Easy Data Transform v2.8.0
for Mac

© 2025 Oryx Digital Ltd, all rights reserved




Table of Contents

1. Getting started 7
1.1 INErOAUCLION ......ceeeeeeeccccccreeceeeetreece e srneneeeeeeesesesssennneseeseesessssssnnsenesssessssssnnnneeenessansnn 8
1.2 SYStEM rEQUIrEMENTS ....uuveeeeeiiiiiiiiiiicnnnetiiieieiisisnnsestsisessssssssnsesssssssssssssnssssssssssssssansasassas 8
13 QUICK SEArt BUIE .coicceeeiiicieetiiiceeticccenensssnee s ssnessssssnssssssnssssssssnsssssssnnessssssnsasssssnanns 8

2. Reference 19
2.1 U LYY 141 0= o i Vol Y PPRPR 20

2.1.1 Y/ 1T VY4 g T Fo 1Y U SPRRRN 20
2.1.2 [0 o T o =SSP 20
2.1.3 00T 0} (=Tl o - o L= O OO PP PP PPPPPPPRRRN 20
2.14 24 T=d 0Y A o - o [T RUPRRRN 21
2.15 L0 PANE i e e 21
2.1.6 Preferences WINAOW ...ttt e e e e e e e arrae e e e e e e e eennes 21
2.2 0] o 11 | T 24
2.2.1 [aY TV o - - U UUPRRRN 24
23 LI 15 0T 3 3N 27
2.3.1 Transform data ...oococeeee e e e e aaee s 27
2.3.2 (@7 o] = USSR 28
2.3.3 6= 1Y PP PUPT PP 41
234 (01T o TSRS 44
2.3.5 (0110 o 1T 46
2.3.6 (O U1 T U 46
2.3.7 COMPATE COIS ..veeiiiieiiiee ettt e e e et e e e e e e e e bbb aeeeeeeessesnsrssarereeeens 49
2.3.8 (60T oF= Yl 6o ] -SSP 52
2.3.9 (@] Tol= ) Bl 2 {0 £ PP PP POPPPRPRPRt 54
2.3.10 (@70 o}V 0o ] S 59
2.3.11 (00T o =] P TSRS 61
2.3.12 (60 10T o X ST 63
2.3.13 01 o 1Y 66
2.3.14 DateTime FOrMAt ..o e e e e e s e e e e e e e as 67
2.3.15 [T =Tolo o LTRSS 77
2.3.16 D7 (0] oI 79
2.3.17 X Al (o 82
2.3.18 U UPRRSRN 87
2.3.19 1= SR RUPRRN 91
2.3.20 (G- 14 = U 95
2.3.21 = 1 o U RUPRRRN 97
2.3.22 [ LT o [T U UPURNE 100
2.3.23 PSPPSR 102
2.3.24 00T o LU o =TSN 106
2.3.25 [ 57 =] o PP PP PP PSP PP PP PPPPPPPPPPPPPPPN 110
2.3.26 [N =T o oY) - | R URRRR 112

Easy Data Transform © 2025 Oryx Digital Ltd



Table of Contents

2.3.27 INEEISECE i, 114
2.3.28 JaVasCIiPT (o, 115
2.3.29 o 1 U UUURR 119
2.3.30 [oYo) (UTo J U UPRUR 123
2.3.31 1Y/ L0371 o V= U URPUR 127
2.3.32 INEW COl ettt e e e e e et e e e e e e e e s taaraeeeeeeeesesnnsraaaeeaeeseennnes 131
2.3.33 NEW ROWS i 133
2.3.34 NN T = ] o RS 136
2.3.35 NUM BaSE it 139
2.3.36 NUM FOIMAt ot e e e e e et s e s e e e e e eerabbeseseeeeesenenanan 142
2.3.37 L@ ) £ PSR 150
2.3.38 L@ TU1 1Y PSR 152
2.3.39 2= Vo U RRUR 156
2.3.40 Y o) U PPPURt 158
2.3.41 PSEUAONYIM «.eiiirieiiiiie ettt eecerree e e e e e seabbr e e e e e eeesesessbaaeeeeeeesesassssraneeeseessennes 162
2.3.42 [ 0o [o T o o TSP 165
2.3.43 REMOVE COIS .uviiiiieiie ettt ettt e e e s e e e e e e e e e rar e e e e e e s s e ssnneranaeeeesesananes 171
2.3.44 RENAME COIS .uviiiiieiee ettt e e e e e e e e e e e e e aar e e e e e e e e e s nnsranneeeeeesananes 173
2.3.45 [ 0=ToT e 1= g @] LU UURUR 174
2.3.46 20T o] 1= TP PP UPPPRRRPPPPRRN 176
2.3.47 RESNAPE e e e et e e e re e e e s naraeeeeaae 183
2.3.48 ROW NUIM ettt e e e e e e et e e e e e e e e e e s aanreeeeeeeeesennssanaeeeenseennnes 185
2.3.49 Y= 110101 [PPSR 186
2.3.50 Yo7 1SS 188
2.3.51 Y =To LU 1] o Lol TP POPOPOPRPRPPPPR 193
2.3.52 1) oL SRS 198
2.3.53 1] T =P 201
2.3.54 1Y o & SRR 205
2.3.55 1Y o111 4 o 1 PR 211
2.3.56 SPHENGME e e e e e e e s e e e e e sareeeeenaaaeee s 215
2.3.57 SPIEROWS ceeieiiiiiiiiiirtiee ittt e e e e et e e e e e e e e sesabbaaeeeeeeeeesssasbaseaeseessenssrseeees 217
2.3.58 Y o1 1=T= e IRt 220
2.3.59 1) = Lol PR 222
2.3.60 1) =12 ] 1SS 224
2.3.61 K] = £ SRR 228
2.3.62 SUBDSTITULE weeeeeeiee et e e e e e e e e e e e s re e e e e e e e e e e nsnnnees 231
2.3.63 U o1 =Tt AU 232
2.3.64 SUMIMIAIY ettt ettt ts st sttt sttt sttt s s s ss st s sssnsssnsssnsnnnnnnn 234
2.3.65 o] | SRR 239
2.3.66 TrANSPOSE .ieieeiiiiicie et e eee ettt rie e e e e e et ettt reeeeeeeeeettaana e eeeeeeseasstanasaeeeerresrsnnnaaaeaerenes 242
2.3.67 1o U PUPRRPSRN 243
2.3.68 UNQUE i 247
2.3.69 [ U URPUR 250
2.3.70 UUID oottt e et ee e e e e e e e e et e e e e e e e e e eesaasaabeeeeeeeeesannsraaaeaeeeeaannnes 252

Easy Data Transform © 2025 Oryx Digital Ltd



Table of Contents

2.3.71 LV ) YRR 254
2.3.72 LT oV ] o - T U 273
24 L0 111 T 276
2.4.1 L@ 1T} o YUL o =1 - [ PRPPPPRE 276
2.5 [T L= o Ty T 1 R 281
251 File TOrMALS .oveeiiiieiee e e e e e e st e e e re e e e saraeeeenaes 281
2.5.2 (O VR {o] 4 10 - O PP PP PP 282
2.5.3 EXCeITOrmMat cocooeeeieeeee 284
2.5.4 Fixed Width fOrmat .......oooiiiiiiie e s s 288
255 JSON FOIMAL it e s e e s ebe e e sba e e sbeeesneeenns 291
2.5.6 HTIML FOIMAt ettt s e e e s bre e e s sabaeeeeeaes 296
2.5.7 MarkdoWn FOrMAt ..c.ccuvieiiiiiee e bae e e s sarae e e e e 297
2.5.8 Plain teXt fOrmMaAt ...eeiiiiiee e 298
2.5.9 BNV o] 1 .41 PSPPI 299
2.5.10 VEArd FOrMAt Loeeiiiiiie e s e s 300
2.5.11 XIMIL FOIMAL .ttt ettt e s e e s e st e st e e s bt e e saneeesanaees 301
2.5.12 YAML FOrMALt ceeiiiiiiiie et st e s e s e e sbee e sans 305
2.6 PrOCESSING eeeririiiiiiiiiisnneniiiiiiiiisissnnetiiisssssssssssssnniisssssssssnssnssssssssssssssanssssessssssssassansssss 306
2.7 07 T4 0] 14 =T 01 3 308
2.8 L0 0T 4 =T o Ao 4 309
2.9 [ T T 1= R 310
2.10 COlUMN TYPES ccoeeiiiriccrrrnneeeetreeeerssssnneeeeeesessssssnsssseseeesssssssssssssseesessssssassssssssesssssansansasss 311
2.10.1 L= PRP 312
2.10.2 Do OSSPSR 312
2.10.3 NUMEBIIC e 316
2.104 2 ToTo] [T o RO PP PPPRPPPRRTIN 317
2.11 [ Lot | 318
2.12 Meta INformation ........ceiiiviiiiiiiiniiinnrr e 319
2.13 Ko 4 T=T 14 - TN 322
2.14 VErifYiNG data ...ceeeeeiiiieiiiirrneetiieeeeiiirssnneeeeeeeecessssssnseeeeeesesssssssssssssssessssssssnsssssessesssssannes 324
2.15 Column vVariables ........eiiiiiiveiiiiiieniiineiiieeisesissserissssss s ssssssssssssssssssssssesssnns 324
2.16 File name variables .......cccciiiiiiiiiiiiiiiiiiiiiniiinnnninsnesisnnsnissssssssssnssssssssssssssssans 325
2.17 REZUIAI @XPIrESSIONS ..eeeeeeeeeireeerrrrsneeeereeeecssssssnneeeeeeesessssssssssssessessssssssassssssssesssssannassssss 329
2.18 [SIUF2 AV (T 1o 41 3-SR 329
2.19 [T ] o (o T 330
2.20 BatCh ProCeSSING .....ueeeeeriiiieiccrrrnneeettreeecesssennneeeeteesessssssnsseneessessssssssnssesasssesssssannnsssses 332
2.21 Command liN@ arGUMENLS ......ccccceiiiiireriiinsnniiiiiinniissssneniesssnseissssssnssssssssessssssssssssssnns 334
2.22 Aransform files ....civviiiiviiiiiiinin e 336
2.23 LIMIES ceeiiireiiiseiiisniinsnenissnnsssnnsesnssesnssssnssssasssssanssssssssssssssssnsssssnsssssnsssssnssssssasssssasssnnns 337
2.24 [\V/ =10 4 ToT 4 VAU LY 7. 337

Easy Data Transform © 2025 Oryx Digital Ltd



Table of Contents

2.25 [ F= ] = TR =T oL U 4 o 338
2.26 POFTaDIlity ..cceeeireeeiiiirrrneeeeeieeeeissssneeeereeeeessssnneeeeeeeesessssssnsssseessessssssssasssssessesssssansnnnssss 338
2.27 DArk MOdE ....cccueriiiiinniiinisneniiiisnnniissssnnnissssssenissssnsssssssssssssssssssssssssnsssssssnssssssssssssssssnns 340
2.28 Keyboard ShOrtCULS .......cciiiiiiiiiieeeeiiiiiccnenneeetiinecssssenssessnssesssssnssssssssssssssssenssssssse 340
3. Howdol? 345
3.1 Add a transform between existing ite€MS .......cccccceeeereeeeiirrrcneeeeeeeeccssssssneeeereececssssannes 346
3.2 Add metadata to @ dataset .......ccccciviireiiiiiinniiiine s sanessses 346
33 Add missSing data ValUES ........ciiiiiiiiiineeiiiiiiciinneneeeiinsccsssenssesssniessssssssnssssssssssssssennes 346
3.4 Add or remove @ hEAET ......ccueiiieiiiierinieiineninninsense s ssssssssssssssssssssssssnns 348
3.5 Change a CONNECLION .....cccvveiiiiiieniiiiineriininenissneeiessssenessssssesssssnsssssssssessssssnsasssssnns 348
3.6 Change eNCOAING ....cccvvreeeiiiiiiiiiiinnneiiiiieciessseetiiiesssssssssssssiesssssssssssssssssssssssansassssnes 348
3.7 Clean @ dataset .......ccccivveiiiieiiineninnnnsr s 349
3.8 Compare datasets .....cccceeiiveiiiiiinniiinieiiieee s sssssssssasesssssnnssssssnns 353
3.9 (00670 \V/=T o 8 o T o T=] g ol o | - V- L= ROt 355
3.10 Dedupe @ dataset ......ccccciveeiiiiinnniinininnniiinineniinsneiinesiisetiessesisnsstsssssssesssan 356
3.11 Duplicate a series of transforms ..........ccicccceiiiiicceiiniisenincreer e snesssesssneesssssnns 360
3.12 Find the difference between dates/datetimes .....cccccccccvveevveerecirsnneeessssneensssssneeessnnns 361
3.13 Handle column name/order changes in INPULS ......cccceeecerererrcererercsenssesseeesneseseesnnes 364
3.14 Handle datasets with many COlUMNS ..........errrrcrrrcrcrcrrrcenenensnenssssssssssssessssssssssssssnnns 364
3.15 Handle 1arge datasets .....cccccccccrccceeetiieecicisscnneeeeieeeessssssnnseneessessssssssnsessesssesssssannnesssnes 367
3.16 Input a fixed width format file ......ccccccriiiiiiiiiiiiiniiiirnie e 368
3.17 Manage a large number of Center Pane itemS .......cccvvvcceeeeeereecerrrssneneeeeeeeecssssanseeseens 368
3.18 Match dirty data ......ccciiiiieeiiiieiiieeneer s sae s s s ane e s s snne 370
3.19 IMerge datasets ......ccccccceeiiiiiiiiiiinnneeiiiiieiiinnnseetiiiesissssnssestissesssssessnssssssssssssssnnnssasae 372
3.20 Move a .transform file .......ccccvvveiiiiinininiininiinie e 376
3.21 Open multiple Main WINAOWS .......iiiiieiiiiinnniiininnniiinneniinseiimsemimsessssae 377
3.22 OULPUL 1O EXCEI ..ceeeieeeeeieicieicreneterereresesesesesesesesesesesesesesesssesesssesssesssesesssssssesssssesssssassnens 377
3.23 Output Nested JSON OF XIVIL ......uueeeeeriieeceersscnmeeeeneeesessssssnnsesssesessssssnnsssssssesssssansnssssns 379
3.24 Perform the same transforms on many files ........ccccevveriiiiieriiiiscnniinssenininsneniennnn. 380
3.25 Profile @ dataset ........cccovvriiieriiieniinininnniinniininennses s sse s sansssans 384
3.26 Replace empty ValUES ......ccceiiiiieeiiiiininnniiiinneniinnnneiisinesiisssenissssesissnssissssssssssans 385
3.27 Run jobs on @ schedule ........coiiiiiiiiiinneeeiiiicceseeeiiiiecsssessssssssnssssssssesssssssns 387
3.28 SCrape WEb data ......cccccirrrreeeiiiieeecinrrssnneeeeeeecessssssnseeeeeesesssssssssssssssessssssssnssssssssessssannes 387
3.29 See changes from a transform .........ccccviiiiiiieiiininniinneee s ssanessees 388
3.30 Set output file name from INPUL fil@ ....cceeeiieiiiirrrreetiiieiciirnrneeeeeeeeccssrsnneeeeeeesesssssennes 390
3.31 Show whitespace and invisible characters .........ccccceeeeecirrrceeeeieeecccnrsnneeeneeeeecssssennee 391
3.32 Split a dataset into multiple files ......ccccciiiiiveriiiiiieiiiiiriee e 392

Easy Data Transform © 2025 Oryx Digital Ltd



Table of Contents

3.33 Trigger an update when an input changes ........ccccecveriiiiieeiiinnnenninnnnenisnnenineen. 395
3.34 Use Easy Data Transform from @ USB KeY .....ccceeeveeeerrrrrnneeeeeeeeccrsssnneneeeeeeeessssssnsseneens 396
3.35 Use multiple keys for Join/Lookup/Intersect/Subtract .........cccceccerererrrerccneccnereennnnes 396
3.36 Verify data ValUES ........eeeiiiiieiiiineeniicceeencccnnessscssnesssssnnessssssnssssssssnsssssssnssssssssnsassns 398
3.37 VisUQlize data .....cocceiiiieiiiiniininiinnninneninenisnnissnsssssessssassssssssssssssssssssssnsssssnssssansssnns 398
3.38 Write to multiple sheets of an Excel file .....cccccevvivveeriiiiseiiiiiieniininenninsnnnicssnennnn. 400
4. Expert tips 401
4.1 EXPEIT HIPS weeeeeiiiiiiiiiiinnneiiiiiiiiiiiinnneetiiiisessssssnssssssisessssssssnssssssssessssssnsassssssssssssssennnssssnes 402
5. Support 420
5.1 o ¥ o 421
5.2 00T - Tou A U o' Yo o 421
5.3 [T o Yol g - TN + 1V 1= RS UTPTPRR 421
54 Request an eNhanCEMENT ........vvceeeeeeieeeeirrrssnneeeeteecessssssnsseeeeesessssssssasssessssesssssansansesss 421
Index 422

Easy Data Transform © 2025 Oryx Digital Ltd



Getting started




Getting started

1 Getting started

1.1 Introduction
1

Easy Data Transform allows you to quickly transform table and list data into
new and more useful forms, without coding. The step-by-step visual
transformation is quicker, more interactive, more repeatable and less error
prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2 System requirements
|

The suggested requirements for running this software are:

e Operating system: macOS 14.x to 10.13.
e Screen resolution: 1280x720 pixels or better.

If your operating system is more recent than the above, check our website to
find a compatible version of Easy Data Transform.

You may be able to run the software satisfactorily on lower specification
systems or more recent operating systems, but we can't guarantee it. If in
doubt, try running an unlicensed trial version before you buy a license.

1.3  Quick start guide
|

This is a quick tour of some of Easy Data Transform's features. It should only

take a few minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue
free trial. If the Getting Started window appears, click | got this! (or you will
just end up back on this page). You should now see the main window.
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e e Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)
he&a . / al e a 3 ® ¥ How Do 1?
v Input

From File

@6

Fram Clipboard

Add datasets you want to transform by:
- dragging dataset files here; or
- clicking the 'From File' or 'From Clipboard’ buttons

[2] Email us questions/feedback

Make sure that Auto Run tool bar button is checked (pressed in), so that any
changes you make are processed automatically after a short delay.

0O EIIE‘D

Drag a data file you want to transform onto Easy Data Transform. For example
a CSV file or an Excel xIsx/.xls file. XML, JSON, fixed width, plain text and
vCard formats are also supported.
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L] L ] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)
DBEBE o~ 0Q & Q H @ * How Do I?
v Input vaccination.csv [l -5 |k
From File @ Fila: L ination.csv
From Cliphoard (%) Type: Delimited text 2]
¥ Transform Delimiter:  Automatic (2]
All transtarms 8 Quoting:  Autarnatic a
Case @
Encoding:  Automatic a
Chap @ =
- Ignore: First O row(s) -
=
Clone @ has header
CompareCols (2) trim whitespace
= simplify whitespace
concarcais (D) ignare emgty rows
ConestRows (7} watch file
Copy Cols ©) Meta info:  Not added [ 2]
vaccination.csv
Count @ Alias: vaccination
) 3 cols x 5.8k rows Warnings | Info | Comment | Results
(2
e = 3 cols x 5,780 rows
: C\B Z|e Show first 10 rows @
Decode @
Cachupa ® country time  bog_vacc
1 alg 1962 10
Extract @
E 2 afg 1983 10
Fill ®
3 afg 1984 1
o @
= 4 afg 1985 17
Gather ®
> f 1
Header @ 5 afg 986 18
" @ 6 alg 1987 27
)]
e @ 7 alg 1988 40
)
e} 8 alg 1989 38

[2] Email us questions/feedback

Notice that the available transforms are shown in the Left pane and the
selected dataset is shown in the Right pane.

In the Right pane, you can check has header, depending on whether you
want to treat the first row of the dataset as a header. For some input formats,
such as JSON and XML, the header is added automatically.
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. . EA
vaccination.csv @ I:F ]

File: /Users/andyb/Desktop/vaccination.csv

Type: Delimited text b
Delimiter:  Automatic L+
Quoting: Automatic C
Encoding: Automatic t
Ignore: First O row(s) =
+ has header
espace
+ simplify whitespace
+ ignore empty rows
watch file
Meta info: Mot added 4

Alias: vaccination
Data Warnings Info Comment Results

3 cols x 5,780 rows

& E% & @ Show first 10 rows <

country time becg_vacc

Transforms are shown in the Left pane. Hover over the transforms to see
tooltips explaining what they do. Click on the ? next to a transform button for
more details.

Ensure the input item is selected and click on the Case transform button to
change the case of your data.
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DOBE o~ OQAQAQHE ® vHwdor
v Input vaccination.csv @||F||E2
From File @ File: JL ination.csv
From Clipboard (2 Type: Delimited text 3
~  Transform Delimiter:  Automatic :
Allltrsfarms - s Quoting:  Automatic
< Case
T Encoding: Automatic <
Chop @ =
= Ignore: First O row(s) -
=
Clane @ + has header
Compare Cols (’) + trim whitespace

+ simplify whitespace

ol 7) 1
ConcatCols  (3)  ignare empty rows

ConestRows (7} watch file
Copy Cals @ L Meta info: Mot added &
vaccination.csv
Count @ Alias: vaccination
& 3 cole x 5.8K rows Data Warnings Info  Comment  Results
(2
3 cols x 5,780 rows
Date Format @
C\B Z|e Show first 10 rows &
Decode @
Dacupa ® country time  beg_vace
1 af 1962 10
Extract @ a
f »
Al ©) 2 afg 1983 10
Fiter @ 3 afg 1984 N
= l
Gather @ 4 afg 1985 17
Haader @ 5 afg 1986 18
" @ & afg 1987 27
Inaset @ 7 afg 1988 40
) 8 afg 1989 38

[2] Email us questions/feedback

A Case transform item will now be added.

L] L ] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)
DBEBE o~ 0Q & Q H @ * How Do I?
v Input Case @ b
From File @ =
From Cliphoard (%) - cuun:f
v Transform time
Al tranatorms B8 bog_vacc
Case @ 0 of 3 columns selected
Chap @ Change case to: Lower case a
Clane (’) [Change the case in the selected column(s).
Compara Cels (7) XN warnings | info | Comment | Results
Concat Cols  (3) 3 cols x 5,780 rows
ConcatRows  (3) G B & e Show first 10 rews B
Copy Cols @ L country time | beg_vace
o ® Jvaocnnanon.csv L, Case PP p—
@ 3 cols x 5.8k raws 00k % RURCroin: 2 afg 1983 10
oate Format  (7) 3 afg 1984 11
Decode @ 4 alg 1985 17
Dedupe @ 5 afg 1986 18
Extract @ 6 afg 1987 27
Fill @ 7 afg 1968 40
Fiter @ 8 afg 1989 38
Gather @ a afg 1980 30
Hesder (D) 0 afg 1991 2
" @]
Iran @ Last 5,770 rows not shown
7

[2] Email us questions/feedback

In the Right pane, check one of the columns and set Change case to to
Upper case. All the text in that column will now be converted to upper case
once you have stopped making changes in the Right pane. You don't have to
click a 'run’ button.
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Case Q) i

E IQ Filter columns ~_|

country

time
beg_wvace

1 of 3 columns selected

Change case to: (&)

Change the case in the selected column(s).

m Warnings | Info | Comment | Resuits

3 cols x 5,780 rows

6 B Z @ Show first 10 rows 63

country time bcg_vacc

1 1982 10

2 1983 10

You can create a sequence of transforms to easily perform complex
manipulations.

Jvaccination,csv Y Case / Filter v Sort

3 omols x 5.8k mows 3 cols x5.8krows 3 cols x4.5krows 3 cols x 4.5k rows

Some transforms require more than one input dataset. For example, to stack

two datasets, one on top of the other:

o Select File>New to start again. Don't save the changes.

¢ Drag two data files onto the Center pane.

e Select both input items (by dragging a box around them or using
Cmd+click).

e Click the Stack transform button (you may need to scroll the Left pane to
see the button).
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ODBEBRE v MO @ a # @ *Hwben
= = L¥]
® vaccination.csv @ P||en
2)
® File: [Users/andybfDesktopfvaccination.csv -
-
) Type: Delimited toxt &
sterpolate @
Delimiter:  Automatic <
Intersect @
Quoting:  Automatic B
@ 9
Encoding:  Automatic <
iy @ ng;
e Ignore: First O row(s) g
Lookup @
P + has b
- vaccination.csv a5 hoader
& v + trim whitespace
& 200l x .8k rows + simplify whitespace
2 + ignare empty rows
@ watch file
® Metainfo:  Not added ¢
=
@ Alias: vaccination
@ Data ‘Warnings Info  Comment  Results
® 3 cols x 5,780 rows
® C B &£le Show first 10 rows &
® vaccination2.csv country |time | beg_vace
3 3 cols x 4.5k rows 1 afg 1882 10
.
2 afg 1983 10
3 afg 1984 1
4 alg 1985 17
5 afg 1966 18
& afg 1987 27
< suck P 7 afg 1988 40
7 8 afg 1989 38

[2] Email us questions/feedback

The tables are now stacked one on top of the other in a new dataset item.
You can choose to match the columns by Header name or Column number.

L] L ] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)
DBEBE o~ 0Q & Q H @ * How Do I?
e \us = "
= E
" ® Stack — (€] -1 |k
et ® Align columns uy:(_y_cajm_nazc___‘) 2]
=4 Merge input I ets one on top of another.Orders by the
@ vertial of the input datasets.
® Warnings | Info | Comment | Results
o ls x 10,258 rows
Jweascript @ )
R R Ze Show first 10 rows 1@
(@]
- country | time  bcg_vacc
i . s
- vaccination.csv 1 afg 1982 10
Hew Cal Q) v
2 afg 1983 10
Mum Format @ 3 cols x 5.8k raws
P 3 afg 1984 11
Pad |$
4 af 1985 17
Fivot @ L
et Stack 5 alg 1986 18
emave Cols  (7)
Rename Cals  (7) 3 ool x 10.3K rows 6 afg 1987 27
7 af 19688 4
Reorder Cols  (7) 9 9 o
feplace %) - & afg 1989 38
ey ® J\raoclnatlonacsv 9 afg 1990 30
Samale (1) 3 cols x 4.5k rows. 10 afg 1991 21
Slica @
Sart @ Last 10,248 rows not shown
Split Cal @
Spiit Rows @
Spread @
@
&
Stamp (7}

[2] Email us questions/feedback

Note that the vertical (Y) position of the inputs affects the order the datasets
are stacked. Try swapping the two inputs around and re-select Stack to see
the effect.
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Any changes to input options will cause the input file to be automatically re-
read. Any changes to input datasets or transform options will be automatically
propagated 'downstream’.

To export your transformed dataset to a file or the clipboard, view it in a local
editor or see it with whitespace displayed, click on the appropriate button in
the Right pane.

Stack ) it

L4

Align columns by: Header name

Merge input datasets one on top of another.Orders by the
vertical positions of the input datasets.

Data Warnings Info Comment Results
3 cols x 10,258 rows

{@ Show first 10 rows <

You can also add an output item to automatically write a dataset to file
whenever it changes. With the Stack item selected, click To File at the
bottom of the Left pane. You may need to scroll to see it.

L] L ] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)

DeRE o~ Oda ol @ ¥ How Do I?

Remove Cals  (2) Stack @ | |22
Rerama Cals (7} Align columns by:  Header name a
= Merge input datasets one on top of another.Orders by the
Foardar Gt t’ wvertical positions of the input datasets.
Auplace @ Warnings | Info | Comment | Results
Row Hum ) 3 cols x 10,258 rows
u @
[FNCUPZEIES Show first 10 rows (6
Samgle @
Slice @ country | time  bcg_vacc
2
Sort ® Jvaocinalion.csv 1 afg 19682 10
# 1 +
Split Col @ 3 cols x 5.8k rows N %o L
Split Rows @ 3 afg 1984 M
Spread @ 4 afg 1985 W7
@ Stack 5 alg 1986 18
2) \/
Stamp @ 3 cals x 10.3k rows 6 alg 1987 27
Stats 3) 7 afg 1988 40
Substitute @ 2 afg 1989 38
@ vaccination2.csv 8 afg 1990 30
Sumenary @ 3 cols x 4.5k rows 10 afg 1901
Total @
Transpese @ Last 10, 248 rows not shown
Unique @
Units @
)

Whitespace

€

[2] Email us questions/feedback

You will be asked for a file to write to. You can choose amongst CSV, Excel,
HTML, JSON, Markdown, Plain text, TSV, vCard, XML and YAML file formats.
Select CSV file.
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Getting started

Save As: output ~
Tags:
Where: % andyb 7]

v CSV file (*.csv)

Excel fileV{* xlsx)

[ o L I

Your dataset will then be written to this file every time it changes.

L] L ] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)
DEBE o~ JQ&QaH#H @ vHwon
® output.csv [O]] - |P34
e File: [Users/andybfDesktopfoutput.cev -
(2
® Type: Delimited toxt [ ]
o Delimiter:  Comma () a8
o) Quoting:  As needed a
(2
.@ Line endings:  Automatic [ 2]
® Encoding: UTF-8 (2]
@ {5 Byte Order Mark
- /vaccination.csv Wirite mode:  Overwrite 8
e 3 cols x 5.8 rows _—
® Alias: output
N warnings | Info | Comment | Results
@ Stack i 3 cols x 10,258 rows
= aci output.csv
@ —_— P CB & o Show first 10 rews (B
@ 3 cols x 103K rows. 3 ools x 103 rows
= country time  Beg_vace
3
@ 1 afg 1982 W0
3!
C’J vaccination2.csv 2 alg 1983 10
(€]
3 cols X 4.5 mws 3 afg 1984 1
(@]
4 alg 1985 17
®
= 5 afg 1986 18
:: & afg 1987 27
@
= 7 alfg 1988 40
@
® 8 afg 1989 38
9 afg 1990 30
o Output
® 10 afg 19E 21

[2] Email us questions/feedback

You can also specify the Delimiter, Quoting, Encoding, Line endings etc for
your CSV files in the Right pane.
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output.csv @ {? E:

File: jUsersfandyb/Desktop/output.csv

[+

Type: Delimited text

[ 4]

Delimiter: Comma (,)

[ 4]

Quoting: As needed

[ 4]

Line endings: Automatic

Encoding: UTF-8
~ Byte Order Mark

L4

Write mode:  Overwrite

(4]

Alias: output

You can save your transforms to a .transform document to use again with
File>Save.

Have a play!

Tips:

e You can also watch a short introductory video.

e Check the show advanced check box in the Left pane to see all the
available transforms.

e You can paste in data from the clipboard (for example, a table from a web
page or Word document) using the From Clipboard button in the Left
pane.

¢ Transforms such as Compare Cols, Filter, If and Sort take account of dates,
numbers and text. You can define what date formats to recognize in the
Preferences window.

e New columns are always added to the right of a dataset.

e Comparisons of text are sensitive to case, unless stated otherwise. E.g.
"CASE", "case" and "Case" are treated differently.

e Comparisons of text are sensitive to whitespace (e.g. spaces and tabs),
unless stated otherwise. You can use the Whitespace transform to remove
unnecessary whitespace.

e The contents of input and output data files are not saved in an Easy Data
Transform .transform file, only their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if
they have a common (‘key') column.

e You can insert a new transform between existing items by selecting the
connection between the items and then clicking the transform button in
the Left pane.

e To be more productive with Easy Data Transform see the expert tips.
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https://www.easydatatransform.com/video.html

Getting started

We are interested in your feedback, so please contact us to ask a question,
report a bug or request an enhancement.
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User Interface
1

Main window

The Main window comeprises:

e Main menu
e Tool bar

o Left pane
e Center pane
¢ Right pane

e Log pane
e Status bar

Tool bar

Left pane

Center pane

COVID-latest with notes.tranfform - Easy Data Transform v1.34.0 (lices

Note

to Oryx Digital Ltd)

Right pane

2.1.2

2.1.3

Easy Data Transform

ga aa # ® * How Do I?
output.xlsx % |f| HE| 23
©) @ Output to file
From Clipboard  (F) By date Output to:  Single file (2]
ot Transform File: [Users/andyb/Desktopfoutput.xisx
- e
Al transforms (5] £ Type: Excel XLSX 8
sherw sdvanced
) Transtorm ks Jamus mencen [ e L _— _— Formatting:  Automatic a
Caicutans @ — -
= Write mode:  Overwrite B Fie (2]
Case @
L4 write header
Chop @ . & wri
— = o e L e A Alias: output
q = EEZN characters| Warnings| info | Comment | Details
Cluster 7,
= © 6 cols x 155 rows @ Written
4 @ s -
Compara Cols  (7) RO lHB Y | 4|
_ &) v 8ot P Phrm Forat ot sian
Concat Cols 2 B e - [ jpenai T
A countriesAndTe.. Grand Sum | dateRep
Concat Rows ® A B i 7765 2020-05-03
. ey Por 10K ey elgiue 2020-05-0
Copy Cols @
Spain 25100 2020-05-03
Count ®
Italy 26710 2020-05-03
Cross @
e : : 4 United Kingdom 28131 2020-05-03
OateTime Format (7 ¢ | |5 itemis) processed in 1,581 second(s)
. L'p to date: 18, Needs updating: 0,Error: 1 France 24760 2020-05-03
Decode @ item(s) with warnings
Netherlands 4987 2020-05-03
Dedupe ©) Started run at: Thu Sep 15 13:53:20 2022
Extract @ Processed Output "output.dsx’ (B cols x 155 rdvs) in 0.138 second(s) [Wrigen], Up to date Sweden 2663 2020-05-03
Ended run at: Thu Sep 15 13:53:20 2022
Fill @ 1 item({s) processed in 0.212 seconds) BEELEaisn e LS
Up to date: 19, Needs updating: 0,Error: 0 o ARE | AT Ry
Fiar @ 1itemis) with warnings 9  United States 66385 2020-05-03
Gather @ 10 Switzerland 1466 2020-05-03
@14 01 Memdly usage: 0.4% of 4068 [=) bi [=] Email us questionsffeedback
Input Log pane Transform Output Status bar

You can split the Right pane onto a separate monitor (if available) by
selecting View>Two Screen Mode.

Left pane

The Left pane shows all the available actions you can perform.

Center pane

The Center pane show the inputs, transforms and outputs you are using to
transform your data. You can also add Note items.
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2.1.4 Right pane

The Right pane shows details of an input, transform or output item you have
selected in the Center pane.

2.1.5 Log pane

The Log pane shows a text representation of processing on the current

.transform file. It shows a maximum of 5000 rows.

e Click the X button to clear all text in the pane.

e Click the (=l button to select all text in the pane.

e Click the B button to copy selected text in the pane to the clipboard.

e Select View>Log (or the corresponding status bar button) to hide/show the
pane.

2.1.6 Preferences window
General tab

Check gray Left pane buttons when not available if you want to gray
buttons in the Left pane button that cannot be used because the appropriate
Center pane items have not been selected.

Check move Note items with associated items if you want Note items to be
automatically moved when you drag other items that the notes are adjacent
to and pointing at.

Check use native file windows to use the native Mac file open/save windows.

Check make a sound when processing completed if you want to make a
system sound every time processing is completed.

Set At start-up depending on what you want to happen when Easy Data
Transform starts.

Set Opening a transform with auto run according to what you want to do

when you open a .transform file with auto-run enabled:

¢ Leave auto run enabled to leave auto run enabled. This could be risky if
you are opening .transform files of unknown provenance.

¢ Prompt to disable auto run to prompt you whether to disable auto run
(you can re-enable it).

¢ Disable auto run to disable auto run (you can re-enable it).

¢ Prompt to disable outputs to prompt you whether to disable any output
items that are not already disabled (you can re-enable them).

¢ Disable outputs to disable any output items that are not already disabled
(you can re-enable them).

Note that this setting is ignored when using the -cli command line argument.
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Set User interface theme to Automatic to follow the theme of the operating
system or override it by setting Light or Dark. This is only available if your
operating system supports a dark theme. Changing User interface theme
does not update the Center pane colors. You can also toggle between themes
using a keyboard shortcut.

Set Tool bar icon size to the size of the icons you wish to display in the tool
bar.

Set Copy data to clipboard text/plain as according to how you want data to

be formatted, when it is copied to the clipboard with MIME type text/plain.

e Comma Separated Value uses Comma as a column delimiter and quotes
Carriage Returns, Commas and quotes within data.

e Tab Separated Value uses Tab as a column delimiter and converts Carriage
Returns and Tabs to Spaces within data.

e Plain text outputs without any column delimiter.

Data is also copied to the clipboard with MIME type text/csv in Comma

Separated Value format and to MIME type text/html as an HTML fragment.

Set Optimize processing for to:

¢ Minimum memory use to use memory compression to reduce the
memory used. This is usually recommended. It works best when columns
contain repeated values.

¢ Maximum speed to turn off memory compression. This might be faster,
but uses a lot more memory. It might also be slower if the memory required
is more than your RAM. It might also cause Maximum memory usage to
be exceeded.

Set Maximum memory usage to the maximum amount of memory that you
want Easy Data Transform to be allowed to use. If this limit is exceeded the
program will give you the option to allocate more memory or exit.

Set Right pane processing delay depending on how long you want to wait
after changes in the Right pane before starting processing, when Run>Auto
Run is checked. Setting the value to 0 is generally not recommended, as this
means that every single click in the Right pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to
work in the Center pane. Hold down the Option key while moving the
mouse wheel to switch between zoom and scroll. If Scroll direction: Natural
is checked in your Mac Settings>Mouse then the directions will be reversed.
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Set Store these preferences in according to where you want preferences
store. portable .ini file is useful if you want to run Easy Data Transform as a
portable application.

User interface font shows the font used for the application user interface,
apart from data tables (see below). Click Choose... to choose a new font. Click
Default to set it back to the operating system default.

Data table font shows the font used in the data tables in the Right pane.
Click Choose... to choose a new font. You might prefer a monospaced (fixed
width) font such as Monaco or Courier New. Click Default to set it back to the
operating system default.

The Locale language and country setting affects how some numbers and
dates are displayed. Consequently it may have an effect on some transforms.
It does not change the language of the user interface, which is English only.

Dates tab

Set Supported date formats to the date formats you wish to recognize. List
the date formats in order of preference, with the most likely to be used first.

Click Default (US) to replace the current supported date formats with US
defaults.

Click Default (non-US) to replace the current supported date formats with
non-US defaults.

Input Extensions tab

Set the default file types corresponding to input file extensions. The order in
which file extensions are shown is not significant.

Click in the Extension column and type to change an input file extension. The
text will be trimmed of whitespace, converted to lower case and any "'

characters removed.

Click in the Default type column and change the drop-down list to change
the file type to associate with an input file extension.

Click Add to add a new input file extension.

Click Remove to remove the selected input file extension(s).
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Click Default to set the input file extensions back to the default setting.

Set Block input from files with extensions to a Comma separated list of file
extension that you want to block Easy Data Transform from reading from for
data security. The case and the order in which file extensions are shown is not
significant.

Output Extensions tab

Set the default file types corresponding to output file extensions. The order in
which file extensions are shown is not significant.

Click in the Extension column and type to change an output extension. The
text will be trimmed of whitespace, converted to lower case and any ".'
characters removed.

Click in the Default type column and change the drop-down list to change
the file type to associate with an output file extension.

Click Add to add a new output file extension.
Click Remove to remove the selected output file extension(s).
Click Default to set the output file extensions back to the default setting.

Set Block output to files with extensions to a Comma separated list of file
extension that you want to block Easy Data Transform from writing to for data
security. The case and the order in which file extensions are shown is not
significant.

Colors tab

Select a Color scheme for the Center pane. A Preview is shown in the
Preferences window. Choose Custom to choose your own color scheme.

2.2 Input
-

2.2.1 Input data

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane
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Enter the file location in File or click the browse button. For Excel
spreadsheets you also need to add a sheet name, e.g.
‘MySpreadsheet.xlsx[Sheet1]".

Easy Data Transform can input data from files in the following formats:
o delimited text file (e.g. CSV or TSV) with various delimiters

e Excel .xlsx or .xls

e Fixed width

e Plain text

* JSON

e vCard

o XML

You can select the input item in the Center pane and change any related
options in the Right pane.

. . R A
vaccination.csv I:? @ Y]

(%) Input from file.
File: /Usersfandyb/Dropbox/vaccination.csv

Type: Delimited text
Delimiter:  Automatic

Quoting:  Automatic

Encoding: Automatic

»00 686

Ignore: First O row(s)
has header
trim whitespace
simplify whitespace
ignore empty rows
watch file

Meta info: Not added

Alias: vaccination

m Warnings | Info | Comment | Details
3 cols x 5,780 rows ) Read

Set Type to the file type. The default type will be set according to the file
extension and the settings in the Input Extensions tab of the Preferences
window.
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For text files Easy Data Transform will treat CRLF, LF or CR control characters
as line endings.

Easy Data Transform will make an intelligent guess at the:

column delimiter and quoting for delimited text files (e.g. Comma)
column widths for fixed width text files

text encoding for text files (e.g. UTF-8)

e presence of a header row in the data

But you can also do this manually by selecting the input item and changing
the Delimiter, Columns, Encoding and has header fields in the Right pane.

Set Ignore to the number of rows you want to skip before you start inputting.
Note that this takes place before any empty rows are removed by Ignore
empty rows.

For delimited text you can:

¢ Set Delimiter to the delimiter character.

e Check ignore repeated delimiters if you want to treat 2 or more
consecutive delimiters as a single delimiter.

¢ Set Quoting according to whether " quoting is used so that the delimiter
can appear within values.

See delimited text for more details.

For fixed width set Columns to Manual to set column widths. See fixed width
for more details.

For JSON or XML set Format to Long (more rows) or Wide (more columns)
depending on how you want to treat arrays/repeat values. See JSON or XML
for more details.

Check has header if your dataset has a header row, with column names.

Set Uses schema to Yes if want to use a schema to manage changes to
columns in the input.

Check trim whitespace to trim any whitespace (e.g. tabs or spaces) off the
start or end of header and data values.

Check simplify whitespace to perform the following in header and data

values:

e Replace any Tabs or Line Feeds with a Space.

e Replace non-standard spaces (such as non-breaking Space, Thin Space etc)
with spaces.

e Remove Carriage Returns.
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Check ignore empty rows to remove any rows that have only empty values
(whitespace is not considered empty).

Check ignore empty columns to remove any columns that have only empty
values (whitespace is not considered empty). This is carried out after any
schema has been applied. Header values are ignored when deciding if a
column is empty.

Check ignore hidden rows to remove any hidden rows (Excel files only).

Check watch file if you set the input to 'Needs update’ whenever the input
file changes (which will trigger processing if Run>Auto Run checked). Easy
Data Transform will wait until the file hasn't been updated for 5 seconds
before doing anything.

Use Meta info if you wish to add some meta information about the input
dataset, e.g. the name of an input file or the date it was created.

Use Alias to identify the input for batch processing or command line
processing.

To change the file being used by an input, select the input item and change
the file location in the Right pane (e,g, by clicking the "..." browse file button),
rather the disconnecting the input and connecting a new one.

2.3 Transforms
1

2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some
transforms only have a single input (e.g. Case), some transforms have two
inputs (e.g. Join) and some transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the
Center pane and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of

transform are displayed, e.g. select Merge Transforms to show only
transforms related to blending data.

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Check the show advanced checkbox in the Left pane to see all available
transforms.

You can select the transform item in the Center pane and change any options
related to the transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if Run>Auto Run is selected and
any input or transform ‘upstream’ of it changes.

2.3.2 Calculate

Description
Performs a calculation on 1 or 2 columns and creates a new column.

Examples
Round a column of numbers to the nearest integer:

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

date elol

1 1920-09-26 1503.947
2 1920-10-03 1503.42

3 1920-10-03 1503.42

y

Calculate 'fmi Qﬁ @ EC

@ Perform calculations on 1 or 2 columns to create a new c...

v automatic new column name

Operation:  Round =

Value 1 type: Column =

Value 1: ? elo1 >
date elo1 Round(elo1)

1 1920-09-26 1503.947 1504

2 1920-10-03 1503.42 1503

3 1920-10-03 1503.42 1503

Divide a column of numbers by 100:
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Percentage
1 100.0
2 95.2
3 453
4 15.6
Calculate it dll=lPEe

@ Perform calculations on 1 or 2 columns to create a new c...

v automatic new column name

Operation:  / Divide hd
Value 1 type: Column v
Value 1: ? Percentage s
Value 2 type: Constant >

Value 2: 100.0

'

Percentage Percentage/100.0
1 100.0 1
2 95.2 0.952
3 45.3 0.453
4 15.6 0.156

Multiply 2 columns of numeric values:
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ItemID Quantity Cost
1 HG89397834 1 99.00
. 2 LK02384030 4 9.95
i
i 3 HG99200444 2 7.95
Calculate N CF EH Eg

@ Perform calculations on 1 or 2 columns to create a new c...

v/ automatic new column name

Operation:  * Multiply -
Walue 1 type: Column -
Value 1: ? Quantity -
Value 2 type: Column -
Value 2: ? Cost b

v

ItemID Quantity Cost Quantity*Cost
1 HGB9397834 1 99.00 99
2 LK02384030 4 995 398
3 HG99200444 2 795 159

Add a days column to a date column:
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Start Duration
1 31/12/2019 7

2 01/01/2021 14

3 07/01/2021 1

v

Calculate g ::F e E :
@ Perform calculations on 1 or 2 columns to create a new c...
v automatic new column name
Operation:  + Add =
Value 1 type: Column o
Value 1: ? Start =
Value 2 type: Column v
Value 2: ? Duration o
Start Duration Start+Duration
1 31/12/2019 7 1/1/2020
2 01/01/2021 14 15/1/2021
3 07/01/2021 1 8/1/2021

Calculate the difference in days between 2 date columns:
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Start End
1 31/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

‘

Calculate % | = 3 g

@ Perform calculations on 1 or 2 columns to create a new c...
v automatic new column name
Operation: - Subtract >
Value 1 type: Column v
Value 1: ? End v
Value 2 type: Column >
Value 2: ? Start =
Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

Inputs
One.

Options

¢ Uncheck automatic new column name to set a name for the newly
created column in New column name.

e Set Operation to the operation you wish to perform.

e Set Value 1 type depending on whether you wish to use a single value or a
column of values for the first value.
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¢ Set Value 1 to the first column of values or constant value you wish to
operate on.

e Set Value 2 type depending on whether you wish to use a single value or a
column of values for the second value (binary operations only).

e Set Value 2 to the second column of values or constant value you wish to
operate on (binary operations only).

Notes
¢ The following operations are supported.

Operati Value 1 Value2 Notes Examples
on
+ Add Numbe Numbe Numerical 1.2 + 3 =4.2
r r addition.
Date Integer Adds daysto 31/01/2021 + 7 =
number the date. 07/02/2021
- Numbe Numbe Numerical 1.2 - 3 =-1.8
Subtract r r subtraction.
Date Integer Subtracts days 31/01/2021 - 7 =

number from the date. 2%/0%/2021

Date Date Days the date 31/01/2021 -
inValue 1is  24/01/2021 =7

24/01/2021 -
afterthe date 31 ,01/2021 = -7
in Value 2
(negative if
before).
* Numbe Numbe Numerical 1.2 * 3 = 3.6
Multiply r r multiplication.
/ Divide Numbe Numbe Numerical 1.2/ 3 =20.4
- 1/ 0 = Error
r r division.
A Power Numbe Numbe Value1ltothe 1-2 © 3 = 1.728

>
|
w
Il
o
’_l
N
()]

r r power Value 2
(Value 1Value2),

% Integer Integer Remainder 75 2 =1
$ 0 = Error
Modulu number number after Value 1
s is divided by
Value 2.
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Operati Value1 Value2 Notes Examples
on
Abs Numbe N/A The absolute  Abs( 1.2 ) = 1.2
Abs( -1.2 ) = 1.2
r value.
And Boolea Boolea Logical AND. And( true, false ) =
n n false
- - And( 1, 1 ) = true
And( 0, FALSE ) =
false

AndBitw Integer Integer Bitwise AND. AndBitwise( 7, 1 ) =

1
ise number number AndBitwise( 5, 10 )
=0
Ceiling Numbe N/A The smallest ~ Ceiling( 1) =1
. . Ceiling( 1.2 ) = 2
r integer that is Ceiling( -1.2 ) = -1
not less than
the value.
DateTim (SO N/A Convert an DateTimeToMSecs ( 197
. . 0-01-01 ) =0
eToMSe datetim ISO datetime DateTimeToMSecs ( 202
cs e to the number 5 _g9_157121:06:10 ) =
of milliseconds 1663272370000
since 1970-01- DateTimeToMSecs( 196
.0N-NO- 9-12-
01:00:00:00.00 30T13:42:23.21172 ) =
o uTC. ~123456789
DateTimeToMSecs ( 202
2-09-
16T13:00:02+01:00 )
= 1663329602000
DateToJ Date N/A Convert a date Da‘;eTOJUlianDaY( 31/
. . 01/2021 ) = 24592406
ulianDa tOdayssm?e DateToJulianDay( 01/
y the beginning 02 /2021 ) = 2459247
of the Julian DateToJulianDay ( 01/
January 4713
BC).
DayOfW Date  N/A Day of the DayOfWeek ( 31/01/202
1) =7
eek week, from 1 @ OfWeek( 01/02/202
=Mondayto 1 ) - 1
7 = Sunday.
DayOfM Date  N/A Day of the DayOfMonth ( 31/01/20
onth month, from 1 21 ) =31
to 31.
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Operati Value1 Value2 Notes Examples
on

DayOfMonth( 01/02/20

21 ) =1
DayOfY Date  N/A Day of the DayOingﬂ 01/02/202
1) =
ear year, from 110 1 Cofvear( 31/12/202
366. 1) = 365
Daysin  Date N/A The number ~ DaysInMonth( 01/02/2
Month of daysinthe 023 ) = 28
DaysInMonth( 01/02/2
date month, 024 ) = 29
from 28 to 31.
DaysInY Date N/A The number g;YSInYizf( 01/02/20
. ) = 365
ear of days in the DaysInYear ( 01/02/20
date year, 24 ) = 366
from 365 to
366.
Decrem Numbe N/A Subtract 1. Decrement ( 1 ) =0
ent r Decrement ( -1 ) = =2
= Decrement ( 1.2 ) =
0.2
Date N/A Subtract 1 Decrement ( 31/01/202
day 1) = 30/01/2021
Floor Numbe N/A The largest Floor( 1) =1
r integer that is Floor( 1.2 ) =1
L 9 Floor( -1.2 ) = -2
not greater
than the
value.
Increme Numbe N/A Add 1. Increment ( 1 ) = 2
nt ; Increment( -1 ) =0
= Increment( 1.2 ) =
2.2
Date N/A Add 1 day. Increment ( 31/01/202
1) =01/02/2021
IndexOf Any Any The 1-based I“de>2<0f( a, EasyData
905|t|on of the IndexOf ( DATA,
first EasyData ) =
occurrence of IndexOf( ,
value 1in EasyData ) =1

value 2. Empty EndeXOf( EasyData, )

IndexOf( , ) =1
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Operati Value1 Value2 Notes Examples
on

if not found.
Case sensitive.

JulianDa |nteger N/A Convert days JulianDayToDate( 245
yToDate number since the 9246 ) = 2021-01-31
L. JulianDayToDate ( 245
beginning of 9247 ) ="2021-02-01
the Julian JulianDayToDate ( 172
period (1st 1426 ) = 0001-01-01
JulianDayToDate( 172
JBaCr])utZr);r?T;(a) 1425 ) = Error
date.
Lastinde Any Any The 1-based  LastIndexOf ( a,
" FasyData ) = 8
xOf position of the LastIndexOf ( DATA,
last EasyData ) =
occurrence of LastIndexOf ( ,
value 1in EasyData ) = 9
value 2. Empty LastIndexOf ( EasyDat
. ) a, ) =
ifnotfound. 1 sttndexof( , ) = 1
Case sensitive.
Length Any N/A Then number Length( 1.2 ) =3
of characters Length( 31/01/2021 )
. =10
inthevalue  1ongen( abcd ) = 4
(include any
whitespace).
LevDista Any Any Calculates the LevDistance( Easy
nce Levenshtein Data, easydata ) = 3
distance
between 2
text values.
Case sensitive.
Log10 Numbe N/A The common LoglO( 10 ) =1
r (base 10) LoglO( O ) = Error
logarithm of
the value.

Log2 Numbe N/A The base 2 Logz2( 10 ) =
r logarithm of 3.3219280949

Log2( 0 ) = Error
the value.
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Operati Value1 Value2 Notes Examples
on
Ln Numbe N/A The natural In( 10 ) = 2.302
r (base e) In( 0 ) = Error
logarithm of
the value.
Maximu Numbe Numbe Returns the Maximum( 10, 11 ) =
11
m r r larger number. Maximum( 10, -11 ) =
10
Date Date Returns the ~ Maximum( 31/01/2021,
01/01/2022 ) =
later date. 01/01/2022
Minimu Numbe Numbe Returnsthe Minimum( 10, 11 ) =
10
m . L smaller Minimum( 10, -11 ) =
number. _
11
Date Date Returns the Minimum( 31/01/2021,
. 01/01/2021 ) =
earlier date. 31/01/2021
MSecsT Integer N/A Convert the MSecsToDateTime ( 0 )
. = 1970-01-
oDateTi number number of 01T00:00:00.000
me milliseconds

MSecsToDateTime ( -

since 1970-01- 123456789 ) = 1969-

01:00:00:00.00 12-30T13:42:23.211
MSecsToDateTime ( 123

OUTCtoan /5clee ) = 1970-01-

ISO datetime.  (5710:17:36.789

May be

affected by

locale (e.g.

Summertime).

MSecsT Integer N/A Convert the MSecsToTime ( 0 ) =

i 00:00
oTime | number number of MSecsToTime ( 8130000

milliseconds ) = 02:15:30

since midnight MSecsToTime ( 8639999
to 9 ) = 23:59:59.999
MSecsToTime ( 8640000

hh:mm:ss.zzz. 1) = 24:00:00.001

Month Date  N/A 1 = January. MOIllgh( 31/12/2021 )
Occurre Any Any The number ~ Occurrences( is,

This is a string ) =
2
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Operati
on

Or

OrBitwis
e

Quarter

Round

Sign

TimeTo
MSecs

WeekOf
Year

Value 1 Value2 Notes

Boolea Boolea
n n
Integer Integer
number number
Date N/A
Numbe N/A

I

Numbe N/A

I

Time N/A
Date N/A

1 occurs in
value 2.
Occurrences
can overlap.
Empty if value
1is empty.

Case sensitive.

Logical OR.

Bitwise OR.

1=Q1

Round to the
nearest
integer.

1 if value > 0,
0 if value = 0,

-1 if value < 0.

Convert an
h:m:s(.zzz)
time to the
number of
milliseconds
since
midnight.

The year and
the week of
the year, from
01 to 53,

Examples

Occurrences ( xx,
XXXx ) = 3
Occurrences ( xXxXxXX,
xx ) =0
Occurrences ( ,

XXXX ) =

Or ( true, false ) =
true

Or( 1, 1 ) = true
Or( 0, FALSE ) =
false

OrBitwise( 7, 1 ) =
7

OrBitwise( 5, 10 ) =
15

Quarter( 1/1/2023 )
=1

Quarter ( 31/3/2023 )
=1

Quarter ( 1/4/2023 )
= 2

Quarter ( 31/12/2023
)y = 4

Round( 1 ) =1
Round( -1.2 ) = -1
Round( 1.5 ) = 2
Sign( 1.2 ) =1
Sign( 0 ) =0

Sign( -1.2 ) = -1
TimeToMSecs( 0:0:0 )
=0

TimeToMSecs( 02:15:3
0O ) = 8130000
TimeToMSecs( 23:59:5
9.999 ) = 86399999
TimeToMSecs( 24:00:0
0.001 ) = 86400001
WeekOfYear( 31/12/20
20 ) = 2020,53
WeekOfYear( 06/01/20
21 ) = 2021,01

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Operati Value1 Value2 Notes Examples
on

separated with WeekOfYear( 31/12/20

aComma.ln 21 ) = 2021,52

accordance
with ISO 8601,
each week
falls in the
year to which
most of its
days belong,
in the
Gregorian
calendar. As
ISO 8601's
week starts on
Monday, this
is the year in
which the
week's
Thursday falls.

WordCo Any N/A Count the WordLength ( Hello

unt number of world: ) = 2
WordLength ( Hello,wo

words rld! ) = 2
separated by  WordLength( Hello,
whitespace world! ) = 2
and/or

punctuation.

Xor Boolea Boolea Logical XOR  Xor( true, false ) =

. true
n n xclusive OR).
o (exclusive OR). - o " 1, 1) = false

Xor( O, FALSE ) =
false

XorBitwi Integer Integer Bitwise XOR XorBitwise( 7, 1 ) =

se number number (exclusive OR). XorBitwise ( 5, 10 )
= 15
Year Date  N/A  The 4 digit fear( 31/01/2021 ) =
2021
year.

e Each row is calculated separately.
e Whether values are interpreted as number, dates or text depends on
Supported date formats and |ocale.
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¢ Bitwise operations interpret negative numbers using Two's complement.

e To concatenate text in different columns use the Concat Cols transform.

To compare 2 columns use the Compare Cols transform.

For logical operations use the |f transform.

For operations on whole rows or columns use the Stats transform.

For more complex calculations, including number/date, use the Javascript

transform.

¢ To modify the numerical precision of the results use the Num Format
transform.

e To add a new column of values use the New Col transform.

See also
e Video: How to convert a Unix timestamp

2.3.3 Case

Description
Changes the case of text in one or more columns.

Example
Set names to title case:
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Reference

First Last

1 john smith

2 JANE SMITH

Case If' @ EC
® Change the case in the selected column(s).
El Q Filter columns

First
vy

Last
v

2 of 2 columns selected ]

Change case to: Title case v
First Last
1 John Smith
2 Jane Smith
Inputs
One.
Options

e Check the column(s) you wish to transform.
¢ Set Change case to according to the case you want:
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Case Description Example output for '
WORD word Word !'

Lower case Converts all letters to word word word
|
lower case. ’

Upper case Converts all letters to WORD WORD  WORD
|
upper case. :

Title case Converts the first letter =~ Word Word  Word

of each word to upper
case and all other
letters to lower case.

Sentence case Converts the first letter Word word word

to upper case and all
other letters to lower
case.

Lower camel case  (Converts the first letter wWordWordWord!

for the second and
subsequent words to
upper case and all other
letters to lower case.
Removes whitespace.

Upper camel case  (Converts the first letter WordWordWord!

of each word to upper
case and all other
letters to lower case.
Removes whitespace.

Kebab case Replaces mu|t|p|e -WORD-word-Word-!

consecutive whitespace
characters with a single
- (Hyphen) character.

Snake case Replaces multiple _WORD word Word !

consecutive whitespace
characters with a single
_ (Underscore)
character.

Inverted case Convert lower case word WORD wORD

|
letters to upper case

and upper case letters
to lower case.
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o If keep upper case is checked, then any existing upper case letters are left
unchanged. This option is only available for Title case and Sentence case.
E.g. you can use Title case with keep upper case checked to convert 'john
McKenzie PhD' to 'John McKenzie PhD'.

See also
e Whitespace
2.3.4 Chop

Description
Remove characters from the start or end in one or more columns.

Example
Remove leading zeros:

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

ID
1 0000001

2 0000002

3 0000003

y

KA

Chop B L3

@ Remove a number of characters from the start o... |
E Q Filter columns

.JID

1 of 1 columns selected

Length: 6 :
From: Start v
ID
1 1
2 2
3 3
Inputs
One.
Options

e Check the column(s) you wish to transform.
¢ Set Length to the number of characters you want to remove.
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¢ Set From to Start or End depending on whether you want to remove
characters from the start or end.

Notes
e If you can to keep the original column use Copy Cols to copy the column
first.

e Whitespace is counted when calculating length. You can use Whitespace to
remove whitespace before chopping.
e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract

2.3.5 Clone

Description
Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.

2.3.6 Cluster

Description
Classify rows with similar text into clusters

Examples
Clustering products by type:
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product unit cost |stock
1 French red wine 23.95 9
2 BULGARIAN RED WN 11.95 13
3/Red Label Whisky 38.45 1
4 Gordon's Gin 25 7
5 German White Wine 14.95 6
6/ Larios Gin 19.90 50
7 Black Label Whisky 45.50 8
8/Wine, White, Dessert 30.00 1
9 Cocoa Cola 1.95 200
Cluster Cf’ Ec
@ Classify rows with similar text into clusters.
Column:  product v
Clustering: Manual v
GIN
RED WINE
WHITE WINE
Closeness: 20% :
case sensitive

product unit cost stock Cluster Closeness

1 French red wine 23.95 9 RED WINE 55
2 BULGARIAN RED WN 11.95 13 RED WINE 25
3 Red Label Whisky 38.45 1 WHISKY 37
4 Gordon's Gin 25 7 GIN 25
5 German White Wine 14.95 6 WHITE WINE 58
¢é Larios Gin 19.90 50 GIN 30
7 Black Label Whisky 45.50 8 WHISKY 33
8 Wine, White, Dessert 30.00 1 WHITE WINE 35
9 Cocoa Cola 1.95 200 <none>
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Correcting the state in an address:

Street City State
1589 Timbercrest Road Haines Alaska
21289 Jerry Toth Drive ATLASKA

3 3597 Blackwell Street Anchorage Alaksa
4 344 George Avenue Mobile Alabam
52555 Lonely Oak Drive Mobile ALABAMA

6 28l6é Barrington Court Pine Bluff arknsas

Cluster d‘" Ec
@ Classify rows with similar text into clusters.

Column:  State v
Clustering: Manual v

Terms: AMERICAN SAMOA
ALABAMA
ALASKA
ARIZONA
ARKANSAS
CALIFORNIA =

4

Closeness: 50%

case sensitive

Street City State Cluster Closeness
1589 Timbercrest Road Haines Alaska ALASKA 100
21289 Jerry Toth Drive ALASKA ALASKA 100
3 3597 Blackwell Street Anchorage Alaksa ALASKA 66
4 344 George Avenue Mobile Alabam ALABAMA 85
52555 Lonely Oak Drive Mobile ATLABAMA ALABAMA 100
62816 Barrington Court Pine Bluff arknsas ARKANSAS 87

Inputs
One.
Options

e Select the Column whose values you wish to use for clustering.
¢ Select Clustering as:
o Manual to cluster by Terms you provide (one per line).
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o Guided to find clustering terms automatically, starting with the Terms
you provide (one per line).

o Automatic to find clustering terms automatically.

¢ Set the minimum Closeness percentage for a value to a term to be
clustered with a term.

¢ Set Max clusters to the maximum number of clustering terms (Guided and
Automatic only).

¢ Set Max time to the maximum amount of time allowed for trying to
improve the terms (Guided and Automatic only).

e Uncheck case sensitive to ignore case.

Notes

e Fuzzy matching is used to classify each row value according to which of the
user supplied Terms it is closest to.

¢ Additional Cluster and Closeness columns are added. The Cluster column
shows the closest matching of the Terms (or the one highest one in the
Terms list if 2 or more match equally). The Closeness column shows the
fuzzy match score between 0 (no match) and 100 (exact match).

e Row values that do not meet the minimum Closeness score for any term
are set to <None>.

¢ Set the minimum Closeness score to 0% to force all values to be assigned.

¢ You can use a Filter to list all the rows with <None> in the Cluster column
to guide you on any additional Terms you might want to add in Manual
mode.

See also

e Ngram
e Video: How to cluster text

2.3.7 Compare Cols

Description
Creates a new column with a comparison of two other columns.

Examples
Compare 2 numerical columns:
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Valuel Value?2
1 183.34 926.7

2 7 7
3 -345 -8934
Compare Cols CP E C
@ Compare the values of two columns.
Column 1:  Value1l v
Comparison: > Greater than v
Column 2:  Value2 v

v case sensitive

V

Valuel Value2 Valuel>Value2

1 183.34 926.7 false

& 7 7 false

3 -345 -8934 true

Compare 2 date columns:
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Datel Datel
1 7/1/2021 01/01/2021

2 1/1/2021  01/01/2021

3 31/12/2020 01/01/2021

V

Compare Cols ff} EH 33

@ Compare the values of two columns.

Column 1:  Datel v
Comparison: >= Greater than equal h..
Column 2:  Date2 v

v/ case sensitive

v

Date1l Date? Datel1>=Date?
1 7/1/2021  01/01/2021 true

2 1/1/2021 01/01/2021 true

3 31/12/2020 01/01/2021 false

Inputs
One.

Options

e Uncheck automatic new column name to set a name for the newly
created column in New column name.

e Select the two columns you wish to compare as Column 1 and Column 2

and the Comparison operator.
e Check case sensitive to use case sensitive matching for text.
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Notes

e Number, date and text values are treated differently for Equal to, Greater
than, Less than, Greater than equal, Less than equal and Not equal to
operations.

o If both values are numeric, a numeric comparison will be carried out. This
is accurate to approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date
comparison will be carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will
be compared as text. So you might want to replace empty values with 0
or remove those rows with Filter, before comparing them.

e Comparisons of text are whitespace sensitive. You can use Whitespace to
remove whitespace before filtering and Replace to get of other unwanted
characters (e.g. whitespace inside the text).

e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.

¢ See here for more details on Regular expressions (regex).

See also

e Split Cols
e Compare datasets

2.3.8 Concat Cols

Description
Creates a new column by concatenating text from existing columns.

Example
Concatenate 'First' and 'Last' columns with a Comma between:
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First Last
1 John Smith

2 Jane Smith

Concat Cols dﬂ E Q

@ Concatenate selected columns into a single new...
E Q Filter columns

First
v

Last
v

2 of 2 columns selected

Delimiter: ,
keep empty
First Last First+Last

1 John Smith John,Smith
2 Jane Smith Jane,Smith

Inputs

One.

Options

e Uncheck automatic new column name to set a name for the newly
created column in New column name.

e Check the columns you wish to concatenate.

¢ Supply the Delimiter you wish to place between concatenated text
(optional). For example *,".

e Check keep empty if you wish to keep the delimiter for empty columns.
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Notes

e If there is a header, the header of the new column is formed from the
header of the concatenated columns. You can use Rename Cols to change
the new column name.

e Concatenating a single column makes a copy of the column.

e The values in the column are in the order of the original columns. You can
change the column order before concatenation with Reorder Cols.

e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.

e Use the right click menu on the Delimiter field to add Carriage Return, Line
Feed, Tab or Null characters.

e The opposite of Concat Cols is Split Col.

See also
e Concat Rows
e Substitute

2.3.9 Concat Rows

Description
Concatenate multiple consecutive rows into a single row.

Examples
Concatenate every 2 rows to 1:
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sensor datetime value

1 sensor1 1/1/18 0:00 578

3 sensor1 1/1/18 0:10 541

4 sensor2 1/1/18 0:10 702

y

Concat Rows d’ =2 E‘;
@ Concatenate multiple consecutive rows into a si...
Mode: Fixed v |
Create 1 row from every: 2 = .

‘

sensor datetime wvalue sensor datetime wvalue

1 sensor1 1/1/18 0:00 578 sensor2 1/1/18 0:00 764

2 sensor1 1/1/18 0:10 541 sensor2 1/1/18 0:10 702

Concatenate values until empty:
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1 2
!
‘ 1/John Smith
1

|2 1 The Street
i 3|Townsville

| 4 Wiltshire

[}

-

E

6

77 The Avenue

9
Concat Rows CP E Q

@ Concatenate multiple consecutive rows into a si...
Mode: Variable v
Concatenate:  Until v
Matches: = Equal to v
Value:

v case sensitive
New row value: Omit v

1 % 3 !

1/John Smith |1 The Street Townsville Wiltshire
:dane Brown 7 The Avemse Cityville

Concatenate values while not starting with 'ID":
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1|
1 ID387423

2 Blue widget

3 100.00
4 123.45
5 |ID&30300

6 Green widget
7 78.90

3 |ID835644

% Red widget

10 12.34
11 111.11
12 7.77
Concat Rows {f} EC

@ Concatenate multiple consecutive rows into a si...

Mode: Variable v
Concatenate:  While v
Matches: I~ Doesn't start with v
Value: ID

v case sensitive

New row value: Add to row start v
1 2 3 4 5
1ID387423 Blue widget 100.00 123.45
2 ID630300 Green widget 78.90
3 ID835644 Red widget ‘ 12.34‘ 111.11 7.77

Concatenate consecutive rows with the same Orderld:
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OrderId Item Price
1 1 238933 3432.89
2 2 528252 L2053
3 2- 012322- 231.98

Concat Rows {}G E Q

@ Concatenate multiple consecutive rows into a si...

Mode: By key v
Key column: Orderld b4
Vv repeat key column r
Vv case sensitive .’
OrderId Item Price OrderId Item Price
1 1 238933 3432.89
2 2 526252 172 TE 2 012322 231.98
2 3| 323002' 11.99
Inputs
One.
Options

e Set Mode to:
o Fixed to concatenate a fixed number of rows from the current dataset to

make each new row.
o Variable to concatenate values while or until a match to make each new

row.
o By key to concatenate consecutive rows with the same value in a key

column to make each new row.
¢ Set Create 1 row from every to N, to concatenate every N rows into 1 row

(Mode=Fixed only).
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¢ Set Concatenate to Until or While to keep concatenating until/while a
match is found for Matches and Value (Mode=Variable only).

e Check case sensitive to use case sensitive matching for text
(Mode=Variable or By Key only).

¢ Set New row value depending on what you want to do with the value that
denotes a new row (Mode=Variable only).

e Uncheck repeat key column to keep only the first key column (Mode=By
Key only).

Notes

e Use Sort before this transform if you need to change the row order.

e Use New Col if you need to add additional columns before concatenating
rows.

e Use Filter if you need to remove rows before concatenating row.

e Use Rename Cols if you need to change column names after concatenating
rows.

e The opposite of Concat Rows is Split Rows.

See also

e Reshape

e Spread

e Unique

e Concat Cols

2.3.10Copy Cols

Description
Creates one or more copies of the selected column(s).

Example
Copy 2 columns, once each:
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First Last
1 John Smith

2/Jane Smith

Copy Cols oy S

@ Copy selected columns.
E] Q Filter columns

First
v e

Last
v

2 of 2 columns selected

Copies: 1

1)

First Last First Last

1 John Smith John Smith

2 Jane Smith Jane Smith

Inputs
One.

Options
e Check the columns you wish to copy.

¢ Set Copies to the number of copies you want to make of each checked
column.

Notes

o If there is a header, the header of each new column is the original column
name. You can rename columns with Rename Cols.
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e The new columns are added at the right end. You can change the column
order with Reorder Cols.

See also
e New Col

2.3.11 Correlate

Description
Calculates the Pearson correlation coefficient of values in 2 or more pairs of
columns.

Example
Calculate the correlation between specimen weight and length:
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Weight (kg)
1 3.63

10 -

KA
Correlate % ¢S
@ Calculate the correlation of 2 or more pairs of columns.
El '_'_Cl Filter columns

Weight (kqg)

v

v Len.g_th. :[Fnj} .

2 of 2 columns selected !

Correlation Weight (kg) _

1 Weight (kg) 1 0.470177233

2_ 0.470177233 1

Inputs
One.
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Options
e Select 2 or more Columns whose values you wish to calculate the
correlation for. All possible pairs of selected columns will be calculated.

Notes

e The Pearson correlation coefficient is calculated in the range +1.0 to -1.0
where:

o +1.0 means a perfect correlation

o 0.0 means no correlation

o -1.0 means a perfect inverse correlation

A column is assumed to always perfectly correlate with itself. Even if it has
no numeric values.

Pairs of values are ignored if they are not both valid numeric values.

N/A is returned if two columns have no valid numeric pairs.

N/A is returned if all the numeric values in a column are identical (as this
gives a standard deviation of 0, which causes a divide by 0 error).

e Use the Num Format transform to change the number of decimal places .

See also
¢ Video: How to calculate Pearson correlation
e Stats

e Summary
2.3.12 Count

Description
Counts the number of occurrences of each item of text in the selected
column.

Example
Count unique values in the 'Response' column:
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Reference

Response

1|YES
2 NO
3 NO

4 NO

Count % 3 ;
® Count the occurences of text in the selected column.

v/ automatic new column name

Column: Response =
Sort by: Count >
Order:  Descending -

v case sensitive

allow drilldown

Response Count Response

1 NO 3

2|YES 1

Inputs
One.

Options

e Uncheck automatic new column name to set a name for the newly
created column in New column name.

e Select the Column whose values you wish to count.

¢ Set Sort by depending on whether you wish to sort alphabetically by the
Text in the left column or numerically by the Count in the right column.

¢ Set Order depending on whether you wish to sort Ascending or
Descending.
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¢ Uncheck case sensitive to convert everything to lower case before
counting.

e Check drilldown to allow double clicking a row in the data table to
drilldown to the rows that contributed to this value in the upstream data.

Notes

Date and number values are treated as text.

Use Rename Cols to change the new column name.

Use Scale to convert the results to percentages.

If case sensitive is unchecked, the case of the first value encountered is
used. You can use a Sort or Case transform before Count if you want to
control the case shown.

Fesponse
1l yes
2 YES
3 NO
4 no
Count % S
@ Count the occurences of text in the selected column.
v automatic new column name
Column: Response .
Sort by: Count =
Order:  Descending v
case sensitive
allow drilldown

Response Count Response

1/NO 2

2‘3&3 2
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See also
e Ngram

e Unique
e Total

e Summary
2.3.13 Cross

Description

Creates an output from combining every possible row combination of each
input. E.g. if the first input has N1 rows and the second input has N2 rows,
then the result will have N1 X N2 rows. Also known as a 'Cartesian product' or
‘cross join'.

Example
Cross 2 small datasets:

letter .letter number
LR —0 Clipboard 1A 1
28 1 col x 3 rows 2A 2
3|1C 3A 3
4B 1
© Cross N ,

2 cols x 9 rows
number °E :
1i 1 ) 7le 1
2 2 w0 Clipboard o )
3| 3 1 col x 3 rows 9c 3
Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e It can create a very large number of rows!
e Use Clone to cross a dataset with itsself.

See also
e Join

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

e Stack
2.3.14 DateTime Format

Description
Changes the date and/or time format in one or more columns.

Examples
Change day/month/year to month-day-year:
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Date
131/12/2020

21/1/2021
3|2f1f2021 ‘
DateTime Format S Qﬂ Eg

@ Change the date and/or time format in the select...

E /;l Q Filter columns

N, Date

1 of 1 columns selected

Locale from: English ¥ United Kingdom ¥
Format from: d/M/yyyy

Locale to: English ¥ United States ¥
Format to:  MM-dd-yyyy

Mon-date: Leave v

\J

Date

112-31-2020

ﬂol—ul-zuzl

ﬂ01-n2—2021

Change 24 hour time to AM/PM time:
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Time

19:07:11

2‘13:14:15

3‘23:12:10

o) KA

DateTime Format {f X ¢ N

® Change the date and/or time format in the select...

E A|(Q Filter columns

Time

v

1 of 1 columns selected

Locale from: English ¥ United Kingdom ~

Format from: h:mm:ss

Locale to: English ¥ United Kingdom ~

Formatto: hh:mm:ss AP

\

Time

Non-date: Leave

109:07:11 AaM

201:14:15 PM

311:12:10 PM

Change datetime to ISO format:
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DateTime

131/12/2020 9:07:11 AM

2‘1!1!2021 1:14:15 PM

3‘2)"11’2021 11:12:10 PM

B

DateTime Format & OD Eg

@ Change the date and/or time format in the select...
E /"5‘ Q Filter columns

DateTi
v DateTime
4 b
1 of 1 columns selected

Locale from: English ¥ United Kingdom ¥

Format from: d/M/yyyy h:mm:ss AP

Locale to: English ¥ United Kingdom ~

Format to:  yyyy-MM-dd'T'HH:mm:ss

Non-date:  Leave e
DateTime

12020-12-31T09:07:11

22021-01-01T13:14:15

| 3‘2021—01-D2T23 :12:10

Convert month names from short English to short German:
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Date

1/31-0ct-2024

2‘ﬂ1-Mar—2025

302-May-2025

4

DateTime Format {FE d} @ Eﬂ

@ Change the date and/or time format in the select...

E /’C!- Q Filter columns

v Date

1 of 1 columns selected

Locale from: English ¥ United Kingdom ¥
Format from: dd-MMM-yyyy
Locale to: German ¥ Germany v

Format to: dd. MMM yyyy

Non-date: Leave -

1/31. Okt. 2024

Date

201. Marz 2025

302. Mai 2025

Example formats for 21 May 2001 14:13:09.120 with |ocale set to
English/United States:
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Format to

dd.MM.yyyy

yyyy-d-M

ddd MMMM d yy
hh:mm:ss.zzz
hh:mm:ss.z

hhmmss

h:m:s ap
YVYYy-MM-dd'T'HH:mm:ss.zzz

HH:mm:ss 'in yyyy-MM-dd
HH:mm:ss format'

Inputs
One.

Options

Output
21.05.2001
2001-21-5

Mon May 21 01
14:13:09.120
14:13:09.12
141309

2:13:9 pm

2001-05-21T14

:13:09.120

14:13:09 in HH:mm:ss

format

e Check the columns you wish to transform.
¢ Set Locale from to the locale you wish to use to interpret input dates.

e Supply the existing date and/or time format in Format from (see below).
¢ Set Locale to to the locale you wish to use to interpret output dates.

e Supply the new date and/or time format in Format to (see below).

¢ Use Non-date to set what to do for values that don't match Format from.
¢ Use With value for values that don't match Format from when Non-date

is set to Change to user defined.

¢ The following date and/or time formats are supported for input and output:

Relates to

Date Years

Format

Yy

YYYY

Meaning

The year as a two
digit number (00
to 99).

The year as a
four digit
number. If the
year is negative,
a minus sign is
prepended in
addition.

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Relates to
Months
Days
Time Hours

Format

M

MM

MMM

MMMM

dd

ddd

dddd

Meaning

The month as
number without
a leading zero (1
to 12).

The month as
number with a
leading zero (01
to 12)

The abbreviated
localized month
name (e.g. 'Jan'
to 'Dec).

The long
localized month
name (e.g.
‘January' to
‘December").

The day as
number without
a leading zero (1
to 31).

The day as
number with a
leading zero (01
to 31).

The abbreviated
localized day
name (e.g. 'Mon'
to 'Sun’).

The long
localized day
name (e.g.
‘Monday' to
‘Sunday").

The hour without
a leading zero (0
to23 or1to12if
AM/PM display).
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Relates to Format

hh

HH

Minutes m

mm

Seconds S

SS

Milliseconds z

Meaning

The hour with a
leading zero (00
to 23 or01to 12
if AM/PM
display).

The hour without
a leading zero (0
to 23, even with
AM/PM display).

The hour with a
leading zero (00
to 23, even with
AM/PM display).

The minute
without a leading
zero (0 to 59).

The minute with
a leading zero
(00 to 59).

The whole
second, without
any leading zero
(0 to 59).

The whole
second, with a
leading zero
where applicable
(00 to 59).

The fractional
part of the
second, to go
after a decimal
point, without
trailing zeroes (0
to 999). Thus
"s.z" reports the
seconds to full
available
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Relates to Format Meaning

(millisecond)
precision without
trailing zeroes,

ZZZ The fractional
part of the
second, to
millisecond
precision,
including trailing
zeroes where
applicable (000
to 999).

AM/PM AP or A Use AM/PM
display. A/AP will
be replaced by
an upper-case
version of locale
AM or PM text.

ap or a Use AM/PM
display. A/AP will
be replaced by
an lower-case
version of locale
AM or PM text.

Timezone t The timezone
(for example
"CEST").

If not set, the default values are:
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Value Default
Year 1900
Month 1

Day 1

Hour 0
Minute 0
Second 0
Milliseconds 0

Notes

e An exact match is expected for the input date. E.g. Format fromis yyyy-
MM-dd then 2020-12-17 will be converted, but 2020-12-17T14:58
won't. You can extract just the date or time part here using Split Col with T
as the delimiter.

e Use the correct case for the format text (e.g. yyyy-MM-dd, not YYYY-mm-
DD).

¢ Any non-empty sequence of characters enclosed in single quotes will be
included verbatim in the output (stripped of the quotes), even if it contains
formatting characters. Two consecutive single quotes (' ') are replaced by a
single quote in the output. All other characters in the format text are
included verbatim in the output.

e Formats without separators (e.g. ddMM) are supported but must be used
with care, as the resulting output isn't always reliably readable (e.g. if dM
produces 212 it could mean either the 2nd of December or the 21st of
February).

¢ You can also use Split Col to split a date into its component parts. For
example to split "31/1/2019" into day, month and year components using
the "/" delimiter.

o If the date to be converted has only two year digits, it is treated as a date
between 1900 and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as
31st January 1919. You can avoid that issue by explicitly setting the century,

e.g.

Format from: MM/dd/yy ‘

‘Forr‘nat to:  MM/dd/20yy ‘
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Or you can use Replace. For example to replace 01/15/18 with

01/15/2018:
Match Type Replace With
1/ Regex ¥ [(\d\d)/(\d\d)/(\d\d) \1A2/20\3

e Some dates do not exist, so cannot be converted. For example, 29-02-2023
matches the format dd-MM-vyyyy. However the date does not exist, so
won't be converted.

e Some datetimes do not exist, so cannot be converted. For example, if your
Locale is Spanish / Chile then 03-09-2023 0:00:00 may not be
converted with Format from dd-MM-yyyy H:mm:ss, as in Chile the clock
is changed at 24 : 00 first Saturday of September, so 0: 00 of next Sunday
doesn't exist. This can also depend on the time zone set in your operating
system.

e Warnings are shown in the Warnings tab for values that don't match
Format from or don't correspond to a real date or datetime.

¢ You can also do date and time format conversion using the Javascript
transform.

See also
e Num Format

2.3.15 Decode

Description
Convert to/from Base64 encoding, URL encoding, escaped HTML or escaped
XML.

Example
Convert <'Hello World!'> to base64 encoding:
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1
1 <'Hello World!"' >

Decode d:' @ Eg
@ Convert to/from baseé4, URL, HTML or XML enc...
IE' Q Filter columns

v 1

1 of 1 columns selected

Change: To base6t4 encoding v

1
1 PCdIZWxsbyBXb3JsZCEnPg==

Type Plaintext Encoded

Based64 encoding <'Hello World!'> PCdIZWxsbyBXb3JsZ
CEnbkPg==
20World%21%27%3E

HTMLeaBng <'Hello World!'> &lt; '"Hello

World!'&gt;

XML escaping <'Hello World!'> &lt; &apos;Hello
World! &apos; &gt;

Inputs
One.

Options

e Check the column(s) you wish to transform.
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¢ Set Change according to how you want to decode/encode the selected
columns.

Notes

e This is distinct from text encoding (e.g. UTF-8 vs UTF-16) which is handled
on input and output.

e Use Copy Cols to copy columns before you transform them.

e Data input from XML files and output to HTML and XML files is
unescaped/escaped automatically.

2.3.16 Dedupe

Description
Remove duplicate rows.

Example
Keep the first row for each unique 'Customer Id":
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MName Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown

89456 10.55 01/10/2020 |
3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown

98526 10.00 02/10/2020

5 Charles Jones CO17783 38746 25.00 03/10/2020!

V

Dedupe Cf:' == EC

@ Remove duplicate rows by matching values in al...

Explore Duplicates...
IEI Q. Filter columns

Mame

Customer Id

v
Product Id

1 of 5 columns selected

Matching: Exact v

v case sensitive

Mode: Remove duplicates v
Name Customer Id Product ld Cost Date
1 Alice Anderson C018930 13574 29.95 01/10/2020
2 Bob Brown 89456 10.55 01/10/2020
3 Charlie Jones CO017783 96352 19.95 02/10/2020
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Inputs
One.

Options
e Click Explore Duplicates... to explore which rows are duplicates.
e Check the column(s) you wish to look for duplicate values in.
¢ Set Matching to Exact to use exact matching to find duplicates and Fuzzy
to match with some differences. Fuzzy matching is much slower.
¢ Set Closeness to how close a fuzzy match has to be to be considered a
match. E.g. set it to 80% to make 2 values that are 80% the same a match.
For Fuzzy matching only.
e Check case sensitive to use case sensitive matching.
e Check ignore whitespace to ignore whitespace characters when matching.
e Check ignore punctuation to ignore punctuation characters when
matching.
¢ Set Mode according to what you want to do with duplicates.
o Remove duplicates removes all duplicate rows.
o Keep only duplicates keeps only the duplicate rows (the inverse of
Remove duplicates).
o Add duplicate information adds extra columns with information about
duplicate rows at the end. Reorders rows, but does not remove them. The
additional columns are:
= Group: Each row and its duplicates are given a unique group number,
starting at 1.

» Row: The number of the row in the input dataset.

= Closeness: How close a match the duplicate is as a percentage. 100% =
exact match.

* Duplicate: Set to true if the row is a duplicate and false if not.

» Duplicates: Set to the number of duplicates a non-duplicate has.

e Check drilldown to allow double clicking a row in the data table to
drilldown to this row and it's duplicates in the upstream data. This is only
available when Matching is set to Exact and Mode is set to Remove
duplicates.

Notes

e Rows are considered duplicates if they match in all the checked columns.

e Comparisons are whitespace sensitive. You can use Whitespace to remove
whitespace before deduping and Replace to get of other unwanted
characters (e.g. whitespace inside the text).

e When several rows are duplicates, only the top one is retained. So you may
want to Sort your dataset first.

e The Unique transform is a more powerful (but more complex and slower)
alternative to Dedupe.
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See also
e Dedupe a dataset
e Video: How to clean, merge and scrub email lists

2.3.17 Extract

Description
Extract text in one or more columns.

Examples
Extract the first 2 digits from the 'Product Id' column:
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Product Id
1 C13574

2 AB9456

13]A96352

V

Extract ol Sl

@ Extract text in the selected column(s).
E| Q Filter columns

Product Id

4

1 of 1 columns selected

Using: Text v
Length: 2 -
From: Start =
Offset: 0 .
Product Id

1C1

2 A8

3 A9

Extract the last group of digits from an IP address:
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IP
1 82.69.52.10

2 66.249.66.92

3 86.28.107.100

.

Extract dj E ES
@ Extract text in the selected column(s).
E Q Filter columns .

JIP

1 of 1 columns selected
Using: Regex v
Matching: \d*‘\_\d*\_\d*\_{\d*ﬂ

Vv case sensitive

¥

1P
110
2 R
3100

Extract titles from a name:
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Name

1 Mr John Black

2 Mr. Ben Brown

3 Ms Jill Green

4 Mrs. Jenny White

5 Bill Grey

‘ R A

Extract d:' e

@ Extract text in the selected column(s).
IE’ Q Filter columns

v Name

T W W - W

TR - T Wy TTT ¥

1 of 1 columns selected
Using: Regex v
Matching: *(Mr|Mrs|Ms|Miss)\.?\s

case sensitive

'

MName

1 Mr

- w ——

2 Mr
3 Ms
4 Mrs

5
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Using depending on whether you want to extract a fixed length of text
or with a regular expression.

¢ Set Length to the length you want values in selected columns shortened to.
Text match only.

¢ Set From to Start or End depending on whether you want to take from the
start or end. Text match only.

e If From is Start then Offset is the offset of the first character from the start
(0 to start with the first character). If From is End then Offset is the offset
of the last character from the end (0 to start with the last character). Text
match only.

¢ Set Matching to a regular expression. Regex match only. If the expression
contains capture parentheses the first capture will be extracted. Otherwise
it will try to capture the whole regular expression. For example:

Value Regular expression Extracted
12.34.567.89 (\d*)\.\d*\.\d*\. 12
\d*
12.34.567.89 Nd*\ . \d*\ L \d*\ . 89
(\d~*)
12.34.567.89 \d*\.\d* 12.34

ip 12.34.567.89 Nd*\ . \d*\ . \d*\.\d* 12.34.567.89

ip 12.34.567.89  ~\d*\.\d*\.\d*\.
\d*$

e Check case sensitive to use case sensitive matching. Regex match only.

Notes
e If you can to keep the original column use Copy Cols to copy the column
first.

e Whitespace is counted when calculating length. You can use Whitespace to
remove whitespace before extracting.

e If you want to set a column to a fixed length use Pad and Extract together.

e Use Replace If you want to extract multiple captures from a value using a
regular expression.

See also
e Chop
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2.3.18Fill

Description
Fill empty cells in selected columns with the adjacent non-empty values.

Examples
Fill down all rows:

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Country Area City

1 Country 1 Area 1‘(:[1)’ 1

2 City 2

3 City 3

4 Area 2‘City 1

5 City 2
Fill ol B2 S
@ Fill empty cells in selected columns from adjacent cells.
E Q Filter columns
v Country |
v Area
vy

3 of 3 columns selected

Direction: Down b

For: All rows -

v

Country Area City

1 Country 1/Area 1 City 1
2 Country 1 City 2

3 Country 1[{Area 1 City 3

4 Country 1 /Area 2 City 1

5 Country 1 /Area 2 City 2
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Fill down all rows only where the value in the 'ld' column matches:
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Id Name Telephone
1 23434 Bill Smith 89345803

2 23434
3 23434
4 90933
5 42344|Ken Green

6 42344

Fill e |l PR
@ Fill empty cells in selected columns from adjacent cells.
E Q Filter columns

Id

Mame

v

Telephone

v

2 of 3 columns selected

Direction: Down bt

For: Rows with same key value v

Key column: ? Id -

Id Name Telephone _
1 23434 Bill Smith 89345803

2 23434 Bill Smith 89345803
3 23434 Bill Smith 89345803

4 90933

5 42344Ken Green
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Inputs
One.

Options

e Check the column(s) you wish to fill.

¢ Select Direction depending on the direction you wish to fill to.

¢ Set For to Rows with same key value, if you wish to only fill up/or down
when when 2 adjacent rows have the same value in the Key column
column.

Notes

e Cells containing whitespace are not considered empty.

e Matching for Rows with same key value is sensitive to case and
whitespace.

¢ To fill empty values with something else use the Replace transform.

See also

e Unfill

e Slide

e Whitespace
e Impute

2.3.19Filter

Description
Removes rows based on number, date and text values in selected columns.

Examples
Keep rows with at least 1 non-empty value.

Filter ‘fw Qﬂ EQ

@ Filter rows by text, date or numeric values in selected columns.

@ ® % (%)%:l X Keep ¥ | Matching any

Column Op. Value
1/ <Any> v e ¥

Keep only rows where the 'Tax' value is greater than 0 and the 'Country’ value
is "US".
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= K A
Filter :j: Bhs
@ Filter rows by text, date or numeric values in sel...

® X E & X Keep ¥ Matchingall ¥

Column Op. Value
1 Tax ¥Y|> ¥Y|O
2 Country ¥i|= ¥ |US

Remove rows where the 'Transaction' value is greater than the 'Threshold'
value (using a column variable).

] KA
Filter ‘S Q{} YN

@ Filter rows by text, date or numeric values in selected col...

@ ® E‘_% é}éj X Keep ¥ Matching any

Column Op. Value
1 Transaction ¥ > ¥ $(Threshold)

Inputs
One.

Options

e Click the ® button to add a new filter criteria.

e Click the ® button to delete the selected filter criteria.

e Click the B button to copy terms to the clipboard.

e Click the & button to paste terms from the clipboard.

e Click the X button to clear all terms.

¢ Select Keep if you want to keep matching rows and Remove to remove
matching rows.

¢ Select Matching all (AND) to match on all criteria (e.g. criteria 1 and
criteria 2). Select Matching any (OR) to require a match on one or more
criteria (e.g. criteria 1 or criteria 2).

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare. You can use a column variable.

e Check case sensitive to use case sensitive matching for text.

e Check disable filtering to turn off filtering. If sampling is disabled, the
transform does nothing.
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Notes
e A text summary of the filters is shown:

@ ®EB & X Keep ¥ Matchingall ~

Column Op. Value
1 Country ¥ |= ¥ |UK
2 Units Sold v |>=V |5
3 Unit Cost ¥ >=7¥ |10

Keep (Country = 'UK') AND (Units Sold >="5") AND (Unit Cost >= "10")

e A filter row is ignored if the Value column is empty , except when Op. is
Equal to, Not equal to, Matches regex or Doesn't match regex.

e Number, date and text values are treated differently for Equal to, Greater
than, Less than, Greater than equal, Less than equal and Not equal to
operations.

o If both values are numeric, a numeric comparison will be carried out. This
is accurate to approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date
comparison will be carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will
be compared as text. So you might want to replace empty values with 0
or remove those rows with Filter, before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches
regex, Is not, Doesn't start with, Doesn’t end with and Doesn't match
regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not
match Is empty. You can use Whitespace to remove whitespace before
filtering and Replace to get of other unwanted characters (e.g. whitespace
inside the text).

e See here for more details on Regular expressions (regex).

¢ You can use Subtract to see rows removed by filtering if there is unique key
column.
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Subtract

14 cols x 585 rows

{

orders.csv rows removed
by filtering

L/

/]

14 cols x 830 rows

° Filter

14 ols x 245 rows

e If you are pasting in filter terms, the format expected is Comma delimited
text with 3 columns.
o The first column is the 0-based index of the Column drop-down list.
o The second column is the 0-based index of the Op. drop-down list.
o The third column is the Value.
For example, pasting in:

0,0,YES

Will add:

Column Op. Value
1 <Any> ¥ |c ¥ I|YES |

You can also try copying terms to the clipboard and pasting into a text file to

see the format. If you only paste in 1 column of text, it will be assumed to be

a list of Value. You can, of course, use Easy Data Transform to create the

appropriate filter terms and paste them into memory.

¢ You can also use a Verify transform to remove rows that do or don't meet
particular verification rules.

See also

e Compare Cols
e Slice
e Video: How to clean, merge and scrub email lists
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2.3.20 Gather

Description
Gather multiple columns into new key and value columns. Also called unpivot,
long pivot or group by.

Example
Gather 'Q1', 'Q2', 'Q3" and 'Q4' columns into 1 column.
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1 Alice
2 Bob East 45 79 g8 33
Gather CF @ Eg

@ Gather selected columns into key and value col...

= .
E] Q Filter columns

salesman
area

v
v

v

Vi

4 of 6 columns selected

Key column name: Quarter

Value column name: Amount

lr

salesman area Quarter Amount

1 Alice North Q 11.3

3 Alice North Q.

4/|Alice Nonr

5 Bob East
6 Bob East ﬂ 79
7 Bob East |Q3 8

8 Bob East - 3.3

Inputs
One.
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Options

¢ Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have
values based on the names of the columns selected.

e Set Value column name to the name of the new value column, which will
have values based on the values in the columns selected.

Notes

e New columns are added at the right end. You can change the column order
with Reorder Cols.

e You can merge the value and key columns into a single column with Concat
Cols.

e The opposite of Gather is Spread.

id n v
1 1
Gather * 14
id x y =z 2 1y b
1 lla |b e 3 lz ¢
2l 2d e |f k olw |a
Spread |, 2ly le
6 2|z |E
See also
e Video: How to unpivot Excel
e Split Rows
2.3.21 Hash
Description

Perform one-way hashing on selected columns.

Example
Compute the MD5 hash of <'Hello World!'>:
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1
1 <'Hello World!'>

!

Hash d& Eip
@ Perform a one-way hashing.
E| Q Filter columns |

\(‘I

1 of 1 columns selected

Algorithm: MD5 v

|
1 f0d946347af462d489af835d3737fe70

Type Plaintext Secret Hashed

SHA1 <'Hello 4a700d8555aa
World!'> ed497cc54d32f
6£3d7478200a

5dea

SHA-256 <'Hello 2c6139a5d874
World!'> b9626e3ae244
3fa85cdfelfc
18£148034826
7£f8bf71a783f
738a

SHA-512 <'Hello 23728b865af0
World!'> f17bb9%bfaafl

64£f711bf0062

6c07e5389dcb

b18365acelc

2394d7a00066

c0boba7112dab

528e62106a85

5dd6bc41d0c?2
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Type Plaintext Secret Hashed

62fb72e9f47e
10fl652c

SHA3-256 <'Hello 0701263723cd
World! '> bdfllelf7118
e62d7d29delf
01£8490ef775
e4991558634b
d719

SHA3-512 <'Hello 6lcbf6flle86
World!'> 4af592626d94
30271a5ado6f3
9edf7e09719%a
97¢c57b5¢c3222
cdf24bd70f1f
6927b7b41eb9
48bbddfelada
e965688a4a68
82df7be36492
ad653ab0

Keccak-256 <'Hello 1a45dd8df9de
World!'> 65049692d919
2509b30560b6
9¢c1£d881c57b
2cf4607e85b3
569f

Keccak-512 <'Hello 2741b7ddfe0d
World!'> 4c4726d476cc
719fdbb3b7db
88feodflaldf
00723547c546
496ac49bd82e
94009£4572d3
a31fe0fc50bc
elee3c76d983
£8ddc480b7da
9cdled02

MD5 <'Hello £0d946347af4
World!'> 62d489%a£835d
3737£e70

HMAC-MD5 <'Hello ABC123 5940ca%b5£f2b
World!'> 47ael1972ab8l
db8030ac

HMAC-MD5 <'Hello abcl23 b185£719143d
World!'> 6380ccabel7d
5d2743eb
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Algorithm to the hashing algorithm you wish to use

o Set Secret to the secret key you wish to use (HMAC-MD?5 only). The default
value is randomly generated.

Notes

e There is no known way to reverse these hashes, apart from brute force
(create the hash of every possible value, then do a reverse lookup).

¢ As the chance of 2 different inputs generating the same hash value by
chance (a 'collision’) is infinitesimally small, hashing can be used to
pseudonymise data or to help find duplicates of long data values.

e The MDS5 algorithm is now considered weak as a cryptographic hash. But
remains suitable for other non-cryptographic purposes.

e Use Copy Cols if you want to copy columns, before you hash them.

See also
e Pseudonym

2.3.22 Header

Description
Move rows from the top of the dataset into the header.

Example
Append the first row to the header:
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Sample Sample Sample

1 1 2 3
2 22334 2389 1935

3 82.2 5059 934.51

Header rj:} @ EQ

@ Move rows to the header.

Top rows to move: 1 =
Existing header:  Append v
Delimiter: -
Sample-1 Sample-2 Sample-3
1 22334 23.89 19.35
2 82.2 5059 93451
Inputs
One.
Options

¢ Set Top rows to move to the number of rows you want to move from the
top dataset into the header. Setting it to 0 means the transform does
nothing.

¢ Set Existing header to Overwrite to ignore the existing header values and
Append to add to the existing header values.

¢ Set Delimiter to any text you want to put between column elements. It can
be left empty. Ignored if Existing header set to Overwrite and Top rows to
move set to 1.
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Notes

e Empty cells are ignored.

e You can Sort and Filter your dataset to change the top rows.

¢ You can add the header from one dataset to another dataset using Stack.

See also
e Headers

2.3.231If

Description
Sets the value of a new column based conditionally on values in one or more
other columns.

Examples
Add a new column based conditionally on 'Payment’ and '‘Currency' columns:
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Payment Currency

1 462697 USD
2 647.54 USD

3 6353.12 GBP

¢

If ‘o dll ==z [WE¢

@ Create a new column with values conditional on value...

New column name: Convert

@esElF (PDanD ™ L ®

Logic Column Op. Value
1IF Currency ¥ |= ¥ |USD
2 THEN= No
3 ELSE IF  Currency ¥ |= ¥ |GBP
4 AND Payment ¥ >= ¥ 1000
5 THEN= Yes
6 ELSE= No

v case sensitive

\

Payment Currency Convert

1 4626.97 USD No
2 647.54 USD No

3 6353.12 GBEP Yes

If the 'h1' and 'h2' columns have the same value then use the value of the 'h2'
column, otherwise use the value of 'h3' column (using column variables).:
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h1 h2 h3
1A A 1
2B B 2
3cC C 3
4d D 4
i * FEC

@ Create a new column with values conditional on oth...

New column name: If

@EeseiF |(HDanp N L X

Logic Column Op. Value
1IF h1 v = ¥ §h2
2 THEN= $(h2)
3 ELSE= $(h3)

v case sensitive

v

h1 h2 h3 |If
1A A 1A
2B B 2B
3c C 3 3
4d D 4 4
Inputs
One.
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Options

¢ Set New column name to the name of the new column you want to create.
e Click the ®ELSE IF button to add a new IF/ELSE IF.THEN condition.

e Click the ®AND'button to add an AND to the selected IF/ELSE IF. THEN.

e Click the ® button to delete the selected IF/ELSE IF.. THEN/AND.

e The Logic column shows the type of row.

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

¢ Check case sensitive to use case sensitive matching for text.

Notes

e The IF, THEN and ELSE values can use column variables, as in the second
example above.

e You can simulate OR with multiple IF statements. For example:

IF x =1 OR vy = 2
THEN 3

Is equivalent to:

IF x =1
THEN 3
ELSE IF y = 2
THEN 3

e Number, date and text values are treated differently for Equal to, Greater
than, Less than, Greater than equal, Less than equal and Not equal to
operations.

o If both values are numeric, a numeric comparison will be carried out. This
is accurate to approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date
comparison will be carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will
be compared as text. So you might want to replace empty values with 0
or remove those rows with Filter, before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches
regex, Is not, Doesn't start with, Doesn't end with and Doesn't match
regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not
match Is empty. You can use Whitespace to remove whitespace before
filtering and Replace to get of other unwanted characters (e.g. whitespace
inside the text).

e See here for more details on Regular expressions (regex).
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See also
e Lookup
2.3.24 Impute

Description
Infer values of missing data from other values in the same column.

Examples

Impute the missing age of Titanic passengers based on the average age of all
passengers:
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Pclass Sex Age Sibsp Parch |+
21 2 male 35 0 0 !
22 2 male 34 0 0
23 3 female 15 0 0
24 1 male 28 0 0
25 3 female 8 3 1
26 3 female 38 1 5
2 3 male 0 0
28 1 male 19 3 2
29 3 female 0 ol |
30 3 male 0 0
31 1l male 40 0 0 ;
impute FE3

@ Infer values of missing data.
[E] Q Filter columns

Pclass
Sex
v Age

1 of 9 columns selected

Using: Average v

Of:  All rows v
Pclass Sex Age SibSp Parch ‘!

21 2 male 35 0 ol &

22 2male 34 0 (0]

23 3 female 15 0 0

24 lmale 28 0 0

25 3 female 8 3 1

26 3 female 38 1 5

27 3 male 29.6991176471 0 0

28 lmale 19 3 2

29 3 female 29.6991176471 0 0

30 3male 29.6991176471 0 0

=ht lmale 40 0 oy

Impute the missing age of Titanic passengers based on the median age of
passengers with the same passenger class and sex:
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Pclass Sex Age SibSp Parch |+
21 2male 35 0 0 b
22 2male 34 0 0
23 3 female 15 0 0
24 1 male 28 0 0
25 3 female 8 3 1
26 3 female 38 1 5
27 ‘ B‘male | | 0 0
28 1 male 19 3 2
229 3 female 0 0
30 3male 0 0
31 1l male 40 0 0 ;
Impute CF Ei
@ Infer values of missing data.
IEI Q Filter columns
Pclass =
Sex
v Age
P v

1 of 9 columns selected

Using: Median ¥
Of: Rows with matching values for: 2
IE' Q Filter columns
Pclass =
v
Sex
v
Age

2 of 9 columns selected
Matching: Exact match v

case sensitive

Pclass Sex Age SibSp Parch |~}
21 2 male 35 0 0
22 2 male 34 0 0
23 3 female 15 0 0
24 1 male 28 0 0
25 3 female 8 3 1
26 3 female 38 1 5
27 | B‘male | 25‘ o] 0
28 Imale 19 3 2
29 | B‘female I 21.5} 0 1]
30 3‘male | 25‘ 0 0
=ht 1 male 40 0 o,

Inputs
One.

Options

e Check the column(s) which have empty values you wish to impute.
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¢ Set Using to impute using the Average (mean), Median or Mode of non-
empty data values in each column.
e Set Of to:

o All rows to fill empty values in each column with the Average, Median or
Mode of all non-empty values in the same column.

o All rows with matching values for to fill empty values in each column
with the Average, Median or Mode of all non-empty values in the same
column where values match in the checked columns below.

¢ Set Matching to Exact match if every field has to match and Best match to
use rows that have the most matching values (or all rows, if no matches).

For example, if you are matching on passenger class and sex then:

o Exact match will only use values from rows where the passenger class
and sex both match.

o Best match will use values from rows where the passenger class and sex
both match, if available. Otherwise it will use values from rows where
either the passenger class or sex match, if available. Otherwise it will use
values from all rows.

e Check case sensitive to use case sensitive matching.

Notes

¢ Average and Median only work on numerical data (non-numerical values
are ignored).

¢ Mode treats all non-empty data values as text. Case and whitespace are
taken into account.

¢ If Mode is selected and there are multiple values with the same maximum
frequency, one will be picked at random.

e If you need to convert some values to empty before imputing, you can do
this using a Replace transform.
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Replace Q{: 3 ;

@ Replace multiple text in the selected column(s).
|E| Q Filter columns

v ge.nder.
group
salary

1 of 3 columns selected

@1 VXS X

Match Type Replace With
1 Text ¥ Unknown

e You can use a Filter transform to remove rows with missing values instead
of imputing values.

e Use a Sequence transform to add missing date or integer values in a
sequence before imputing.

See also
¢ Video: How to impute missing data
e Fill
e Interpolate
2.3.25Insert

Description
Append/prepend text to one or more columns.

Example
Add 'ID-' to the front of a column of text:
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ID
1230933

2 223441

3 323412

| A

Insert CF vy
@ Append/prepend text in the selected column(s).
E Q Filter columns

\!ID B | |

1 of 1 columns selected

Insert: ID-
At: Start v |:
ID
11D-230933
2 1D-223441
31D-323412
Inputs
One.
Options

e Check the column(s) you wish to transform.
e In Insert put the text you want to insert. You can use a column variable.
¢ In At put the position you want the text inserted.
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Notes
¢ You can use Whitespace to remove whitespace before inserting.

See also
e Pad
e Extract

2.3.26 Interpolate

Description
Interpolate values for a dataset based on numerical sample-value pairs in
another dataset and puts the result in a new column.

Example
Interpolate time and temperature datasets for sensors A and B with different
sampling frequencies:

KA
time A temperature A Interpolate =23
1 0.0 1134 @ Create a new column in the top dataset by inter...
Top sample column: time A v
2 1.0 3778 .
Bottom sample column: time B v
3 20 2773 A Bottom value column:  temperature B v i
sensor-A.csv
4 3.0 5,03”0 Interpolation type: Linear v !
2 cols X 6 rows
5 40 3333
time A temperature A Interpolate temperature B
6 S0 2874 Interpolate 100 1134
9 > *
3 cols x 6 rows
time B temperature B 2 10 3778
1 0.0 0.000 3 20 2.773
sensor-B.csv
2 20 W@ 4l 30 5039
2 cols x 4 rows
340 2697 5 40 3333
4 60 6 50 2.874
Inputs
Two.
.
Options

¢ Place the dataset you want to modify as the top input and the dataset you
want to sample values from as the bottom input.

Uncheck automatic new column name to set a name for the newly
created column in New column name.

Select Top sample column for the column whose values you wish to
sample.

Select Bottom sample column for the column that matches the top sample
column in the bottom dataset.

Select Bottom value column for the column that contains the values.

Set Interpolation type to the type of interpolation you wish to use.
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Piecewise interpolation (image from Wikipedia)

Linear interpolation (image from Wikipedia)
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Notes

e If your sample is below the first sample in the bottom dataset, the first value
will be returned.

e If your sample is above the last sample in the bottom dataset, the last value
will be returned.

e Easy Data Transform will try to guess sensible default values for Top sample
column, Bottom sample column and Bottom value column based on
column contents.

e If the first input has a header, this will be used for the output.

e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.

e Use Num Format to change the precision of the results.

e Messages are shown in the Warnings tab for non-numeric values in either
dataset.

e Messages are shown in the Info tab for Top sample column outside the
range of values in Bottom sample column .

See also

e Lookup

e Impute
e Join

2.3.27 Intersect

Description
Keep only rows from the top dataset with key values that are present in the
lower dataset.

Example
Keep rows in the top dataset that also have their IDs in the bottom dataset:

Id  First Intersect togll == 5:
1 001 Alice ©) Keep only rows from the top dataset whose key value... |
N > o intersect-1.csv Top key column: 1d v

4 004 Dwayne

Bottom key column: | ID v
3| 003 Charlie 2 cols x 4 rows /

Intersect b ne
(/] v * 1 001 Alice

2 cols X 2 rows

o

intersect-2.csv

1 col x 2 rows
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Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Click Explore Keys... to compare key values in the 2 datasets.

¢ Select Top key column for the column you want to match in the top input
dataset.

¢ Select Bottom key column for the column you want to match in the
bottom input dataset.

e Check case sensitive to use case sensitive matching for keys.

Notes

o If there are 10k rows or less in both datasets, Easy Data Transform will try to
guess sensible default values for Top key column and Bottom key column
based on column header names and contents.

e If the first input has a header, this will be used for the output.

¢ All values are treated as text and comparisons are whitespace sensitive. You
can use Whitespace to remove whitespace before the intersect.

¢ Does not remove duplicates. You can use Unique to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name’
and 'last name' columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract
e Use multiple keys for Join/Lookup/Intersect/Subtract

2.3.28 Javascript

Description
Create a custom transform using Javascript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data
transformations without coding. But sometimes you might need a specialist
transformation that can't be done with the built-in transforms. For that you
can use the Javascript transform. It allows you to write the body of a
Javascript function, to calculate a value for each row in a new column. Existing
column values can be used as variables.

Javascript is a fully-fledged programming language and can perform arbitrarily
complex transforms. It can handle strings (text), numbers, dates and text.
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Examples
Multiply the value in column 'items' by the value in column 'item price":

items item price
1 1 11.45
2 5 0.95
3 2 9.95

Javascript C? = Dg

@ Script your own custom transform in Javascript.

New column name: cost

Type columns as:  Number/Boolean/String v

Javascript:

return $(items) * $(item price);

items item price cost

1 1 11.45 11.45
2 5 0.95 475

3 2 9.95 199

To concatenate 'last' and 'first' columns with a Comma and a Space:

return $(last) + ', ' 4+ S$S(first);

To calculate the biggest of numeric columns 'v1' and 'v2":
return Math.max( $(vl), $(v2) );

To find the number of characters in column 'v1":
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return String( $(vl) ).length;

To determine whether phone numbers in the '‘phone_num' column are valid
using a regular expression:

const validPhoneNum = /~[\+]12[(]1?2[0-971{3}[)12[-\s\.]?
[0-91{3}[-\s\.1?[0-91{4,6}s$/;
if ( validPhoneNum.test ( $(phone num) ) )
return "valid";
else
return "invalid";

To replace the last Comma in the 'Location’ column with a ;' using a regular
expression:

return $ (Location) .replace(/(.*), ([~ 1*)S$/, '$1;%2");

To calculate the number of years difference between Javascript compatible
dates in column 1 and column 2:

return new Date( $(1) ).getFullYear() - new
Date( $(2) ).getFullYear();

To calculate the number of milliseconds between a datetime in the 'datetime
column and 1st Jan 2000:

return new Date( $(date) ) - new Date( "2000-01-
01T00:00" ),

To calculate the number of whole days difference between a date in the
‘created' column and today (negative for future dates):

return Math.floor( ( new Date () - new
Date( S(created) ) ) / ( 1000*60*60%*24 ) );

To use the value of the 'n' column if it is a number and O if it isn't:

if ( isNaN( $(n) ) )
return 0;

else
return $(n);

To reverse the text in the 'key' column:

var a = $(key);

var newString = "";

for (var i = a.length - 1; i >= 0; i--) {
newString += al[i];

}
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return newString;
To convert meters to feet using a function:

function metersToFeet ( x )

{
return 3.28084 * x;

}

return metersToFeet ( $(meters) );

Inputs
One.

Options
¢ Set New column name to the name of the new column you want to create.
¢ Set Type column as to:
o Number/Boolean/String to pass:
= A column that is numeric values as Javascript Number type.
» A column that is true and false values as Javascript Boolean type.
» Anything else as Javascript String type.
o String to pass data all columns with Javascript String type.
e Enter your script into the Javascript field. The script should be the body of
a Javascript function.
e Select a column from Insert variable to add that column variable into the
Javascript field at the current cursor position.
¢ Click the Evaluate button to evaluate your Javascript expression over every
row and show any errors (only available if Run>Auto Run is checked).

Notes

¢ If Run>Auto Run is checked, the Javascript transform is calculated every
time:
o The Evaluate button is pressed.
o The Javascript transform item is unselected in the Center pane and script

changes have been made without the Evaluate button being clicked.

o An item upstream of it changes.

e An empty string is passed as an empty Javascript string variable (
null. To test if the 'v' column has an empty value:

), not

if ( $(v).length === 0 )
{
// empty cell

}
else if ( String( $(v) ).trim().length === 0 )

{
// blank cell (whitespace only)

}
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e Numeric values should use Dot ('.") as the decimal separator and have no
group separator. E.g. 1234.5 is valid, but 1,234.5 and 1.234,5 are not,
regardless of the |ocale. You can use the Num Format and Replace
transforms to put numeric data in the correct format before processing a
Javascript transform.

e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.

e The Javascript Date() object evaluates to the number of milliseconds since 1
January 1970 UTC.

o Date values passed to Javascript Date() objects should be in ISO ('yyyy-mm-
dd') format, e.g. '2020-01-31' (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you
should merge them first, e.g. using Join.

e The Javascript transform is very versatile and quite fast. But is not as fast as
built-in transforms. So we recommend you use built-in transforms where
possible.

e Javascript running in Easy Data Transform is not 'sandboxed' and has the
same privileges as the Easy Data Transform executable. However the
Javascript does not have access to window(), XMLHttpRequest() or
ActiveXObject(). So we aren't aware of any way that a bad actor could
damage your system from Javascript sent in a .transform file.

e Javascript is far too big a topic to cover here. However there are many
detailed resources online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute
transform.

e Warnings are shown in the Warnings tab for:

o Javascript syntax errors
o Ambiguous column references

e For simple arithmetic operations on numbers and dates use the Calculate

transform.

See also
e Find the difference between dates/datetimes

2.3.29 Join

Description

Merge two inputs based on common (key) columns, e.g. on an email address
or ID column present in both inputs. The bottom dataset (by vertical position)
is joined to the right of the top dataset.

Examples
Join two datasets side-by-side matching the 'ID' columns, keeping only IDs in
both datasets:

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Join & & Eg
@ Merge 2 input datasets side by side using com...
Explore Keys...
By: Key b
Top key column: ? ID hd
include top non-matching row
Bottom key column: v ID v
include bottom non-matching

Name ID  DOB vV case sensitive

1/John Black 001 1966-07-01 detailed report

2 Paul White 002 1973-03-11 *0 employees.csv
3 Jill Green 003 1977-12-30 3 cols x 4 rows

4 Ahmed Ali 004 1980-11-05

P Join

>
5 cols x 4 rows
ID Department Level
1 001 Engineering 1
. : details.csv .
2 004 Marketing > © Name (D DOB

3 cols x 4 rows

3/ 003 Engineering 2 1/John Black 001 1966-07-01 Engineering 1

Department Level

4 002 Sales 2 Z‘Paul White 002 1973-03-11 Sales 2

3 Jill Green 003 1977-12-30 Engineering 2

4’Ahmed Ali 004 1980-11-05 Marketing 1

Join 2 datasets side-by-side matching the row numbers, keeping all rows:

Join % el
@ Merge 2 input datasets side by side using common (ke...

Explore Keys...

By: Row number b
Country v include top non-matching rows
1 |Afghanistan v include bottom non-matching rows
2 |Albania . X countries.csv
3 Algeria 1 col x 205 rows
4 Andorra
Join
: 9
Code 2 cols x 205 rows
1 AFG
2 |AIB * @ Codes.csv
1 c i Cods
B DZA 1 col x 205 rows ountry s
1 |Afghanistan AFG
4 |AND
| 2 Albania ALB
3 |Algeria ‘sz. ‘
4 Andorra ‘AND ‘

Inputs

Two.
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Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Click Explore Keys... to compare key values in the 2 datasets.

e Set By to:

o Key to join by common key columns.
o Row number to join by the row number of the dataset.

e Select Top key column for the column you want to match in the top input
dataset.

¢ Select include top non-matching rows if you want to include in the
output any rows in the top input with no matching value in the bottom
input.

¢ Select Bottom key column for the column you want to match in the
bottom input dataset.

¢ Select include bottom non-matching rows if you want to include in the
output any rows in the bottom input with no matching value in the top
input.

e Check detailed report to show detailed information in the Warnings and
Info tabs on duplicate keys in each dataset, overlap of keys in the 2
datasets and leading and trailing whitespace in keys. This slows down the
join significantly.

e Check case sensitive to use case sensitive matching for keys.

include top non- include bottom non-  Also known as:

matching rows matching rows

checked checked

No No Inner join

No Yes Right outer join

Yes No Left outer join

Yes Yes Full outer join
Notes

¢ Join merges two datasets side-by-side (horizontally). To merge datasets one
on top of the other (vertically) use Stack.

e If there are 10k rows or less in both datasets, Easy Data Transform will try to
guess sensible default values for Top key column and Bottom key column
based on column header names and contents.

e All values are treated as text. You can use Whitespace to remove
whitespace before the join.
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o If a key value occurs M times in the first dataset and N times in the second
dataset, you will get M x N rows with this key value. You can use Unique to
remove rows with duplicate key values.

e If you need more than one column for the key, use Concat Cols to create
that column.

e Use Row Num to create a unique key column.

e Use Sort to sort the results.

e Use the Cross transform for cross joins.

e Messages are shown in the Warnings tab for keys that occur more than
once in either dataset (duplicates).

e Messages are shown in the Info tab for keys that only occur in 1 of the 2
datasets (misses).

e Use Subtract to see rows not joined from the top or bottom dataset (an
‘anti-join"). The Clone is necessary to get the correct Y position of the
bottom dataset for the Subtract.

Clone
/]
14 cols x 750 rows
Filter & Subtract Rows not joined
11 cols X 87 rows e — from top dataset
Join
/]
24 wols x 720 rows
Filter Subtract Rows not joined
o o from bottolm dataset
14 coks x 750 rows 14 cols x 30 rows

e Cascade multiple joins to join more than 2 datasets.

CLIS LOM &r 5.CSV

lokxSlrws \
Join
L]
24 @l %830 row §
orders.csv Join
o o
14 wls x830 ows / 28 colsx 2.2k rows \
order-details.... Join
(] L]
Scols x 22k rows / 37 cols x 22k rows \
roducts.csv Join
s 3
W0@lx77 mws / “Beslsx 2k rmws \
suppliers.csv Join
9 [
12 cols x 29 mw s 51 cols x 2.2k rows
categories.csv
a9

4 cols x 8 rows
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See also

¢ Video: How to join Excel files
e Cross

e Lookup

e Interpolate
e Merge datasets

e Use multiple keys for Join/Lookup/Intersect/Subtract

2.3.30 Lookup

Description

Looks up the values of a column in the top input dataset in the bottom input
dataset and puts the result in a new column.

Examples
Lookup 'Category Name' in a second dataset using 'Category ID":

R7
Lookup %23
@ Create a new column in the top dataset using valu.
Explore Keys.

V' automatic new column name

Top key column: ? Category ID N
Bottom key column: v Category ID N
Bottom value column: v Category Name v
Matching: Exact v
Bottom values used: ~ First S
Product ID Product Name  Supplier ID Category ID
X If no match: Use no match value v
1 1 Chai 1 1
No match value:
2 2 Chang 1 1 I © products.csv v case sensitive
3 3 Aniseed Syrup 1 2 4 colsx 5 rows
4 4 Cajun Seasoning 2 2]
5 5 Gumbo mix 2] 2

, Lookup
5 cols x 5 rows:

Category ID Category Name Descript

1 1|Beverages soft drinks categories.csv Product ID Product Name  Supplier ID Category ID Lookup Category Name
2 2|Condiments sauces, relishes and seasonings* . 3 cols x 3 rows 1‘ 1 Chai 1 1 Beverages
3 3|Confections dessers and candies 2‘ 2 Chang 1 1 Beverages
3‘ 3 Aniseed Syrup 1 2 Condiments
4‘ 4 Cajun Seasoning 2 2 Condiments
| 5‘ 5 Gumbo mix 2 2 Condiments

Fuzzy lookup of company stock 'Symbol' by 'Name":

Easy Data Transform © 2025 Oryx Digital Ltd



https://www.screencast.com/t/aE7Rib6uH8l

Reference

Name Symbol “
P NP R P N B S B 3 B Ny S Y &

3 Amazon.com AMZN ‘
4 Bank of America BAC |

VYWYV VYWY

company 10 sl aa e Gu JG.

1 Amazon
11 Home Depot (The) HD

2 Bank of America

ke’ B S W S SV S S SV S S oY o o
3 Home Depot

4 McD 1d 1b 8. cE SJe A oI 0L 0. ub 4 M
cDonalds

|
5 NVIDAI L

17 McDonald's MCD
) X =t 2O ST SV T P S S A Lt Y
6 Pepsi
L PR ! S Y & L)
21 NVIDIA NVDA 4

S W Y W S A Y A A A S A A

24 PepsicCo PEP i
Lookup "9@ C? :ﬂ

@ Create a new column in the top dataset using v...

Explore Keys...

Top key column: Company v
Bottom key column:  Name v
Bottom value column: Symbol v
Matching: Fuzzy hd
Closeness: 60% :
Bottom values used:  First best v
If no match: Use no match value h

No match value:

case sensitive

Company Lookup Symbol

1 Amazon AMZN

2 Bank of America BAC

3 Home Depot HD

4 McDonalds MCD
5 NVIDAT NVDA
6/Pepsi PEP
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Lookup the staff assigned to each day:

Lookup % 1:)0 =3 E:
@ Create a new column in the top dataset using v...
Explore Keys...
v automatic new column nam;
Top key column: ? Day v
Bottom key column: v Days v
Bottom value column: v Staff v
Matching: Bottom contains top b
Bottom values used:  All b
23y Delimiter:
T If no match: Use no match value ~
2/Tuesday No match value:
3|Wednesday V' case sensitive
4/ Thursday
5 Friday \0 Clipboard
G-Saturday dElE

?|Sunday

Lookup
2 cols x 7 rows
Staff Days
1Alice Monday, Tuesday, Friday staff-days.csv
2 Bob Monday, / 2 cols x 4 rows
3 Charlie Wednesday,Friday
4 Denzil Thursday, Saturday :
Day Lookup Staff
1 Monday Alice,Bob
2 Tuesday Alice

3 Wednesday Bob,Charlie

4 Thursday Denzil
5/Friday Alice,Charlie
G-Saturday Denzil

7 Sunday

Inputs

Two.

Options
¢ Place the dataset you want to modify as the top input and the dataset you
want to lookup values from as the bottom input.
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e Click Explore Keys... to compare key values in the 2 datasets.

e Uncheck automatic new column name to set a name for the newly
created column in New column name.

¢ Select Top key column for the column whose values you wish to lookup.

¢ Select Bottom key column for the column that matches the lookup in the
bottom dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Matching to how you wish to match values with the lookup table.

o Exact, Not exact and the various contains, starts with and ends with
matches, match as text. E.g. date values 1/1/2024 and 01/01/2024 are
not considered an exact match.

o Equal, Not equal and the various greater than or greater than equal
matches, match date and numeric columns using date and numeric
comparisons (respectively). E.g. date values 1/1/2024 and 01/01/2024
are considered equal.

o Exact match is fast. Other options are likely to be much slower.

¢ Set Closeness to how close a fuzzy match has to be, to be considered a
match. E.g. set it to 80% to make 2 values that are 80% the same a match.
For Fuzzy matching only.

e Set Bottom values used to:

o All if you want to use all matches. Duplicate values are only shown once.

o First if you want use the first match in Bottom lookup column. For Exact
matching only.

o All best if you want to use the best matches. If there are multiple values
that are equally good, use all of them. Duplicate values are only shown
once. For Fuzzy matching only.

o First best if you want to use the best match. If there are multiple values
that are equally good, use the first one. For Fuzzy matching only.

¢ Set Delimiter to the delimiter you want to use to separate multiple values
returned for Bottom values used of All or All best.

e Set If no match to Use not match value or Leave unchanged, depending
on what you want to do for values in Top lookup column that do not
match in Bottom lookup column.

¢ Set No match value to the value you want to use for values in Top lookup
column that do not match in Bottom lookup column when If no match is
set to Use no match value. You can use a column variable to use values
from the top dataset.

¢ Check case sensitive to use case sensitive matching for keys.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup
column, Bottom lookup column and Bottom value column.

¢ Bottom values used is only important if there are duplicate values in the
Bottom lookup column.
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e If the top input has a header, this will be used for the output.

e If you want to see what bottom dataset keys are matched to each top
dataset key, you can set Bottom value column to the same column as
Bottom key column.

¢ Exact and Not exact match as text. So date values "1/1/2024" and
“01/01/2024" are not considered an exact match.

¢ Equal and Not equal match date and numeric columns using date or
numeric comparisons. So date values “1/1/2024" and “01/01/2024" are
considered equal.

e Text comparisons are whitespace sensitive. You can use Whitespace to
remove whitespace before the lookup.

e Exact match is fast. Other options are slower. Fuzzy matching is much
slower.

e If you want to lookup values in multiple columns, use Concat Cols to join
several columns together to form new columns.

e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.

e Use Clone to lookup a dataset with itsself.

e Warnings are shown in the Warnings tab for:

o Values that cannot be found in the bottom dataset (misses).
o Values that occur more than once in the bottom dataset (duplicates), if
Bottom values used is First.

See also

o If

e Interpolate

e Join

e Match dirty data

e Use multiple keys for Join/Lookup/Intersect/Subtract

2.3.31 Moving

Description
Add a new column with a moving average/median/sum/min/max/range of the
selected column.

Examples
Calculate a 7 day moving average for the sales column, leaving the first 6 days
empty.
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Date Sales
1 2020-07-01 100
2 2020-07-02 120
3 2020-07-03 90
4 2020-07-04 145
5 2020-07-05 95
& 2020-07-06 75
7 2020-07-07 125
8 2020-07-08 130
9 2020-07-09 95
Moving ‘s OG Eg

® Add a new column with a moving average/sum/...

Column: Sales v
Calculation: Average v
Interval: 7 -
Offset: 0 =

4

Incomplete values: Set empty

Date Sales Moving Average Sales

F

1 2020-07-01 100
S

2 12020-07-02 120

3 2020-07-03 90

4 (2020-07-04 145

5 2020-07-05 95

6 2020-07-06 15

7 2020-07-07 125 | 10?.14285?1429'
!

8 2020-07-08 130 | 111.4285714286|
, o

g 2020-07-09 a5 107.8571428571
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Calculate the sum of the current row and the rows above and below, where
available, for the sales column.
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Date Sales
12020-07-01 100
212020-07-02 120
32020-07-03 S0
4 2020-07-04 145
5/2020-07-05 95

Moving ‘= d} Ei
@ Add a new column with a moving average/sumy/...
Column: Sales v
Calculation: Sum v |
Interval: 3 -
Offset: 1 :
Incomplete values: Calculate from available v

Date Moving Sum Sales
12020-07-01 220
2|12020-07-02 310

T
32020-07-03 90 355
42020-07-04 145
52020-07-05 95 240
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Inputs
One.

Options

e Uncheck automatic new column name to set a name for the newly
created column in New column name.

¢ Select the Column you wish to calculate a moving
average/median/sum/minimum/maximum for.

¢ Set Calculation to the statistic to be calculated.
o Average shows the arithmetic mean of the values in the interval (Simple

Moving Average).
o Median shows the median of the values in the interval.
o Sum show the sum of the values in the interval.
o Minimum shows the smallest value in the interval.
o Maximum shows the largest value in the interval.
o Range shows the difference between the largest and the smallest value in
the interval (always > 0).

¢ Set Interval to the number of rows to include in each moving
average/median/sum/minimum/maximum value.

o Set Offset to the number of rows above (if negative) or below (if positive)
the current row to end each interval at.

¢ Set Incomplete values according to what you want to show for rows
without a full interval of data. For example the first 6 rows when Interval is
7 and Offset is 0.

Notes

e Non-numeric values are ignored. E.g. a 7 day moving average that includes
2 non-numeric values will be shown as an average of the 5 numeric values.

¢ You will be warned of any non-numerical values in the selected column.

See also

¢ Video: How to calculate moving averages
o Offset

e Stats

2.3.32 New Col

Description
Adds a new column, filled with a given value.

Example
Add a new column full of '1' values:
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Reference

price

1 1145
2 095

3 995

New Col d} &= Eﬂ

@ Add a new column filled with a specified value.

New column name: quantity

New column value: 1

price quantity
1 1145 1
2| 0.95 1
3 995 1

Inputs

One.

Options

¢ Set New column name to the name of the new column you want to create.
¢ Set New column value to the value for every cell of the new column. You
can leave it empty for an empty column.

Notes
e New columns are always added at the right end. You can change the
column order with Reorder Cols and the column name with Rename Cols.
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See also

e Copy Cols
e Remove Cols

2.3.33 New Rows

Description
Add new rows.

Examples
Add an empty row above every row with an invoice number:
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Invoice Lineltem Value

1 00456 1 150.00

2 2 95.00

3 3 50.0

4 00457 1 845.00

5 2 1250

New Rows 0::1 E ES
@ Add new rows.
Number added: Same for every row hd
Number value: 1 :
As: Blank row(s) hd
Location: Above each row v
For: Rows where A
Column: Invoice hd
Matches: I= Not equal to v
Value:
v case sensitive

\

Invoice Lineltem Value

1

2 00456 1 150.00
3 2 9500
4 3 50.0
5

6 00457 1 845.00
7 2 1250

Copy each row the number of times in the 'ltems' column:
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Orderld Items

1 12345 0

2 12346 1

3 12347 2

New Rows 0:} @ Eg

@ Add new rows.
Number added: Set from a column .
Number column: Items X
As: Copied row(s) v
For: Every row =

v

Orderld Items
1 12345 0

2 12346 1

3 12346 1
4 12347 2
# 12347 2
6 12347 2

Inputs
One.
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Options
e Set Number added according how many rows to add for each existing row.

o Set Number value to the number of new rows to create for each existing
row (available when Number added is Same for every row).

o Set Number column to get the number of new rows to create for each
existing row from a column (available when Number added is Set from a
column).

e Set As to add either blank rows, copies of existing rows or user defined
rows.

¢ Set With value to set the value used for each column of the new row
(available when As is User defined row(s)).

¢ Set Location depending on whether you want new rows added above or
below existing rows (available when As is Blank row(s) or User defined
row(s)).

¢ Set For depending on whether you wish to add rows to all rows, only rows
that meet certain conditions or only the first or last rows.

Notes

e You can use Calculate or Javascript transforms to calculate the number for
the Number column. E.g. to subtract 1 from the final number of copies
wanted to give the number of new rows.

See also
o Offset

e Sequence
2.3.34 Ngram

Description
Counts the number of times each sequence of consecutive words appear in
the selected column.

Examples

Find ngrams of 2 to 3 word length (bigrams and trigrams) in the 'Keywords'
column:
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Keywords Impressions

1 EDT 47

2 easy data transform 1598

3 Easy Data Transform 964

4 easy data transformer 345

5 data transformer 19343

6 EASY,DATA, TRANSFORM 23
Ngram o al === IID34]
@ Count sequences of N consecutive words in the sel... E
Column: Keywords v b
Minimum N: 2 : ;
Maximum N: 3 - :

Sum: Rows \

case sensitive

V

Keywords Ngrams Words Rows
1 easy data transform 3 3
2 easy data transformer 3 1
3 easy data 2 4
4 data transform 2 B
5 data transformer 2 2
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Sum the impressions associated with each 2 to 3 word ngram:

Keywords Impressions

1 EDT 47

2 easy data transform 1598

3 Easy Data Transform 964

4 easy data transformer 345

5 data transformer 19343

6 EASY,DATA, TRANSFORM 23
Ngram * 1:? E i
@ Count sequences of N consecutive words in the sel... .
Column: Keywords v
Minimum N: 2 - :
Maximum N: 3 : |

Sum: Impressions v

case sensitive

‘

Keywords Ngrams Words Impressions
1 easy data transform 3 2585
2 easy data transformer 3 345
3 data transformer 2 19688
4 easy data 2 2930
5 data transform 2 2585
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Inputs
One.

Options

e Select the Column you wish to analyze for ngrams.

e Set Minimum N to the minimum number of words in an ngram.

e Set Maximum N to the maximum number of words in an ngram.

e Set Sum to:
o Rows to count the number of rows containing the ngram.
o A column to sum numeric values in that column for all rows containing

the ngram.

e Uncheck case sensitive to convert everything to lower case before counting
ngrams.

e Check drilldown to allow double clicking a row in the data table to
drilldown to the rows that contributed to this row in the upstream data.

Notes

e Words are made up of letters, digits and Apostrophes ('). All other
characters are treated as word separators.

e All letters are converted to lower case.

e If you have set Sum to a column then only numeric values in that column
will be summed.

e The output sorted by number of words in the ngram, then the count and
then the ngram. Use a Sort transform to sort it in a different order.

e Use a Replace transform before the Ngram transform to remove/replace
any words or letters you don't wish to analyze.

See also

e Video: How to find NGrams in data for PPC, SEO and NPL
e Count

e Unique

e Total

e Pivot

o Stats

e Summary

2.3.35 Num Base

Description
Change the number base of integer values, e.g. decimal to hexadecimal.

Examples
Convert from decimal (base 10) to hexadecimal (base 16):
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Reference

Value
1 0
2 1
3 01
4 10
£y 20
6[RR=2E888899
7 -1
Num Base % E el

@ Change the number base of integer values, e.g. ...
E Q Filter columns

Value

v

1 of 1 columns selected

Base from: 10

4r 4>

Base to : 16

4

Non-integer: Leave

‘

Value
1 0
2 1
3 1
4a
5 14
6/98967f
TELfEffffffffffffrf

Convert from guessed base to decimal (base 10):
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Value
1 0100
2 100
3 0x100
Num Base % Qﬂ Eg

@ Change the number base of integer values, e.g. ...
E] Q Filter columns

Value

v

1 of 1 columns selected

Base from: Guess :
Base to : 10 -
Non-integer: Leave v
Value
1 64
2 100
3 256
Inputs
One.
Options

e Check the column(s) you wish to convert.
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¢ Set Base from to the base of the current values. If you set it to Guess, it will
guess the base for each column by looking at some of the values, Numbers
starting with Ox (e.g. 0x123) are assumed hexadecimal (base 16). The base
guessed in output in the Info tab.

e Set Base to to the base wanted.

Notes

e The values to be converted should be integers (whole values) without group
separators (e.g. no Commas or decimal points).

o If Base from and Base to are the same, no change is made.

¢ Negative numbers are represented using unsigned values (e.g. twos
complement for binary) if Base to is anything other than 10.

e Warnings are shown in the Warnings tab for non-integer values.

e Use Copy Cols to copy columns before conversion.

e Use Num Format to change the format of numbers (e.g. remove group
separators).

e You can use Insert to add characters to the front of values, e.g. to add '0x’
to hexadecimal values.

See also

e Video: How to convert base
e Decode

2.3.36 Num Format

Description
Change the number format in one or more columns.

Examples
Set numeric values to 2 decimal places:
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Reference

v - o

Value
1 1.27239
2 23.52035

3 49,7877

\J

Num Format & d} £ EZ
@ Change the number format in the selected colu...

o n
IE] /{:l Q Filter columns

Value

v

1 of 1 columns selected

From: Automatic v
Format to: f v

- il
Precision to; 2 v

Locale to: English ¥ | United States ~

use group separator

\

Mon-numeric: Leave

Value
1 1.27
2|
3/ 49.79

Set numeric vales to the shortest accurate number:
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Value

1 1.2720000
2 23.0035000

3 4.0787770

¥

KA
Num Format Il N

@ Change the number format in the selected colu...

[3]| A aFilter columns

Value

v

1 of 1 columns selected

From: Automatic >
Format to: 3 b4
Locale to: English ¥ United Kingdon ~
use group separator
Mon-numeric: Leave bt
Value

1L 1.272

2 23.0035

3 4.078777
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Change European style numbers to English/United Kingdom locale:
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Reference

Easy Data Transform

Value

11234567, 8

2/1.234.567,8
31 234 567,8
41'234'567,8

5€1.234.567,8

¥

Num Format Soire dll=== IDEe
@ Change the number format in the selected colu...
IE‘ /‘:" Q Filter columns

Val
v aue.

1 of 1 columns selected

From: Automatic v
Format to: f v
Precision to: 2 =
Locale to: English ¥ United Kingdon ~
use group separator
Non-numeric: Change to NaN v
Value

1 1234567.80

2 1234567.80

3 1234567.80

4 1234567.80

5 1234567.80
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Change numbers from Bengali/Bangladesh locale numbers to
Arabic/Egypt locale:
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Reference

Value

1524
2 .G

3 82498

R

Num Format % | BB Eg
@ Change the number format in the selected colu...
IE' /{1 Q Filter columns

Value

v

L i "

1 of 1 columns selected

From: Selected locale v
Locale from: Bengali ¥ Bangladesh ¥
Format to: f v
Precision to: 3 -
Locale to: Arabic ¥ Egypt v

use group separator

Non-numeric: Change to NaN v

\J

Value

1y,Yve.
2(¥F, 0¥

3/£9,v¥4:
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Inputs
One.

Options
e Check the column(s) you wish to transform.
¢ Set From according to the numeric format in the input dataset:
o Automatic: Make an intelligent guess for each column, based on the
input data. This is usually the best choice.
o US/UK. (dot): Input number are US/UK style, with . (Dot) as the decimal
separator.
o European, (comma): Input numbers are European style, with , (Comma)
as the decimal separator.
o Locale in Preferences: Interpret input numbers using the locale the
Preferences window.
o Selected Locale: Interpret input numbers using the locale in Locale from.
¢ Set Locale from to the locale of the input numbers. Available for Selected
Locale only.
¢ Set Format to to the new number format (see below).

Formatto Meaning

e Format as [-]9.9e[+|-]999.
E.g. 1234567.89 isshown as 1.235e+06.

E Format as [-]9.9E[+]-]999.
E.g. 1234567.89 isshown as 1.235E+06.

f Format as [-]9.9.
E.g.1234567.89 isshown as 1234567.89.

g Use e or f format, whichever is the most concise.
G Use E or f format, whichever is the most concise.
S The shortest accurate representation for the given

number without exponents.
E.g. 1234567.00 is shown as 1234567.

¢ Set Precision to to the precision desired.
o For the e, E, and f formats, Precision to represents the number of digits
after the decimal point.
o For the g and G formats, Precision to represents the maximum number of
significant digits (trailing zeros are omitted).
o For the s format Precision to is ignored.
¢ Set Locale to according to set the decimal and group separators and digits
for the numbers output.
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e Check use group separators to include the group separators for the
selected locale. E.g. to turn 1234567 to 1,234,567 fora
English/United States orEnglish/United Kingdom locale.

¢ Set Non-numeric according to what you want to do with non-numeric
values in transformed columns. NaN means Not a Number.

Notes

¢ Numbers should be base 10 (decimal).

e 3, £ and € characters are ignored.

¢ If Decimal symbol from is set to Locale in Preferences the allowed group
separators are set by the locale. Otherwise Dot (if not used as the decimal
separator), Comma (if not used as the decimal separator), whitespace
(including Thin Space) and Apostrophe characters are ignored.

e You can also use Extract and Pad to change the number of characters.

e Warnings are shown in the Warnings tab for non-numeric values.

See also
e Video: How to convert decimal separators and number formats
e DateTime Format

2.3.37 Offset

Description
Moves values in selected columns up or down.

Example
Move the 'v2' values down 1:
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Reference

vl v2
1 1 1
2 2 2
3 3 3
4 4 4
5 5 5
Offset ol : : Offset F c :
(@ offset values up or down in selected columns. (3 offset values up or down in selected columns. i
[E|(aFilter columns 2] (e Filter columns l
vl i vl !
v v2 2 v2 E
1 of 2 columns selected 1 of 2 columns selected E
Offset: 1 = Offset: 1 = |
Direction: Down v Direction: Down hA
wraparound V| wraparound .
New value: 0 New value: F
\al *\{2 vl {2
1 1 0 1 1 5
2 2 1 2. 2 1
3 3 2 3 3 2
4 4 3 4 4 3
5 5 4 5 5 4

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Offset to the number of rows you wish to offset values by.

¢ Set Direction to the direction you want to offset in.

e Check wraparound if you want values pushed off the bottom of the table
to be added to the top or values pushed off the top to be added to the
bottom.

¢ Set New value to the value you wish to set for any cells newly created by
the offset.

Notes
e You can use Copy Cols to create copies of columns before you offset them.
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See also
¢ New Rows
e Slide

2.3.38 Outliers

Description
Find outlier numerical values.

Examples
Set outliers empty based on quartiles and add a column with the outlier score:
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Reference

Easy Data Transform

Height

). 0.00

2 1L -5

8 1.71

4 il o7/l

5 173

6 1L 73]

7 L7

8 1.84

9 1.89

10 1.95

11 % AL(10)

12 5.00
Outliers <) ) e 3
@ Find outlier numerical values.
Column: Height S
Score by: Inter Quartile Range v
Threshold: 1.50 :

Action: Set value
Value:
Non-numeric: Treat as not outlier

v add score column

¢

Height Score
1 -8.1428571429
2 1.59 -0.5714285714
3 1.71 0
4 al 7l 0
) 1575 0
6 Lo 713 0
7 1.77 0
8 1.84 0
9 1.89 0
10 1.2 0.1428571429
11 2.10 0.8571428571
1h 14.6666666667
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Remove rows with values that are more than 1 Standard Deviation from the
mean:

Weight

1 67

2 69

3 59

4 98

5 103

6 84

7 71

8 75

9 83

10 0

11 300

Qutliers g OE{} E;
® Find outlier numerical values. ¢
Column: Weight v
Score by: Standard Deviation v
Threshold: 1.00 -
Action: Remove outlier rows v
Non-numeric: Treat as not outlier v
add score column

v

Weight
1 e7
2 69
3 55
4 98
5 103
6 84
7 71
8 75
9 83
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Inputs
One.

Options

e Select the column you wish to check for outliers.

e Set Score by depending on how you wish to score outliers.

o Inter Quartile Range scores values on how far they are above Q3 or
below Q1 as proportion of the Inter Quartile Range. For example:
= A value 2 IQRs above Q3 scores 2.0.
= Avalue 1IQR below Q1 scores -1.0.
= A value between Q3 and Q1 scores 0.0.

o Standard Deviation scores values on how many deviations they are from
the average (mean). This is also known as a Z-score. For example:

» A value 2 Standard deviations above the average scores 2.0.
= A value 1 Standard deviations below the average scores -1.0.

e Any score that is greater than Threshold or less than -Threshold is
considered an outlier. E.g. if the threshold is 1.5 then values that scores
more than 1.5 or less than -1.5 are considered outliers. The corresponding
upper and lower ‘fence' values are shown in the Info tab.

¢ Set Action to the action to take for outliers:

o Change to threshold: Value greater than the upper fence value or less
than the lower fence value are set to the nearest fence value. Non-
numeric values are not changed, as it isn't clear which fence value to set
them to.

o Remove outlier rows: Rows with outlier values are removed.

o Keep outlier rows: Only rows with outlier values are kept.

o Set value: Outlier values are changed to the value provided in the Value
field.

¢ Set Non-numeric depending on whether you want to treat non-numeric
values as outliers.

e Check add score column if you want to add an extra column with the
outlier scoring.

Notes

e Warnings are shown in the Warnings tab for non-numeric values.

e Use Num Format to change the format of numbers (e.g. remove group
separators).

e Use Impute to impute any missing values.

e Use Sort to sort by values in the score column.

e You can convert dates into numerical values (e.g milliseconds since 1970 or
Julian day) using Calculate or Javascript.
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See also
e Video: How to find outliers in data

2.3.39Pad

Description
Pad text to a minimum length in one or more columns.

Example
Pad the 'ld' column to 10 digits using zeros:
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Reference

Id Name
1 1 Alice
2 2 Bob
3 3 Charlie
4 4 Dwayne

v

Pad ff} E:
@ Pad the selected column(s) to a fixed length.

EI Q Filter columns

Id

v

Name

1 of 2 columns selected

Minimum length: 10 -

Pad: Left v

Pad with: Zeros >
Id Name

1 0000000001 Alice
2 0000000002 Bob
3 0000000003 Charlie

4 0000000004 Dwayne

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Set Minimum length to the length you want values in selected columns
padded to. Values this length or longer are unaffected.

e Set Pad to Left or Right depending on where you want any padding
characters added.

e Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Whitespace to
remove whitespace before padding.

2.3.40Pivot

Description
Creates a pivot table to summarize values for one or two columns.

Examples
Pivot to sum 'Amount’ by 'Area’ and 'Currency":
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Area Currency Amount

1 Europe EUR 13937.00

2 North Americal.22894.90

3 Africa ZAR 12745.55

48356.95

1100.00

5905.80

Pivot o Qc} EQ
@ Create a pivot table to summarize the selected ...
Pivot columns: @ ™ ® X

1 ? Currency b
Pivot rows: @ T ¥ ® X

1 ? Area v
Values: ? Amount v
Summarize by: Sum v
Set non-calculated: Zero v

V' add totals
Total by: Rows and columns b

allow drilldown

V

Area ggg_lggp_lggg_l;gu(srand Sum
1 Africa 0 0 0 12745.55 12745.55
2 Europe 19842.8 1100 0 0 20942.8
3 North America 0 0 71251.85 0 71251.85
4 Grand Sum 19842.8 1100 71251.85 12745.55 104940.2
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Pivot to sum 'Amount’ by 'Year' + 'Quarter' and 'Area’ + 'Salesman":

Year Quarter \Region Salesman |Product No |Sale
1 2023 Q3 Alice 1003, e703
2 2024 Q1 Alice 1010, 2465
B :
~a r_u/_ ny _/ nnsafl
41| o - . luw
12 2024 Q2 1004 7801
13 2024 Q2 1000 5271
14 2024 Q1 1002 6481
Pivot ODE d: @ 52
@ Create a pivot table to summarize the selected columns.
Pivot columns: @ ™ ® X
1 v Region v
2 ? Salesman v
Pivot rows: @ ™ @ X
1 v Year v
2 ? Quarter v
Values: v Sale v
Summarize by: Sum \
Set non-calculated: Zero v
v add totals
Total by: Rows and columns v
Delimiter: /
allow drilldown .

Year/Quart;L; - |i10RTH/AJ.ice NORTH/Bob SOUTH/Alice SOUTH/Bob Grand Sum
1/2023/91 0 0 0 2345 2345
2/2023/03 0 0 6703 0 6703
3/2023/04 0 0 7179 0 7179
4/2024/01 2465 6721 0 6481 15667
5(2024/02 5271 3706 7801 9660 26438
62024/04 5033 0 6629 0 11662
7Grand Sum 12769 10427 28312 18486 69994

Inputs
One.
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Options
¢ Set Pivot columns to the columns you want to use as columns in your pivot
table.
¢ Set Pivot rows to the columns you want to use as rows in your pivot table.
¢ Set Values to the column you wish to summarize.
e Set Summarize by to how you wish to summarize the values:
o Sum show the sum of the values. Non-numeric and empty values are
ignored.
o Minimum shows the smallest value. Non-numeric and empty values are
ignored.
o Maximum shows the largest value. Non-numeric and empty values are
ignored.
o Average shows the arithmetic mean of the values. Non-numeric and
empty values are ignored.
o Median shows the median of numeric values in the column. Non-numeric
and empty values are ignored.
o Mode shows the mode of numeric values in the column. Non-numeric
and empty values are ignored.
o Standard deviation is the sample standard deviation (equivalent to Excel
function stddev.s). Non-numeric and empty values are ignored.
o Count shows the number of non-empty values. A value that contains
whitespace or 0 is not considered empty.
o Count distinct show the number of non-empty values. Duplicates are not
counted. A value that contains whitespace or 0 is not considered empty.
¢ Set Set non-calculated depending on how you want to set cells not
calculated by the pivot.
e Check add totals to add row and/or column totals.
¢ Set Total by depending on whether you want to total by Rows and
columns, Rows or Columns. This is only available if add totals is checked
and Columns and Rows are selected.
¢ Set Delimiter to separate column names. Only shown if more than 1
column is selected for Pivot columns or Pivot rows.
e Check allow drilldown to allow double clicking a cell in the data table to
drilldown to the rows that contributed to this value in the upstream data.

Notes

e Column and row values are ordered alphabetically. You can change the
order after pivoting using Reorder Cols (for columns) and Sort (for rows).
Mode may not work as expected with non-integer values, due to precision
issues. You can fix this by using a Num Format transform first.

Use Num Format to change the precision of the results.

Use Scale to convert the results to percentages.

To add a column of 1 values to Sum (e.qg. to find out how many rows a value
occurs in) use a New Col transform.
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e To pivot a dataset wider see Spread. To pivot a dataset longer see Gather.

id n w
1 1
Gather *x |2
id = y =z 2 1y b
1 la b c 3 12 c

2l 29 e (|4 2[x |

Spread

See also
e Count
e Stats

e Summary
2.3.41 Pseudonym

Description
Adds a new column with pseudonymised values for the selected column.

Example
Pseudonymising a column of dates of birth:
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Name - DOB
1 Mr Andrew Adams 29/1/1992
2 Mrs Nikki Adams 13/3/1965
3 Ms Rose Atwell 21/2/1988
4 Mr Colin Ayer 7/10/1999
Pseudonym = QG E;

@ Add a new column with pseudonymised values for the se...

v automatic new column name

Column: ? DOB v
Prefix: DOB-

Start at: 1 :
Random seed: 122420 =

Name DOB DOB-Pseudonym

1 Mr Andrew Adams 29/1/1992 DOB-021
2 Mrs Nikki Adams 13/3/1965 DOBE-068
3 Ms Rose Atwell 21/2/1988 DOB-023
4 Mr Colin Ayer 7/10/1999 DOB-066

Inputs

One.

Options

¢ Uncheck automatic new column name to set a name for the newly
created column in New column name.
e Set Column to the column you want to pseudonymise.
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e set Prefix to the text to be prepended to each pseudonym. It can be left
blank.

e set Start at for the number to start at.

e Set Random seed to the seed value used by the pseudo-random generator
algorithm. This determines the order that pseudonyms are assigned to
values.

Notes
e The order in which pseudonyms are assigned to values is randomized, to
make them harder to reverse.
¢ The default Random seed value is based on the system clock when the
transform was first created.
¢ Os are added to pseudonyms, where necessary, to make all them all the
same length.
¢ You should generally use a different Prefix for each column
pseudonymised.
e Any change to the input dataset may change the mapping between values
and pseudonymes.
e To create a lookup table to reverse the pseudonymisation:
o Use Remove Cols to remove all columns apart from the original value
column and the corresponding pseudonym column.
o Use Dedupe to remove the duplicate rows.
o You can then output this to a file and use it with Lookup to restore the
original values.

Remove original Pseudonymized
column data

Remove Cols
’ ° data.csv

6 cols x 69 rows 6 cols x 69 rows

mailinglist.csv Pseudonym
Py g L g Y

6 cols x 69 rows 7 cols x 69 rows

o Remove Cols ° Dedupe

2 cols x 69 rows 2 cols x 68 rows 2 cols x 68 rows

° lookup.csv

Remove all except Remove

original and

pseudonymised du Dl.\ca tes

Lookup table

Pseudonymizing data

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Pseudonymized
data

o data.csv Original data

6 cols x 69 rows

- Lookup

7 cols x 69 rows

o lookup.csv

2 cols x 68 rows

Lookup table

Recovering pseudonymised data

See also

Video: How to pseudonymise data
e Hash

Row Num

e UUID

2.3.42 Random

Description
Adds a new column, filled with pseudo-random values.

Examples
Add a new column of random real values between -1 and +1:
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Reference

v
1 0
p 1
3 2
4 3
5 4
Random S d} = Eil

@ Add a new column filled with pseudo-random n... |

MNew column name: RNG

Type: Real v
Seed: 0 .
Minimum: -1.00 -
Maximum: 1.00 -
v RNG

1 0 -0.3584059983

2 1 0.0231829141

3 2 -0.5275243884

4d 3 -0.6523676871

5 4q 0.7553240687

Add a new column of dates randomly chosen from 1st Jan 2000 and 10th
June 2025 (inclusive):
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W
1t 1
2 2
3 3
4 4
5 5
Random % T
@ Add a new column filled with pseudo-random v...
New column name: Random
Type: Date A
Seed: 53024442 -
Minimum: 01/01/2000 -
Maximum: 10/06/2025 -
Format: yyyy-MM-dd
v Random
1 1 2008-10-07
2 22014-03-07
3 32008-10-11
4 4 2018-08-18
5 52008-07-05
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Add a new column of text values randomly chosen from 'A’, 'B' or empty:

- .;I,
1 1
2 7
= 3
4 4
5 5
Random % S

@ Add a new column filled with pseudo-random v...

New column name: Random

Type: Text v
Seed: 56515103 -
Values: A,B,
v |Random

1k 1A

2 2B

3 3A

. 4 A

5 5
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Inputs
One.

Options

¢ Set New column name to the name of the new column you want to create.

¢ Set Type depending on whether you wish to generate Real (floating point),
Integer (whole number), Date or Text values.

e Set Seed to the seed value used by the pseudo-random generator
algorithm.

¢ Set Minimum to the minimum value you want to generate. The value may
be equal to minimum, but not less. For Type is Real, Integer or Date only.

e Set Maximum to the maximum value you want to generate. The value may
be equal to maximum, but not more. For Type is Real, Integer or Date only.

¢ Set Format to the date format. For Type is Date only.

¢ Set Values to a comma delimited list of values to choose from. Empty and
duplicate values are allowed. Values may not contain commas. For Type is
Text only.

Notes

e The values output are a sequence of pseudo-random values based on the
Seed value.

e The same sequence is always output for the same options.

e The default Seed value is based on the system clock when the transform
was first created.

e If Type is set to Text, you need to provide a

¢ As an alternative to setting Type to Text, you can use Random with Type
set to Integer and then use the results in conjunction with Lookup to
lookup text values using an integer key.

e To generate random dates or datetimes then use Random with Type set to
Integer and then use the results in conjunction with Calculate with
Operation set to MSecsToDateTime.

e To generate passwords use Random in conjunction with the Hash
transform.

e New columns are always added at the right end. You can change the
column order with Reorder Cols.

e You can use the Correlate transform to check sets of random numbers are
not correlated. This show the very low correlation between 2 sets of
1,000,000 values between 0.0 and 1.0 generated by Random using seeds 0
and 1:
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Correlation Random Random

1 Random 1 0.000802%644

2/Random 0.0008025644 1

See also

e Sample
e UUID

2.3.43 Remove Cols

Description
Removes columns.

Example
Remove the 'Area' column:
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Area Currency Amount

1 Europe EUR 13937.00
2 North America USD 22894.90

3 Africa ZAR 12745.55

KAy

Remove Cols Q{: e Nt

@ Uncheck columns you wish to remove.

[ — —_—
E Q Filter columns

:
Area !
c E
urrenc !
v ey E
i
Amount
v !
)
Currency Amount
1 EUR 13937.00
2 UsSD 22894.90
3 ZAR 12745.55
Inputs
One.
Options

e Uncheck the column(s) you wish to remove.

Notes
e The column will be removed from any dataset ‘downstream’.
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See also
e New Col

2.3.44 Rename Cols

Description
Rename column headers.

Example
Rename columns 'first' to 'First' and 'last' to 'Last":

first last

1 John

2|Jane

Smith

Smith

R

K A
Rename Cols = (f} ¢ N
@ Rename column headers.
a | AllAal48 28 5al % | C|IES&3|(aFilter columns
Old name New name
first First
last Last
First Last
1 John Smith
2 Jane Smith
Inputs
One.
Options

e Change the column headers using the New name column.
e Click the @ button to change all the names to lower case.
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e Click the A button to change all the names to upper case.

e Click the A2 button to change all the names to title case.

e Click the 5 button to replace space characters with underscore characters.

e Click the ‘% button to replace name text using text, exact text or Regular
expression matching.

e Click the %A button to add text to the front or back of all the names.

e Click the % button to add '-2', '-3" etc to duplicate names, to make them
unique.

e Click the C button to change all the names back to their original name.

e Click the B button to copy names to the clipboard.

e Click the & button to paste from from the clipboard.

e Type text into the Filter field to temporarily hide columns whose old or new
names do not contain this text.

Notes

e The names of column headers do not have to be unique.

e Column filtering is sensitive to whitespace, but not case.

e Warnings are shown in the Info tab for duplicate column names (case
sensitive).

e If you are pasting names, the format expected is Comma delimited text. E.g.:
namel, name2, name3.

2.3.45Reorder Cols

Description
Reorder columns.

Example
Reorder 'Last’, 'First' and 'Title' columns:
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Last Fii Title
1 Smith John Mr

ESmil:hMDr

Reorder Cols dﬁ @ ;i

@ Drag columns to reorder.

N MMEEE

Title
First
Last
Title |First |Last
1 Mr [John Smith
2 Dr Smith
Inputs
One.
Options

Drag the columns into the desired order (left-most at the top).

Click the Move first button to move the selected columns to be first.

Click the Move up button to move the selected columns up one place.

Click the Move down button to move the selected columns down one place.
Click the Move last button to move the selected columns to be last.

Click the Sort ascending button to sort the columns in ascending order of
name.

Click the Sort descending button to sort the columns in descending order of
name.

Click the Reset button to restore the original column order.
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Notes

e You can also rename columns with Rename Cols and remove unwanted
columns with Remove Cols.

e Number, date and text values are treated differently for sorting purposes,
when sorting columns.

2.3.46 Replace

Description
Replace text in one or more columns.

Examples
Replace US state initials in the 'Address' column:
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First  Last Address
1Jane  Smith 100 W St, Tucson, AZ

2 Ahmed Ali 17 N St, Anchorage, AK

3 Josh  Jones 123 S St, Fort Smith, AR

‘

Replace F e
@ Replace multiple text in the selected column(s). ...
E Q Filter columns

Last =

Address
v

1 3
1 of 3 columns selected

@M ®EB|&E X

Match Type Replace With
1 Text ¥ AK Alaska
2 Text ¥ AR Arkansas
3 Text ¥ AZ Arizona

v case sensitive

V

First  Last Address

1 Jane  Smith 100 W St, Tucson, Arizona
2 Ahmed Ali 17 N St, Anchorage, Alaska

3 Josh Jones 123 S St, Fort Smith, Arkansas
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Reformat phone numbers using a regular expression:

| c
‘ Home Business
i1

0123456789 0123489404
I

i 2 0139384892 0129347236
I
| 30153498348 0150923404

R

Replace

FE

¥ N
@ Replace multiple text in the selected column(s). Can use powerf...
[ =] (aFilter columns

Home
v .

Business
v .

2 of 2 columns selected

@MV ®E S X

Match Type Replace With
1 Regex v 0(\d\d\d\d)(\d\d\d\d\d) |(+44) \1 \2
Vv case sensitive
Home Business

1 (+44) 1234 56789 (+44) 1234 89404

2 (+44) 1393 84892 (+44) 1293 47236

3 (+44) 1534 98348 (+44) 1509 23404

Replace a whole word using a regular expression (\b=word boundary):
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company

l1€8lorado & Co

Replace o (Lo lll=== | ke
@ Replace multiple text in the selected column(s).

—— .
E| Q.-llr_'-' columns

v company

1 of 1 columns selected
® 1T VRS X

Match Type Replace With
1| Regex ¥ \bco\b Company

case sensitive

company

1|;l-:::rado & Company

Replace empty values:
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| nl n2 n3

1 123.8 9876.1

2981234 233
| 3 288
Replace OP Eg

@ Replace multiple text in the selected column(s). Can use powerf...
El Q Filter columns

v,m

v,nz

Jna

3 of 3 columns selected |
@1V RBAX |

Match Type Replace With
1 Empty ¥ 0.0

- I
v case sensitive

Y

n n2 n3

(1 123.86 98761 0.0

2981234 00 233

3 288 00 00

Remove symbols:
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Amount
1 $100.0
2 $95.2
3 $45.3
4 $15.6
Replace * Ij: BB Ei

® Replace multiple text in the selected column(s).
E Q Filter columns

Amount
v

1 of 1 columns selected

@1V ®BSX
Match Type Replace With
1 Symbols v

V

Amount
1 100.0
2 a5.2
= 45.3
4 15.6
Inputs
One.
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Options
e Check the column(s) you wish to transform.
e Click the ® button to add a new replace term.
e Click the T button to move the selected terms up.
e Click the ' button to move the selected terms down.
o Click the ® button to delete the selected terms.
o Click the B button to copy all terms to the clipboard.
e Click the & button to paste terms from the clipboard.
e Click the X button to clear all terms.
e Add the terms you wish to replace and how you wish to replace them.
o Choose the Match type as:
» Text to replace matches contained in the text.
» Exact text to replace the text only if it matches exactly (whitespace
sensitive).
» Regex to match using a Regular expression.
= Empty to match empty cells (cells with whitespace are not empty). The
Replace value is ignored.
= Letters to match letters, e.g. 'a’. The Replace value is ignored.
= Digits to match numeric digits, e.g. '1". The Replace value is ignored.
» Punctuation to match punctuation characters e.g.',". The Replace value
is ignored.
» Symbols to match symbol characters e.g. '$'. The Replace value is
ignored.
= Space to match whitespace characters. The Replace value is ignored.
o In Replace put the text you want to replace for Text, Exact text or Regex
matching. You can use a column variable.
o In With put the text you want to replace it with. You can use a column
variable.
e Check case sensitive to use case sensitive matching for Text, Exact text or
Regex matching.

Notes

e The order in which the Replace operations are carried out is always from
the top term to the bottom term.

e If you can to keep the original column use Copy Cols to copy the column
first.

e Comparisons are whitespace sensitive. You can use Whitespace to remove
whitespace before replacing.

e If you are pasting in replacement terms, the format expected is Comma
delimited text with 3 columns.
o The first column is the 0-based index of the Match Type drop-down list.
o The second column is the text Replace.
o The third column is the text With.
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For example, pasting in:

0,YES, 1
2,7Y$,1
Will add:
Match Type Replace With
1 Text ¥ YES 1
2| Regex v AYS 1

You can also try copying terms to the clipboard and pasting into a text file to
see the format. If you only paste in 1 column of text, it will be assumed to be
a list of Replace. You can, of course, use Easy Data Transform to create the
appropriate filter terms and paste them into memory.

See also
e Insert
e Substitute

2.3.47 Reshape

Description
Change the number of columns and rows.

Example
Change from 3 columns x 2 rows to 2 columns x 3 rows:
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1l 1| 2| 3

-
!

Reshape %S | o
@ Change the number of columns and rows.
Number of columns: 2 =

A B

1] 1] 2

2

3 5 6
Options

e Set Number of columns to the new number of columns you want to have.
The number of rows will be calculated automatically.

Inputs
One.

Notes

e Any extra values added will be set to empty. E.g. If 7 columns x 3 rows is
reshaped into 4 columns x 6 rows, the 3 new values will be set to empty.

e To get the effect you want, you may need to add empty columns with New
Col, before Reshape.

See also

e Concat Rows
e Split Rows
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2.3.48 Row Num

Description
Add a new column that contains the row number.

Example
Add a row number starting at 1:

Product Id
1 A00001

2 A00002

3 A00003

Y

Row Num ‘%d"ﬁx

@ Add a new column with the row number.

New column name: Row Num

Start at: 1 :
Increment: 1 :
Every: 1 .

'

Product Id Row Num
1 A0D001 1
2 A00002 2
3 A00003 3
Inputs
One.
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Options

¢ Set New column name to the name of the new column you want to create.

e Set Start at to the number you want to use for the first row.

¢ Set Increment to the amount you wish to increment by.

¢ set Every to how often to apply the increment (e.g. set to 5 to increment
once every 5 rows).

Notes

e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.

e You can Pad the row number with zeros to turn it into a column of unique
Ids with a fixed length.

¢ You can use Row Num with a Calculate transform using operation
MSecsToDateTime to create a sequence of dates.

¢ You can use Row Num with Calculate transform using operation Modulus
and an [f transform to create a sequence of repeating text.

See also
e UUID

2.3.49 Sample

Description
Selects a subset of rows from the input.

Example
Sample 3 rows from 5:
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Timestamp Temperature (F) Humidity (RH )
1 2020-10-19T20:40 143.5 108
2 2020-10-23T19:45 119.6 127

5 2020-11-05T07:15 130.8 132

Sample - dﬁ L] E »Z '
@ Sample from all rows. Useful for testing changes to d...
Rows: 3 -
Select: Evenly v
Random seed: 93267 =

disable sampling

'

‘Timestamp Temperature ( F) Humidity ( RH )
1.2020-10-23T719:45 119.6 127

2020-10-30T716:40

Inputs
One.

Options

¢ Set Rows to the number of rows you want to output. If it is the same or
greater than the number of rows in the input, then the input will be
unaffected.
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¢ Set Select depending on how you want the rows sampled.
e Check disable sampling to turn off sampling. If sampling is disabled, the
transform does nothing.

Notes

e If you set Select to Randomly (for quality) or Randomly (for speed), rows
will be selected using a pseudo-random number generator, initialized with
Random seed. Changing the seed will change the rows sampled.

¢ With the same Random seed and the same Select value you should get the
same random sampling, even across Windows and Mac versions of Easy
Data Transform.

e Random (for speed) is significantly faster than Randomly (for quality),
but the results may be less random.

e If you are transforming a large dataset, then you can use Sample to test a
small subset.

e If you need to do something more complex than Sample can handle (e.g.
keep only rows 500 to 1000) then use Slice or Row Num followed by a Filter.
For the most complex cases use Row Num, followed by Javascript, followed
by a Filter. E.g. this Javascript function returns 1 for every 10th row
between 1000 and 2000 and 0 otherwise:

return $(Row Num) >= 1000 & $(Row Num) <= 2000 & $ (Row
Num) % 10 == 0O;

2.3.50Scale
Description

Scale (normalize) numeric values, e.g. to a percentage or 0 to 1.

Examples
Scale a single column to a percentage:
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Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale Qc E 3

@ Scale numeric values, e.g. to a percentage or 0 t...

E Q Filter columns

Item

v Di.s.plljted

1 of 2 columns selected

4 )

Scale to: 100
Using:  Sum v

Of: All values v

‘

Item Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions |20.5633113897
3 Unknown 13.6227590823
4 Delivery & Installation 13.0305037981
5 Service Delivery 2.8524001673

6 Technical Issues 0.6425123193

Scale a table with row, column and grand totals to a percentage (scale to 400
as each value is also added to the row total, column total and grand total):
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Sum Amount EUR GBP usD ZAR Total
1 Africa 0.00 0.00 0.00 12745.55 12745.55

2 Europe 19842.80 1100.00 0.00 0.00 20942.80

3 North America 0.00  0.00 71251.85 000 71251.85

4 Total 19842.80 1100.00 71251.85 12745.55 104940.20

y

KA
Scale d} vy
® Scale numeric values, e.g. to a percentage or 0 t...
IE' Q Filter columns

Sum Amount

EUR
v

v GBP

usb
v

v ZAR.

Total
v _

5 of 6 columns selected

4

Scale to : 400

Using:  Sum

Of: All values v

\

Sum Amount EUR GBP uspbD ZAR Total
1 Africa 0 0 0 12.1455362197 12.1455362197

2 Europe 18.9086737018 1.0482160316 0 0 19.9568897334

3 North America 0 0 67.8975740469 0 67.8975740469

4 Total 18.9086737018 1.0482160316 67.8975740469 12.1455362197 100

Scale heights and weights so that the largest in each column is 1 and the
smallest is 0.
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Name Height (m) Weight (Kg)
1 Alice 1.65 65.0
2 Bob 1.99 98.0
3 Charlie 1.93 76.0
4 Doug 2.02 89.5
5 Erin 1.89 76.3
Scale )‘;f D i I

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Name

v Hgig ht {m) |

v Welllght (Kg) |

2 of 3 columns selected

Scaleto: 1 =
|
Using:  Maximum v |
|
Of: Each column >

\

Name Height (m) Weight (Kg)
1 Alice 0.8168316832 0.6632653061

2 Bob  0.9851485149 1
3 Charlie 0.9554455446 0.7755102041
4 Doug 1 0.9132653061

5Erin  0.9356435644 0.7785714286

Scale heights and weights so that the largest in each column is 1 and the
smallest is 0.
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Name Height (m) Weight (Kg)
1 Alice 1.65 65.0
2 Bob 1.99 98.0
3 Charlie 1.93 76.0
4 Doug 2.02 89.5
5 Erin 1.89 76.3
[ scale - * — FECT

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Name

v HE|.g.ht (m)

v V-l-"eight (Kg) _

2 of 3 columns selected

Scale from: 0

4P

Scaleto: 1

Using: Minimum & Maximum v

Of: Each column v

‘

Name Height (m) Weight (Kg)
1 Alice 0 0

2 Bob 0.9189189189 1
3 Charlie 0.7567567568 0.3333333333
4 Doug T 0.7424242424

5 Erin 0.6486486486 0.3424242424

Inputs
One.

Options

¢ Set Columns to the columns whose values you want to scale.
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e set Scale from to the value you want to scale the minimum value to. E.g. 0
if you want the minimum value scaled to 0. This is only available when
Using is set to Minimum and Maximum.

e Set Scale to to the value you want to scale the maximum or sum value to.
E.g. 100 for a percentage.

¢ Set Using depending on whether you want to use the Sum, Maximum or
Minimum and Maximum values for scaling.

¢ Set Of depending on whether you want to scale for Each column, Each
row or for All values.

Notes

e Whether values are interpreted as numbers depends on |ocale.

¢ Non-numeric values (including empty values) are ignored.

e To replace empty values with zeros use the Replace transform.

¢ To modify the numerical precision of the results use the Num Format
transform.

e To add a '%' at the end of values use the Insert transform.

e To copy columns before using Scale use Copy Cols .

e Warnings are shown in the Warnings tab for non-numeric values.

See also
e Video: How to normalize data

2.3.51Sequence

Description
Add missing rows from an integer or date sequence.

Examples
Add missing IDs in the current range, with values copied from above:
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Reference

| ID CODE

1 1A

2 5B

3 10je

Sequence ‘f'g Q{’ :;

@ Add missing rows from a sequence,
Rows added: Missing integers M
From column: | ID - |
Minimum: User defined b
Minimum value: 1
Maximum; User defined v
Maximum value: 15
Order: Ascending v
MNew values: Copy from above > |

ID CODE
1 la
2 2A
3 3A
4 4 A
5. 5B
6. 6B
?l 7B
8. 8B
9. 9B

Add missing dates in a specified range as 0 sales:
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Date Sales
112/1/2023 100

2‘7/1/2023 2000

3|9/1{2023 ‘ 555

Sequence & Q{} Ei
(?) Add missing rows from a sequence.
Rows added: Missing dates ¥
From column:  Date M
Minimum: User defined v
Minimum value: 2023-1-1
Maximum: User defined v
Maximum value: 2023-1-14 v
Order: Ascending ¥ E
New values: User defined v
With value: 0

Date Sales
1 |1/1/2023 0
2 2/1/2023 100
3 |3/1/2023 0
4 14/1/2023 0
5 |5/1/2023 0
6 |6/1/2023 0
T T7/1/2023 2000
8 |8/1/2023 0
g 9/1/2023 555
10/10/1/2023 0
11/11/1/2023 0
12|12/1/2023 0
13/13/1/2023 0
14/14/1/2023 0

Create an integer sequence from a dataset with no rows:
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Sequence a CP E2E E ;
@ Add missing rows from a sequence.
Rows added: Missing integers >
From column: N -
Minimum: User defined >

Minimum value; 0
Maximum: User defined -

Maximum value: 9

Order: Descending v
New values: Blank =
N
1|9
2 | 8
3|7
4 | 6
5|5
6 4
713
8 | 2
9 1
10 0
Inputs

One.
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Options
¢ Set Rows Added to Missing integers or Missing dates depending on the
type of sequence.
¢ Set From column to the column with the incomplete sequence.
e Set Minimum to:
o From data to set the minimum value in the sequence to the minimum
value in the selected column.
o User defined to set the minimum value to a value set by the user.
¢ Set Maximum to:
o From data to set the maximum value in the sequence to the maximum
value in the selected column.
o User defined to set the maximum values to a value set by the user.
e Set Order according to whether you want the dataset sorted Ascending or
Descending by the selected column.
¢ Set New values to:
o Blank to set new row values to empty.
o Copy from above to set new row values to the same as the next row
sorted above from the input dataset.
o Copy from below to set new row values to the same as the next row
sorted below from the input dataset.
o User defined to allow the user to choose a value for new row values. Set
With value for the new value to use.

Notes

¢ Existing sequence values are unchanged.

e You can add leading zeros to integers values created using the Pad
transform.

e Dates added will try to follow the format of existing dates, using the date
formats listed in the Dates tab of the Preferences window. If you want ISO
dates, make sure yyyy-MM-dd is above yyyy-M-d in the Dates tab of the
Preferences window.

¢ You can change the format of dates created using the DateTime format
transform.

e If you only want to add some values from a sequence (e.g. odd numbers or
weekdays) then you can do this by using Sequence followed by Filter to
remove the unwanted values. You might need to use Calculate with the
Modulus and/or Day of week operation to create a column to filter on.

e Use the Cross transform if you want to combine multiple sequences. E.g. to
cross hourly times (00:00, 01:00 ... 23:00 ) with a date sequence.

See also
e Video: How to insert missing dates
e New rows
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Reference

Impute
e Interpolate

2.3.52Slice

Description
Keep or remove a continuous section of rows.

o Fill
L]

Example
Keep only the rows between the 'YEAR' rows:
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1 2 3 4
1 YEAR JAN FEB MAR

2 1980 256.9 238.5 2754
3 1981 2489 2249 2591
4 YEAR JAN FEB MAR
5 1982 258.6 230.0 2804

6 1983 275.9 2349 251.9

4

Slice d} B Ei
® Keep or remove a continuous section of rows.
Mode: Keep v
From: First row where v
Column: 1 v
Matches: = Equal to v
Value:  YEAR

include 'From' row

To: Last row where v
Column: 1 v
Matches: = Equal to b
Value:  YEAR

include 'To' row

v case sensitive

v

1 2 3 4
1 1980 256.9 238.5 2754

2 1981 2489 2249 259.1
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Inputs
One.

Options

¢ Set Mode depending on whether you want to keep or remove the slice.
¢ Set From according to how you want to choose the first row of the slice.
e Set Column, Matches and Value to match the first row. You can use a
column variable for either Value.

Uncheck Include ‘From’ row if you don't want to include the first row in
the slice.

Set To according to how you want to choose the last row of the slice.
Set Column, Matches and Value to match the last row.

Uncheck Include ‘'To' row if you don't want to include the last row in the
slice.

e Check case sensitive to use case sensitive matching for text.

Notes

e If there is no match for the From or To row:

o Mode=Keep will remove all rows

o Mode=Remove will keep all rows

e Number, date and text values are treated differently for Equal to, Greater
than, Less than, Greater than equal, Less than equal and Not equal to
operations.

o If both values are numeric, a numeric comparison will be carried out. This
is accurate to approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date
comparison will be carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will
be compared as text. So you might want to replace empty values with 0
or remove those rows with Filter, before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches
regex, Is not, Doesn't start with, Doesn't end with and Doesn't match
regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not
match Is empty. You can use Whitespace to remove whitespace before
filtering and Replace to get of other unwanted characters (e.g. whitespace
inside the text).

e See here for more details on Regular expressions (regex).

e If you want to keep or remove a selection of rows by row number, use a
Row Num transform followed by a Filter transform.
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2.3.53Slide

Description
Move non-empty values in selected columns to adjacent non-empty cells.

Examples
Move all non-empty values to the top:
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Alice Bob TS
litask 1
2 task 2
3 task 4
4 task b6 task 7
Slide & d} E;

® Move non-empty values in selected columns to...

o — a
E] 2 (QFilter columns

Ali
v Alice |

, Bob

N, Charlie

3 of 3 columns selected
Direction: Up v

For: All rows v

v

Data Characters  Warnings

3 cols x 4 rows
BBRIHZ VK < >

Alice Bob Charlie

1task 1 |[task 2 task 3
2 task 4 task 7
3 task 6

4
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Move all non-empty values to the top within rows of same priority:
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Priority Alice Bob Charlie
1 High task 1
2/High ntask 3
3/ Low task 4 task 5
4 Low task 6 task 7
Slide i e gl == lhae

@ Move non-empty values in selected columns to...

EI /{[ Q Filter columns

Priority

Alice

v

v Bob

v Charlie

3 of 4 columns selected

Direction:  Up v
For: Rows with same key value v
Key column: ? Priority v
Priority Alice Bob _Charlie
1 High task 1 |task 2 task 3
2/High |
3 Low task 4 [task S5 |task 7
4 Low task 6
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Inputs
One.

Options

e Check the column(s) you wish to move values in.

¢ Select Direction depending on the direction you wish to move values.

¢ Set For to Rows with same key value, if you wish to only slide up/or down
when when 2 adjacent rows have the same value in the Key column
column.

Notes

¢ Cells containing whitespace are not considered empty.

e Matching for Rows with same key value is sensitive to case and
whitespace.

¢ You can delete rows left empty using Filter and columns left empty using
Remove Cols.

e To fill empty values with something else use the Replace transform.

See also

e Offset

e Fill

e Whitespace
2.3.54 Sort

Description
Sorts rows by one or more columns.

Examples
Sort by 'Last' and then First' columns:
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Title First Last

1Mr John Smith

2 Dr |Jane ‘Smith

3 Mr |Alhert‘5m'rl:h

4 Mr  John Doe

v

Sort S| 24
@ Sort rows by text, numeric and date values in th...

@1 @]

Column Order
1| Last ¥ Descending ¥
2 First ¥ Descending ¥

V

Title _First _Last
1Mr  John Doe

add rank

4 Mr  John Smith

Sort by 'Category' and then 'Score' columns. Rank for each distinct '‘Category"
value:

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Name Category Score

1 Ancly Novice

3|Charles Novice

Sort %@ d’ B Dg
@ Sort rows by text, numeric and date values in th...
@ 1T ¥ ® X
Column Order
1/ Category ¥ Descending ~
2/ Score ¥ Descending ¥
v add rank

Rank type: Minimum v
Rank by:  Category v |

Name Category Score Rank

5 Charles Novice

3

4

|Andy Novice 122 2

Inputs
One.

Options

o Click the @ button to add a new sort level.

e Click the T button to move the selected sort levels up.

e Click the Y button to move the selected sort levels down.
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o Click the ® button to delete the selected sort level(s).
e Click the X button to clear all sort levels.
¢ Set Column to the column you want to sort by.
¢ Set Order depending on whether you want to sort this column Ascending
or Descending.
e Check add rank to add a ranking column
o Set Rank type according to how you wish to do the ranking:
* Minimum: Uses the minimum rank of each group.
= Average: Uses the average rank of each group.
»* Maximum: Uses the maximum rank of each group.
» Dense: Each successive rank is only incremented by 1. There are no
gaps.
» Cumulative: Shows the proportion of rows (0 to 1) with the same or
lower numbered rank.

For example:
Sorted score
1 131
2 123
3 123
4 123
5 120
6 120

Gives the following rankings, depending on Rank type:
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Rank type

Sorted Minimum Average  Maximum Dense Cumulativ
score e

131 1 1 1 1 0.167

123 2 3 4 2 0.667

123 2 3 4 2 0.667

123 2 3 4 2 0.667

120 5 5.5 6 3 1

120 5 5.5 6 3 1

o Set Rank by to rank separately for each distinct value in this column.
Leave as <None selected> if you only want a single ranking for all
rows.

o Check intelligent sort to sort dates as dates and numbers as numbers.
Otherwise everything will be alphabetically sorted as text.
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v intelligent sort ]

locale aware

case sensitive

Data Characters

1 col x 9 rows

BV =

d
1

207/03/1999
331/07/2000
411/01/2020

501/11/2021

intelligent sort

locale aware

case sensitive

Data Characters

1 col x 9 rows

(86 @HH=

d
1

201/11/2021
301/11/2021
401/11/2021

501/11/2021

©01/11/2021 607/03/1999

701/11/2021 711/01/2020
g801/11/2021 §29/01/2022

929/01/2022 931/07/2000

o Check locale aware to use the Locale set in Preferences to determine the
sorting order. If this is unchecked the sorting will be by Unicode character
value, which is a lot faster.

o Check case sensitive for case sensitive sorting. This option is not available
if locale aware is checked.

Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are
the same will be sorted by level 2 etc.

e Number, date and text values are treated differently for sorting purposes.

e Any values that can be converted to numbers will be treated as numbers.

¢ Any values that match the supported date formats in Preferences will be
treated as dates.
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e Comparisons of text are case and whitespace sensitive. You can use Case to
change the case and Whitespace to remove whitespace before sorting.

e If you want to rank rows without losing the original order, use Row Num to
add a row number before the Sort, and then use another Sort on the Row
Num column to return to the original order.

e Columns that are not being sorted, can be sorted into any order and this
may vary between different releases of Easy Data Transform and Windows
and Mac versions.

See also
e Video: How to rank data

2.3.55 Split Col

Description
Split a column into multiple new columns or rows.

Examples
Split the 'Courses' column into multiple columns or rows:
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Reference

Name Courses

1 Alice  C001,H005
2 Bob  |POD2

3 Charlie|C001,P003

4 Denzil |E007,C001,H005

split Col ||| =] b Ee split Col % FE T
@ Split a column into multiple new columns or rows. ® Split a column into multiple new columns or rows.
Column: Courses e Column: Courses v
Using: Text delimiter = Using: Text delimiter b
Delimiter: |, Delimiter:

Into: Columns \ Into: Rows \

Ordering:  Current = Ordering:  Current b
keep empty keep empty

Min. values: 0 = Min. values: 0 =

Max. values: 100 = ‘ Max. values: 100 s

v v

Name Courses Courses1 Courses2 Courses3 Name Courses
1 Alice  C001,H005 €001 H005 1 Alice €001
2 Bob  P002 P002 2 Alice  H005
3 Charlie C001,P003 C001 ‘PUOB 3 Bob  PO0O2
4 Denzil E()OT,CO(]LHU()S\EOO? JEON HO005 4 Charliem
5 Charlie POD3
6 Denzil E007
7 Denzil €001
8 Denzil HOOS

Split the '"URL' column into multiple columns using colon, slash, question mark
or ampersand:
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URL

1 https://www.easydatatransform.com/index.html?utm=adwords&token=xxx

2 https://www.perfecttableplan.com/download.html

3 https://www.hyperplan.com/buy.html?utm=twitter

¥

Split Col %l P23

@ Split a column into multiple new columns or rows.

Column: Courses =
Using: Regex delimiter v

Delimiter:  [:/?&]

Into: Columns v
Ordering:  Current S
keep empty

Min. values: 0

Max. values: 100 -
URL URL1 URL2 URL3 URL4 URLS
1 https://www.easydatatransf... https www.easydatatransform.co... index.html utm=adwords token=xxx

2 https://www.perfecttablepl... https www.perfecttableplan.com download.html

3 https://www.hyperplan.co... \https |www.hyperplan.com

Jbuy.html utm=twitter

Split characters 4 to 13 and 15 onward into new columns:
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ID

1 XXXTID34982347-423434
2 XXXID34983441-7347877

3 XXXID34973883-07434

V

split Col %= FEE D3
@ Split a column into multiple new columns.

Column: ID "

Using:  Lengths v
Lengths: -3,10,-1,*

Into: Columns v

Ordering: Current v

ID ID1 ID2
1 XXXID34982347-423434 1ID34982347 423434

2 XXXID34983441-7347877 ID3459583441 7347877

3 X¥XID34973883-07434 ID34973883 07434

Inputs
One.

Options

e Select the Column you wish to split.

¢ Set Using depending on whether you wish to split using a Text delimiter
(usually a single character), a Regex delimiter or Lengths of each column.

¢ Set the Delimiter for splitting the column. E.g., (Comma). For Text
delimiter or Regex delimiter only.
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¢ Set Lengths as a Comma separated list of the number of characters in each
new column. Put - in front of a value to ignore it. Use * as a wildcard to
mean 'the rest of the value'. Only 1 * can be used. For Lengths only. For
example:
o 3,5, 4 will create 3 columns with characters 1-3, 4-8 and 8-11
o -3,5,-4,* will create 2 columns with characters 4-8 and 12 onward
o —*, 3 will create 1 column with the last 3 characters
o 2,-*,2 will create 2 columns with the first 2 and last 2 characters

¢ Set Into to:
o Columns to create a new column for each split value.
o Rows to create a new row for each split value (the original row is

removed).

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to keep empty values (e.g. honor delimiters
with nothing in between). For Text delimiter or Regex delimiter only.

e set Min. values to the minimum number of columns/rows you wish to split
each value into. For Text delimiter or Regex delimiter only.

¢ set Max. values to the maximum number of columns/rows you wish to split
each value into (ignored if less than minimum). For Text delimiter or Regex
delimiter only.

Notes

¢ Set Min. values to the same as Max. values to always create the same
number of columns.

e To split a column by Carriage Returns or Tabs set Using to Regex delimiter
and set Delimiter to \n or \ t, respectively.

e If Into is Columns, new columns are added at the right end. You can
change the column order with Reorder Cols.

e If there is a header, the header of the new column is based on the original
header. You can change the column name with Rename Cols.

¢ The opposite of Split Col with Into as Columns is Concat Cols.

e The opposite of Split Col with Into as Rows is Unique.

See also

e Split Name
e Split Rows

2.3.56 Split Name

Description
Split a column containing people's names into separate columns for first
name, last name etc.
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Examples

Split the 'names' column into separate columns for honorifics, first names,
middle names, last names and suffixes.

names

1Mrs Jill H. Jones-Lee
. 2Major General Sir Reginald James White, OBE
|

3Elder Chuck Smith Jr. IIT

i fted =]V

(@) Split a column containing people’s names into separat.

i
izl[-lr. Axel Petersen MBA
‘SLeonardo Da Vinci DEF

Split Name
[Column: v names v
Names may contain

V' honorific(s)
(Custom honorifics:  Elder
v first name(s)
v middle name(s)

Inputs
One.

Options

Honorific

Middle

Suffix

v last name(s)
Num last names: 1 -
v suffix(es)
(Custom suffixes: abc,def,ghi
nar[;es T Honorific First Middle Last Suffix
1Mrs Jill H. Jones-Lee Mrs Jill H. Jones-Lee
2Major General Sir Reginald James White, OBE Major General Sir Reginald James White OBE
3|/Elder Chuck Smith Jr. IIT Elder Chuck Smith Jr. IIT
4 Hr. Axel Petersen MBA Hr. Axel Petersen MBA
5 Leonardo Da Vinci DEF Leonardo Da Vinci DEF

Dr/John/A.Smith|PhD

First

Last

e Select the Column with the names you wish to split.
e Check honorific(s) if names may contain honorifics/titles.

Easy Data Transform
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¢ In Custom honorifics add any honorifics that Easy Data Transform does not
recognize, as a comma separated list. Case is not important.

e Check first name(s) if names may contain first/given names.

¢ Check middle name(s) if names may contain middle names.

e Check last name(s) if names may contain last/family names.

e Set Num last names to the number of last names expected for each name
(not including particules). E.g. this will typically be 1 for UK and US names
and 2 for Spanish names.

e Check suffix(es) if names may contain suffixes/post-nominal titles.

¢ In Custom suffixes add any suffixes that Easy Data Transform does not
recognize, as a comma separated list. Case is not important.

Notes
¢ The Split Name transform uses various heuristics (rules of thumb) to split a

name into parts. It expects each value to be a single name in the order:
honorific(s) -> first name(s) -> middle name (s) ->

last name(s) -> suffix(es), separated by whitespace or commas.
Some of the name parts can be missing, but they must be in this order.

¢ Split Name cannot guarantee to be 100% accurate. For example it is
impossible to know for sure if the 'Lee’ In 'John Lee Hooker" is a first name,
middle name or last name. In such situations it will make a guess.

e The splitting algorithm knows about:

o Common honorifics in a range of languages, such as: ‘Mr', 'Mrs', 'Miss',
'‘Ms', '‘Herr' and 'Frau’, and their abbreviations.

o Military, political, religious and other honorifics, such as: ‘Major General'
and 'Rabbi'.

o 'Particules’ at the start of last names, such as: 'de’ and 'von'.

o Common suffixes, such as: 'MBA', 'PhD' and 'Jr'.

e If values can contain multiple names (e.g. 'Mr John Smith & Mrs Jane
Smith') you will need to split the column using Split Col, before you use
Split Name.

e To combine the columns created back into a single column, with additional
text and in a different order, using Substitute.

See also
¢ Video: How to separate names in Excel

e Split Col
e Case

2.3.57 Split Rows

Description
Split each row into multiple rows.
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Reference

Examples
Split rows before each column containing 'title":

Guest title Guest first name Guest last Spouse title Spouse first name Spouse last name

1 IMr ‘John Smith Dr Jane Smith
2Mr Bill Brown Mrs Andrea Brown
Split Rows Od L] 5:

@ Split each row into multiple rows.
Split each row:
® before each column where name ¢ ¥ title

1time < before <None ¥ then every 1 columi

automatically using repeated column names

'

Guest title Guest first name ‘Guest last

Vv case sensitive

1/ Mr John Smith

3|Mr Bill Brown

4|Mrs Andrea Brown

Split rows using repeated column names:
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QL Q2 Q3 Q4 01 Q2 03 Q4 Q1 Q2

' |
1/ 232 123 34 5678 2345 23 234 89 341 93i

Split Rows Cf} E :
@ Split each row into multiple rows.
Split each row:

before each column where name =
2 times| 4 starting be Q2 then every 4 colun
® automatically using repeated column names

v case sensitive

Q1 Q2 Q3 04
1 232 123 34 5678

2| 2345 23| 234 89

3 341 83

Inputs
One.

Options
e Split by column name:
o Each row will be split before each column that matches the criteria.
e Split a fixed number of times:
o Define the number of times you want to split each row, starting before
which column and then every N columns.
o The split is added before the designated columns.
o Splits after the last column are ignored. So you can set times to a large
number if you don't know how many columns there will be.
¢ Split automatically:
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o Find the first column name that appears more than once and split each
row before each column with that name.
e Check case sensitive to use case sensitive matching for column names.

Notes

e Comparisons of column names are whitespace sensitive.

e Splits added before the first column are ignored, as there is already a split
there.

e Use New Col or Rename Cols if you need to add additional columns or
rename columns before splitting rows.

e The opposite of Split Rows is Concat Rows.

See also

e Reshape
e Gather

e Split Col
2.3.58 Spread

Description
Spread a column into multiple new columns. Also called wide pivot or
crosstab.

Example
Spread 'Quarter' and 'Amount’' columns to multiple columns:
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salesman area Quarter Value

1 Alice North Q1 1.3

2 Alice North Q2

3 Alice North Q3 44.3

4 Alice North Q2

5 Bob East Q1 4.5
6 Bob East - 79
7 Bob East Q3 8

8 Bob East - 3.3

'

Spread (f' E C

@ Spread the selected key and value columns into m...

Key column:  Quarter v
Value column: Value v
Missing value:

Min. new cols: 0

F

4)»

Max. new cols: 100

2 Bob East 45 79 8 33

Inputs
One.
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Options

e Select the Key column and Value column you wish to spread.

¢ Missing values is used for values missing from the input dataset.

¢ set Min. new cols to the minimum number of new columns you wish to
add, compared to the original dataset.

¢ set Max. new cols to the maximum number of new columns you wish to
add, compared to the original dataset. Ignored if less than minimum.

Notes

e Set Min. values to the same as Max. values to always create the same
number of columns.

e Use Sort on the key column before this transform if you need to control the
order of columns created.

e If there are rows that are duplicates, apart from the value column, this will
cause errors.

e New columns are added at the right end. You can change the column order
with Reorder Cols.

¢ You can merge the new columns into a single column with Concat Cols.

e The opposite of Spread is Gather.

id n v
Gather - il
id x y =z 2 1y b
1 lab c 3 1lz e
2 2d e f Ao
Spread |, 2ly le
6| 2|z |f
2.3.59 Stack
Description

Merge rows from inputs, one on top of the other.

Examples
Stack 3 employee datasets by header name:
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,
Stack ff} : Q

Name ID DOB .
@ Merge input datasets one on top of another. Or...

employeesl.c...
1/John Black = 001 1956'07'01*0 Align columns by: Header name >

3 wls x 2 rows
2 Paul White 002 1973-03-11 /
ID DOB

Name Name ID DOB
. employees2.c... Stack
1003 Jill Green |1977-12-30 qupuliy @ — Aqp 1 John Black 001 1966-07-01
N 3 cols x 2 rows 3 cols x 6 rows
2 004 Ahmed Ali 1980-11-05 2 Paul White 002 1973-03-11
DOB D Name 3Jill Green 003 1977-12-30
employees3.c... I
119681212 005 Lars Hansen el € [P 4/Ahmed Al 004 1980-11-05
. . 3oolsx2
219770105 006 Pierre Martin o Lo S Lars Hansen 005 1968-12-12
& Pierre Martin 006 1977-01-05

Stack 2 employee datasets by column number:

Stack o = E:‘
Name ID  DOB @ Merge input datasets one on top of another. Or...
1/John Black 001 1966-07-01 memplnyeesl.c,,, Align columns by: Column number v
2 Paul White 002 1973-03-11 ool rons e e e

1/John Black 001 1966-07-01
° Stack A*z Paul White 002 1973-03-11

3 cols x 4 rows

3 Jill Green = 003 1977-12-30

full name id  date of birth 4 Ahmed Ali 004 1980-11-05

1Jill Green 003 1977-12-30 *9 Bl EE e

3 cols x 2 rows

2 Ahmed Ali 004 1980-11-05

Stack 2 employee datasets with a separator row:

Stack Ou Ei
@ Merge input datasets one on top of another. Or...
Align columns by: Column number v
Name ID DOB v add separator rows
I 1.c.. i .
1/John Black 001 1966-07-01 *oemp PSR With value: ik
. 3 cols x 2 rows i
2 Paul White 002 1973-03-11 1| Name ID DOB
/11 John Black 001 1966-07-01
Stac ' 2 Paul White 002 1973-03-11
(/] S =
1| 3 ##### e
3 cols X 5 rows I L
i 4Jill Green 003 1977-12-30
full name id date of birth : 5/ Ahmed Ali 004 1980-11-05

1Jill Green 003 1977-12-30 *oem ployees2.c...

i 3 wls x 2 rows
2 Ahmed Ali 004 1980-11-05

Inputs

One or more.

Options
e Select Align columns by to Header name if you want line up column
values by header name (e.g. the 'id' column in input 1 with the 'id' column
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in input 2) and Column number to align by the column number (e.g. the
first column of input 1 with the first column of input 2). The headers will be
matched in order:
o case and whitespace sensitive (e.g. 'ID' to 'ID"); then
o case insensitive and whitespace sensitive (e.g. 'Id' to 'ID"); then
o case sensitive and whitespace insensitive (e.g. 'ID' to ' ID '); then
o case and whitespace insensitive (e.g. 'ld" to ' ID )

e Check use only top dataset columns to ignore columns not in the first
dataset.

e Check add separator rows to extra rows to separate the inputs. The value
entered for With value is used for each column of the separator rows.

Notes
e The stacking order depends on the vertical (Y-axis) position of the inputs.
e Stack merges datasets one on top of the other (vertically). To merge
datasets side-by-side (horizontally) use Join.
e If you align by Column number the header of the first input is used.
e Messages are shown in the Warnings tab for:
o duplicated column names within an input dataset when Align columns
by is set to Header name
o columns stacked under columns with different names when Align
columns by is set to Column number
o differing numbers of columns between input datasets
e It is sometimes useful to Stack a single dataset, so you can add more inputs
later.

See also

e Cross

e Join

e Merge datasets

e Schemas

¢ Video: How to clean, merge and scrub email lists

2.3.60 Stamp

Description
Adds a stamp with time, date and other information as a new row or a new
column.

Examples
Add the current date to the end of each row:
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Generation [kW] Grid [kW]  Solar [kW]
1 1.904804444 0.372133333 1.904804444

2 2.072017778 0.470303333 2.072017778

3 1.980881111 0.426542222 1.980881111

Stamp 2= Qﬂ Eﬂ
@ Add a stamp with processing date, time and other information.
Format: -- dd/MM/yyyy --

Position: Every row =
New column name: Stamp

Generation [kW] Grid [kW]  Solar [kW] Stamp
1 1.904804444 0.372133333 1.904804444 -- 07/06/2021 --

2 2.072017778 0.470303333 2.072017778 -- 07/06/2021 --

3 1.980881111 0.426542222 1.980881111 -- 07/06/2021 --

Add the current date and time to the top of a dataset with a comment:
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Stamp Dﬂ @

@ Add a stamp with processing date, time and othe
Format: d/M/yyyy HH:mm:ss -- Id/M/yyyy format!!

Position: At start

Data Warnings Info Comment Deta’
1 col x 2 rows @ 1 row ac
IR e F Yk <= =TI

|

1 14/2/2022 17:58:07 -- d/M/yyyy format!!

Inputs
One.

Options

e Supply the stamp format in Format (see below).

Format Meaning

d The day as number without a
leading zero (1 to 31)

dd The day as number with a leading
zero (01 to 31)

ddd The abbreviated localized day name
(e.g. 'Mon' to 'Sun’). Uses the locale
to localize the name.

dddd The long localized day name (e.g.
‘Monday' to 'Sunday'). Uses the
locale to localize the name.

M The month as number without a
leading zero (1 to 12).

MM The month as number with a leading
zero (01 to 12)

MMM The abbreviated localized month
name (e.g. 'Jan' to 'Dec’). Uses the
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Format Meaning
locale to localize the name.

MMMM The long localized month name (e.g.
‘January' to 'December’). Uses the
locale to localize the name.

vy The year as two digit number (00 to
99).
YYyvy The year as four digit number. If the

year is negative, a minus sign is
prepended in addition.

h The hour without a leading zero (0
to 23 or 1to 12 if AM/PM display).

hh The hour with a leading zero (00 to
23 or 01 to 12 if AM/PM display).

H The hour without a leading zero (0
to 23, even with AM/PM display).

HH The hour with a leading zero (00 to
23, even with AM/PM display).

m The minute without a leading zero (0
to 59).

e The minute with a leading zero (00
to 59).

S The whole second without a leading

zero (0 to 59).

ss The whole second with a leading
zero where applicable (00 to 59).

z The fractional part of the second, to
go after a decimal point, without
trailing zeroes (0 to 999). Thus "s.z"
reports the seconds to full available
(millisecond) precision without
trailing zeroes.

AP or A The fractional part of the second, to
millisecond precision, including
trailing.
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Format Meaning

ap or a Use am/pm display. a/ap will be
replaced by either "am" or "pm".

t The timezone (for example "CEST").

$(c) The computer name.

$(£f) The location (path) of the .transform
file,

e.g. /Users/andy/Desktop/myt
ransform.transform.

S (u) The name of the user (from the
USER or USERNAME environment
variable).

Anything after the first !
(Exclamation) character won't be
substituted.

e Select from Position whether you want the stamp row added to the start or
end of the dataset or to every row in a new column.

¢ Set New column name to the name of the new column you want to create
(only for Position = Every row).

Notes

e If you add the stamp to Every Row you can move the column using
Reorder Cols.
e The Format text is case sensitive.

See also
e Meta information
e Stack

2.3.61 Stats

Description
Calculates statistics by column and/or row in one or more selected columns.

Example
Calculate column and row averages:
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Grid [kW]  Solar [kwW]
1 0.372133333 1.904804444

2 0.470303333 2.072017778

3 0.426542222 1.980881111

y

K A
Stats o B 2]
@ Calculate sum, min, max, average, median or st...

v n E
|E| Q Filter columns

v Grid [kW]

v Sglar [kW]I | | B | |

2 of 2 columns selected

Calculation: Average v

On: Columns and rows v

v

Grid [kW] Solar [kKW] Average
1 0.372133333 1.904804444 1.1384688885

2 0.470303333 2.072017778 1.2711605555
3 0426542222 1980881111 1.2037116665

4 0.4229929627 1.985901111 1.2044470368

Inputs
One.

Options

e Check the column(s) you wish to calculate stats for.
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¢ Set Calculation to the statistic you want to calculate:

o Sum show the sum of the values.

o Minimum shows the smallest value.

o Maximum shows the largest value.

o Average shows the arithmetic mean of the values.

o Median shows the median of numeric values in the column.

o Mode shows the mode of numeric values in the column.

o Standard deviation is the sample standard deviation (equivalent to Excel
function stddev.s).

o Variance is the square of the sample standard deviation.

o Q1 is the first quartile (calculated using Method 1 here).

o Q3 is the third quartile (calculated using Method 1 here).

o IQR is the Inter Quartile Range.

o Skew is the alternative Pearson Mode Skewness (3 * (Mean — Median) /
Standard Deviation ).

o Percentile (inclusive) is an interpolated value at which the specified
Percentile of values are below or equal to this value. It is similar to the
Excel PERCENTILE. INC () function.

o Percentile (exclusive) is an interpolated value at which the specified
Percentile of values are below this value. It is similar to the Excel
PERCENTILE.EXC () function.

¢ Percentile is the percentile value to use in Percentile (inclusive) and

Percentile (exclusive) calculation.

e Set On depending on whether you wish to calculate the statistics for
columns, rows or both.

o If On is set to Columns an extra row with the results is added to the
bottom.

o If On is set to Rows an extra column with the results is added to the right.

o If On is set to Columns and rows an extra row with the results is added
to the bottom and extra column with the results is added to the right. The
bottom right cell contains the calculation across all values.

Notes

e Non-numerical and empty values are ignored.

e Mode may not work as expected with non-integer values, due to precision
issues. You can fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

e Use Scale to convert the results to percentages.

e If you want to compute the sum, minimum, maximum or average for each
distinct value in 1 or more columns you can use Unigue.

See also
e Correlate
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e Count

e Pivot

e Summary
2.3.62 Substitute

Description
Substitute column values into text.

Example
Create an SQL statement to insert 'date’, 'cases’, 'deaths' and 'country’ values
into 'mytable’:
date cases deaths country
12020-05-03 134 4 Afghanistan
2 2020-05-03 7 0 Albania
32020-05-03 141 6 Algeria
Substitute Qn = :i

@ Substitute column values into text.
New column name: SQL

Substitution script:

INSERT INTO mytable (country,date,deaths,cases) VALUES ($(country),$(date),$(deaths),$(cases));

date cases deaths country saL
12020-05-03 134 4 Afghanistan INSERT INTO mytable (country,date,deaths,cases) VALUES (Afghanistan,2020-05-03,4,134);

2 2020-05-03 7 0 Albania INSERT INTO mytable (country,date,deaths,cases) VALUES (Albania,2020-05-03,0,7);

3 2020-05-02 141 6 Algeria INSERT INTO mytable (country,date,deaths,cases) VALUES (Algeria,2020-05-03,6,141);

Inputs
One.

Options

¢ Set New column name to the name of the new column you want to create.

e Enter your substitution script into the Substitution script field.

e Select a column from Insert variable to add that column variable into the
Substitution script field at the current cursor position.

e Click the Evaluate button to evaluate your script over every row and show
any errors (only available if Run>Auto Run is checked).

Notes
e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.
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e If you want to carry out your transform across more than one dataset, you
should Join them first.

e If you need to do something more complex than this transform allows, try
the Javascript transform.

e Warnings are shown in the Warnings tab for ambiguous column references.

2.3.63 Subtract

Description
Remove rows from the top dataset with key values that are present in the
lower dataset.

Example
Subtract from the top dataset all the rows with IDs in the bottom dataset:

Subtract o5l f Bis
@ Remove rows from the top dataset whose key values are...
Explore Keys...
Top key column; Y id v
Bottom key column: ? ID =
Remove: All matches v
Id First vV case sensitive

1 001 Alice

subtract-a.csv
2 002 Bob * )
. 2 cols x 4 rows
3 003|Charlte

4 004 Dwayne

Id First

© Subtract Y . 1| 002leob

2 cols x 2 rows
2 004 Dwayne

subtract-b.csv

1 colx 2 rows

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Click Explore Keys... to compare key values in the 2 datasets.

¢ Select Top key column for the column you want to match in the top input
dataset.

e Select Bottom key column for the column you want to match in the
bottom input dataset.

¢ Set Remove according to which row matches you wish to remove:
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o All matches to remove every row from the top dataset where the key
exists in the bottom dataset.

o First match to remove 1 row in the top dataset for each matching key in
the bottom dataset, proceeding from first to last row in the top dataset.

o Last match to remove 1 row in the top dataset for each matching key in
the bottom dataset, proceeding from last to first row in the top dataset.

Key Value

|Remove: All matches = ||
1|a 1 ‘

Key Value

- Clipboard T Subtract

2 cols x 6 rows 2 cols x 2 rows

‘Remave‘ First match r h 1
Key Value

© Subtract g ;

2 cols x 3 rows 2

‘Remove‘ Last match ]
Key ’

1A Clipboard Subtract :
2R *o p __/—Po *

1 col x 3 rows 2 cols x 3 rows

3B

¢ Check case sensitive to use case sensitive matching for keys.

Notes

¢ The Info tab shows some examples of rows removed.

e This transform is sometimes called an anti-join.

o If there are 10k rows or less in both datasets, Easy Data Transform will try to
guess sensible default values for Top key column and Bottom key column
based on column header names and contents.

e If the first input has a header, this will be used for the output.

o All values are treated as text and comparisons are whitespace sensitive. You
can use Whitespace to remove whitespace before the subtract.

e All rows in the top dataset with a given key value are removed if that key
value occurs 1 or more times in the bottom dataset.

¢ You can use Concat Cols to join several columns together (e.g. ‘first name’
and 'last name' columns) to form a key column.

e You can use Row Num to create a unique key column.

¢ Use a second Subtract transform to see what was subtracted:
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Id First
0" btract-a.csv >0 Subtract o |1 001 21ice
2 cols x 4 rows 2 cols x 2 rows 2| 003 Charlie

° Subtract

2 cols x 2 rows

subtract-b.csv

1 col x2 rows

See also

o Intersect

e Use multiple keys for Join/Lookup/Intersect/Subtract
¢ Video: How to clean, merge and scrub email lists

2.3.64 Summary

Description
Summarize the values in the selected columns.

Example
Create a summary, including dates and statistics:
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Inputs
One.

Easy Data Transform

date cases deaths country

1/2020-05-03 134 4 Afghanistan
2/2020-05-03 7 0 Albania

3/2020-05-03 141 6 Algeria

+

Summary ' H ;C
@ Summarise the values of the selected columns.
E Q Filter columns
v date £
\, CESElS
v deaths
4 of 4 columns selected
v include dates
v include statistics
Metric date cases deaths country
1 Empty values 0 0 0 0
2 Non-empty values 3 3 3 3
3 Numeric values 0 3 3 0
4 Integer values 0 3 3 0
5 Date values 3 0 0 1]
6 Text values 0 0 0 3
: 7 Distinct values 1 3 3 3
8 Unique values 0 3 3 3
9 Duplicated values 1 0 0 0
10 Min length 10 1 1 7
11 Max length 10 3 1 1"
12 Min numeric N/A 7 0 N/A
13 Max numeric N/A 141 6 N/A
14 Range numeric ~ N/A 134 6 N/A
15 Sum numeric 0 282 10 0
116 Average numeric N/A 94 3.3333333333 N/A
17 Median numeric  N/A 134 4 N/A
18 Mode numeric N/A 7,134,141 0,46 N/A
19 Stddev numeric ~ N/A 754254598925 3.0550504633 N/A
20 Variance numeric  N/A 5689 9.3333333333 N/A
21 Q1 numeric N/A 7 0 N/A
22 Q3 numeric N/A 141 6 N/A
23 IQR numeric N/A 134 6 N/A
24 Skew numeric N/A -1.5909747209 -0.6546536707 N/A
25 Min date Sunday, May 3, 2020 N/A N/A N/A
26 Max date Sunday, May 3, 2020 N/A N/A N/A
27 Most frequent 2020-05-03 X 3 N/A N/A N/A

© 2025 Oryx Digital Ltd




Reference

Options

¢ Select the Columns you wish to summarize.

e Check include dates if you wish to check for date values using supported
date formats. This can be slow for large datasets.

e Check include statistics if you wish to add the sum, average, median and
standard deviation for numeric values.

Notes

e Whether values are interpreted as number or dates depends on Supported
date formats and locale.

e Empty values is the number of values in the column that are completely
empty. Values with whitespace do not count as empty.

¢ Non-empty values is the number of values in the column that are not
completely empty. Values with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can
be interpreted as a number.

¢ Integer values is the number of numeric of values in the column that can
be interpreted as integers (whole numbers). "1.0" (depending on your
locale), "0", "-1" and "1e3" are considered integers.

¢ Real values is the number of numeric values in the column that can be
interpreted as reals (floating point numbers). "1.2345" (depending on your
locale) and "1e-3" are considered reals.

¢ Boolean values is the number of values in the column that can be
interpreted as booleans (true/false). "TRUE", "True" and "false" are
considered booleans.

¢ Date values is the number of values in the column that can be interpreted
as a date. Only shown if check for dates is checked.

e Text values is the number of values in the column that cannot be
interpreted as empty, numeric or date.

e Distinct values is the number of different values in the column. All values
are treated as text (e.g. '7' is treated as different to '7.0' and '1/1/2020" is
treated as different to '01/01/2020'). Comparison between values is
sensitive to case and whitespace.

¢ Unique values is the number of values that only occur once in the column.
Date and numeric values are treated as text. Comparison between values is
sensitive to case and whitespace.

¢ Duplicated values is the number of values that occur more than once in
the column. Date and numeric values are treated as text. Comparison
between values is sensitive to case and whitespace.
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1A
2B

Distinct values 3 ¢ A, B, C
3B

=P Unique values | p— A

4C

Duplicated values 2 G B, C
5C
6C

¢ Min length is the minimum number of characters of non-empty values in
the column. Whitespace is counted. Date and numeric values are treated as
text.

¢ Max length is the maximum number of characters of values in the column.
Whitespace is counted. Date and numeric values are treated as text.

¢ Average length is the arithmetic mean of the number of characters of non-
empty values in the column. Whitespace is counted. Date and numeric
values are treated as text.

¢ Min numeric is the minimum numeric value in the column. Non-numeric
and empty values are ignored.

e Max numeric is the maximum numeric value in the column. Non-numeric
and empty values are ignored.

¢ Range numeric is Max numeric - Min numeric.

¢ Negative numeric is the number of negative numeric values in the column.
0 is not considered negative here.

e Zero numeric is the number of numeric zero values in the column.

¢ Positive numeric is the number of positive numeric values in the column. 0
is not considered positive here.

e Sum numeric is the sum of numeric values in the column. Non-numeric
and empty values are ignored. Only shown if include statistics is checked.

e Average numeric is the arithmetic mean of numeric values in the column.
Non-numeric and empty values are ignored. Only shown if include
statistics is checked.

¢ Median numeric is the median of numeric values in the column. Non-
numeric and empty values are ignored. Only shown if include statistics is
checked.

¢ Mode numeric is the mode of numeric values in the column. Non-numeric
and empty values are ignored. Only shown if include statistics is checked.

e Stddev numeric is the sample standard deviation (equivalent to Excel
function stddev.s) of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.
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¢ Variance numeric is the square of the sample standard deviation. Only
shown if include statistics is checked.

¢ Q1 numeric is the first quartile (calculated using Method 1 here). Only
shown if include statistics is checked.

¢ Q3 numeric is the third quartile (calculated using Method 1 here). Only
shown if include statistics is checked.

¢ IQR numeric is the Inter Quartile Range. Only shown if include statistics is
checked.

¢ Skew numeric is the alternative Pearson Mode Skewness (3 * (Mean —
Median) / Standard Deviation ). Only shown if include statistics is checked.

e Format date is the inferred format of dates in the column. Only shown if
include dates is checked.

¢ Min date is the minimum date value in the column. Only shown if include
dates is checked.

e Max date is the maximum date value in the column. Only shown if include
dates is checked.

¢ Range date is Max date - Min date + 1. Only shown if include dates is
checked.

¢ Distinct dates is the number of distinct date values. 01/01/2000 and
1/1/2000 is only 1 distinct date. Only shown if include dates is checked.

¢ Missing dates is the number of missing dates in sequence from Min date
to Max date. Only shown if there is no row sampling and include dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are
not counted. Date and numeric values are treated as text. Comparison
between values is sensitive to case and whitespace.

Notes

e If your dataset is large, you might want to Sample it first.

e Use Num Format to change the precision of numerical results.

e You can use Whitespace to remove any whitespace at the start or end of
values before Summary.

e If you wish to have a row displayed per column you can Transpose the table
first.

e Mode may not work as expected with non-integer values, due to precision
issues. You can fix this by using a Num Format transform first.

See also
e Correlate
e Count

e Ngram
ivot
tats
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2.3.65Total

Description
Add a new column with a running (cumulative) total of the selected column.

Examples
Total the 'transaction' column:
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area transaction
1 North 100
2 South 200
3 North -50
4 South 320
5 East 200
6 East -50
Total r,‘f E G
@ Add a new column with a running (cumulative) t...
Column: transaction v
By: <None selected> b

v

area transaction Total transaction
1 North 100 100
2 South 200 300
3 North -50 250
4 South 320 570
5 East 200 770
6 East -50 720

Total the 'transaction’ column separately for each 'area’ value:
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area transaction

1 North 100

souh 20

3 North -50

4

5

6

Total | o | == [wFe

@ Add a new column with a running (cumulative) t...
Column: transaction v
By: area v |

'

area transaction Total transaction

1 North 100 100

2

3 North -50 50

4
5
6

Inputs
One.
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Options

e Uncheck automatic new column name to set a name for the newly
created column in New column name.

¢ Set Column to the column you want to total.

e Set By to a column if you want a separate running total per value in that
column. Leave as <None selected> if you only want a single running total.

Notes

¢ Non-numerical values are ignored.

e The By column takes account of case and whitespace in values.

e The new column is added at the right end. You can change the column
order with Reorder Cols and the column name with Rename Cols.

See also
e Count

2.3.66 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and
each column becomes a row.

Example
Swap rows and columns:
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Grid [kW] Solar [kW]
1 0.372133333 1.904804444

2 0.470303333 2.072017778

3 0426542222 1.980881111

kA
Transpose o d ¢ N

@ Swap rows and columns.

v

1 2 3 4

has header

1 Grid [kW] 0.372133333 0.470303333 0.426542222

2 Solar [kW] 1.904804444 2.072017778 1.980881111

Inputs
One.

Options

e Check has header to make the new first row into a header.

Notes
o If the input dataset has a header, it will become the new first column. Use
Remove Cols to remove it.

2.3.67 Unfill

Description
Set adjacent cells with identical values to empty in selected columns.

Example
Unfill down all rows:
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Reference

Country Area  City
1Country 1 |Area1 City 1

2 Country 1 m{:ity 2

3 Country1 [Areal City3

4 Country 1 Area2 City 1

5Country1 Area2 City2

y

Unfill e al=: R
@ Set adjacent cells with identical values to empty in selecte...
E] El Q Filter columns

Country

v

Area

v
vy

3 of 3 celumns selected

Direction: Down v

For All rows hd

Y

Country  Area  City

1Country1 Areal City1

2 City 2
3 City 3
4 Area2 City1
5 City 2
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Unfill down all rows only where the value in the 'Country' column matches:
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Date Country Region Sale
12025-03-11 |UK 1 239234
2 2025-03-11 UK 1 28403
32025-03-11 |DE 1] 8237433
4 2025-03-11 ) 982347
52025-03-11 2 83433
Unfil % | B 23

@ Set adjacent cells with identical values to empty in selecte...
IEI Q Filter columns
v Date
v Country
v Rggl_on

Sale
4 of 4 columns selected
Direction:  Down v
For: Rows with same key value =
Key column: v Country -

Date Country Region Sale
12025-03-11 UK 1 239234
2 28403
32025-03-11 DE 1 8237433
4 2 982347
5 83433
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Inputs
One.

Options

e Check the column(s) you wish to unfill.

¢ Select Direction depending on the direction you wish to unfill to.

¢ Set For to Rows with same key value, if you wish to only unfill up/or down
when when 2 adjacent rows have the same value in the Key column
column.

Notes

e Matching for Rows with same key value is sensitive to case and
whitespace.

e You can delete rows left empty using Filter and columns left empty using
Remove Cols.

¢ To fill empty values with something else use the Replace transform.

See also
e Fill
e Slide

2.3.68 Unique

Description
Aggregate rows that have matching values in one or more selected columns.

Example

If you have a dataset of orders and you want to:

e keep one row per unique Customer Id

keep the first listed Name for each Customer Id

concatenate Product Ids for each Customer Id, delimited by a Comma
sum the Costs for each Customer Id

keep the latest Date for each Customer Id

add a Count column showing how many rows in the input correspond to
each row in the output
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Name Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown

89456 10.55 01/10/2020 |

3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown 98526 10.00 02/10/2020

5 Charles Jones CO17783 38746 25.00 03/10/2020|

‘ R

Unique % ¥y

@ Aggregate rows that have matching values in selected col...

Q Filter columns

Column Option
Mame Keep first v
Customer |d Keep unique b
Product Id Concat ~r
Cost Sum v
Date Maximum =
Set: All * | to Keep unique v Apply

‘Keep unique' for 1 of 5 columns
Concat delimiter: |,
ignore empty values for concat
V' add count column

case sensitive

allow drilldown

'

Mame Customer Id Productld Cost Date Count

1 Alice Anderson C018930 13574 29.95 01/10/2020 1

2 Bob Brown 018917 89456,98526 20.55 02/10/2020 2

3 Charlie Jones CO17783 96352,38746 44.95 03/10/2020 2
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Inputs
One.

Options

e Type text into the Filter field to temporarily hide columns whose names do
not contain this text.

¢ Set an Option for each column:

o Only 1 row is kept where all the Keep unique columns have the same
value. Empty is counted as a value.

o Keep first keeps the first value in the current sort order. Empty is
counted as a value.

o Keep first non-empty keeps the first value in the current sort order that
is not empty.

o Keep last keeps the last value in the current sort order. Empty is counted
as a value.

o Keep last non-empty keeps the last value in the current sort order that is
not empty.

o Sum sums any numerical values. Empty values are ignored.

o Maximum keeps the maximum numerical or date value. Empty values are
ignored.

o Minimum keeps the minimum numerical or date value. Empty values are
ignored.

o Average takes the average (mean) of any numerical values. Empty values
are ignored.

o Concat to concatenate values. Duplicate values are kept. All values are
treated as text. Empty is counted as a value.

o Concat distinct to concatenate values. Duplicate values are ignored. All
values are treated as case sensitive text. Empty is counted as a value.

o Count unique to count distinct values with no duplicate. E.g. 2, A, B, C
has 2 unique values: B, C. All values are treated as case sensitive text.
Empty is counted as a value.

o Count duplicate to count distinct values with duplicates. E.g. A, A, B, C
has 1 duplicate value: A. All values are treated as case sensitive text.
Empty is counted as a value.

o Count distinct to count distinct values. E.g. A, A, B, C has 3 distinct
values: A, B, C. All values are treated as case sensitive text. Empty is
counted as a value.

o Count empty to count empty values. Values containing whitespace are
not empty.

o Count non-empty to count non-empty values. Values containing
whitespace are not empty.

o Set empty sets the value to empty.

e Use the Apply button to quickly set the option value for multiple columns.
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¢ Set Concat delimiter to add a delimiter between Concat and Concat
distinct values.

e Check ignore empty values for concat to ignore empty values in Concat
and Concat distinct columns.

¢ Check add count column to add a column showing how many rows in the
input dataset created each unique row.

e Check case sensitive for case sensitive Keep unique matching.

e Check allow drilldown to allow double clicking a row in the data table to
drilldown to the rows in the upstream data that contributed to this row.

Notes

e Column filtering is sensitive to whitespace, but not case. Columns hidden by
filtering are unselected.

e Rows are considered duplicates if they have exactly the same value in all the
columns set to Keep unique. Comparisons are case and whitespace
sensitive. You can use Case and Whitespace to change case and whitespace
before deduping.

e If no columns are set to Keep unique the transform won't do anything.

e If you are using Keep first, Keep last, Keep first non-empty or Keep last
non-empty the sort order is important. You can use Sort to change the sort
order before this transform.

e Cells containing whitespace are not considered empty.

e The Dedupe transform is a less powerful (but simpler and faster) alternative
to Unique.

¢ You can reverse Unique concatenation using Split Col with Into as Rows

See also
e Dedupe a dataset

2.3.69 Units

Description
Change units of time, length, temperature etc.

Example
Convert the 'Temperature’ column from Celsius to Fahrenheit:
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Temperature
1 -20
2 0
3 20
4 40
5 60
6 80
7 100

Units { ro dlll==: IVE¢

@ Change units of time, length, temperature etc.
IE' Q Filter columns

Temperature
v p

1 of 1 columns selected

Dimension: Temperature v
From: Celsius/Centigrade v
To: Fahrenheit * v
Temperature

1 -4

2 32

3 68

4 104

5 140

6 176

7 212

Inputs
One.

Options

e Check the column(s) you wish to transform.
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¢ Set Dimension to the dimensions of the units you wish to convert.
¢ Set From to the units you wish to convert from.
e Set To to the units you wish to convert to.

Notes

e The |ocale is used to decide how the number is represented (e.g. decimal

separators).

Unit disambiguation:

o Years are 365.25 days.

o Calories are thermal/small/gram (not nutritional) Calories.

o Miles are International/Statute Miles.

o Nautical miles are International Nautical Miles.

o Gallons (US) are liquid gallons.

o Pints (US) are liquid pints.

e Warnings are shown in the Warnings tab for non-numeric values.

Non-numerical and empty values are not changed.

Use Copy Cols to copy columns before you transform them.

Use Num Format to change the number format of the results.

Use Extract or Split Col to remove any unit symbols from the value before

conversion, e.g. to change "0.0 Kg" to "0.0".

e If you want to convert units not covered here you can do it using the
Javascript transform.

2.3.70UUID

Description
Adds a new column, filled with Universally Unique Identifiers.

Example
Add a column of UUIDs:
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Reference

CustomerID OrderDate

1 |VINET 1996-07-04 00:00:00.000
2 TOMSP 1996-07-05 00:00:00.000
3 |HANAR 1996-07-08 00:00:00.000

uuID i |teal=](vEe

® Add a new column, filled with Universally Unique Identifiers.

New column name: UUID

Format: Standard v
CustomerID OrderDate UUID
1 |VINET 1996-07-04 00:00:00.000 {0114276d-17bf-47e5-95a3-eb6ldac77e3b}
2 |TOMSP 1996-07-05 00:00:00.000 {6£7ea092-£f0c3-4b7b-b720-8b0afd2fcdca}
3 | HANAR 1996-07-08 00:00:00.000 {df3b0dbl-51a7-4535-a816-90b87026ckh4b}

Inputs
One.

Options
¢ Set New column name to the name of the new column you want to create.
¢ Set Format according to how you want the UUIDs to look:

o Standard: { xxxxxXXXX-XXXX-XXXX—XXXX—XXXXXXXXXXXX }

o] Without braces: XX XXXXKXKX XXX KX XXX XXX XXX KXXXKXKXXXXX

o Without braces or dashes: xXXXXXXXXXXXXXXXXXXXXXXXKKKXXXKK

Notes

¢ A Universally Unique Identifier (UUID) is used to uniquely identify objects in
computer systems. It is also known as a Globally Unique Identifier (GUID).

¢ On Mac, DCE v4 (random) UUIDs are used.

e Each time the transform is run it will create a different set of UUIDs.

e Theoretically, it is possible to generate the same UUID twice. But you are
more likely to hit by a meteorite on your way to collect your lottery
winnings.

See also
¢ Video: How to generate UUIDs

e Pseudonym
e Row Num

e Random
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2.3.71 Verify

Description
Verify that values in the dataset are as expected.

Examples
Show an error and stop processing if the dataset doesn't have 9 columns:

Verify ‘s OQ ES
@ Verify that values in the dataset are as expected.
El D 2 rules checked
Verify Value Severity |
¥ Dataset [2 rules active]
No duplicate col names Warning
v Minimum number of cols: 9 < Error v
v Maximum number of cols: g < Error v
Minimum number of rows: 1 , Warning ¥ ' :
Vv case sensitive
Filter: Keep all rows v
Data Characters _ Warnings @ Info Comment Details
10 cols x 45,716 rows €31 fail (1 erron)
[0 B ¢ © = Y Iee%%|$/l\\l/ii
name id nametype recclass * |

Remove any rows where there is an empty (0 length) value in the 'name’
column:
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Verify S e dll===IvEe
@ Verify that values in the dataset are as expected.
E] D 1 rule checked
Verify Value Severity -
¥ Columns [10]
¥ Column 1: name ( Aachen, , Abee, ... ) [1 rule active] :
Column type: Text v |
Match column name: Warning
No duplicate values Warning
v No empty values Warning ¥
No blank values Warning -
Vv case sensitive
Filter: Remove rows with: v
no fails :
Information fails
v Warning fails
Error fails
Data Characters ,T Warnings @ Info Comment Details |
10 cols x 45,715 rows £ 1 fail (1 warning), 1 rows removed
ENEPZE ==Y K= =2 2A Tk
name id nametype recclass 4

Show a warning message and color any duplicate values in the 'id' column:
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Verify = Qﬂ EQ
@ Verify that values in the dataset are as expected.
E D 1 rule checked
Verify Value Severity =
» Dataset [0 rules active] i
¥ Columns [10] I
» Column 1: name ( Aachen, Aarhus, Abee, ... ) [0 rules active]
¥ Column 2:id (1, 2, 6, ... ) [1 rule active]
Column type: Text v
Match column name: Warning
v No duplicate values Warning ¥
No empty values Warning
At least 1 non-empty Warning
No blank values Warning
LN T i — 4 W T b’
v case sensitive
Filter: Keep all rows v
Data  Characters ()Warnings (i)Info  Comment  Details
10 cols x 45,716 rows (1)) 88 fails (88 warning)
(s & ¢« @ HHE Y T ) o B O R
name id Inametype recclass -
4 Acapulco 10 valid Acapulcoite
5 Achiras 379 valid L6
6 Adhi Kot 379 Valid EH4

Check for invalid telephone numbers or email addresses and keep only rows
with validation fails:
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Verify %o B2
@ Verify that values in the dataset are as expected.
E] D 2 rules checked
Verify Value Severity =
» Dataset [0 rules active]
¥ Columns [4]
» Column 1: First ( Bob, Alfred, Alice, ...) [0 rules active]
¥ Column 2: Last ( White, Grey, Brown, ... ) [0 rules active]
¥ Column 3: Telephone (,, N/A, ...) [1 rule active]
Column type: Text v
b W name: / _/_ Mg o J
il Warr. . _
Contains: Warning
v Is valid telephone num. Warning ~
! >

on-printable Warning
¥ Column 4: Email ( bob@bobmail.com, , alice@hotmail.com, ... ) [1 rule ac...

Column type: Text v

Matche™™ ome: e e v

—as with: Warning
Contains: Warning
V' Is valid email Warning ¥

v case sensitive
Filter: Remove rows with: v
Vv no fails
Information fails
Warning fails

Error fails

Data Characters '3.'_1_: Warnings (D Info Comment Details

4 cols x 4 rows ":;T':' 5 fails (5 warning), 54 row(s) removed

LR eMlHEY AEEEEERTM
First Last Telephone Email

1/Bob White bob@bobmail.com
2|Alfred Grey
3Alice Brown N/A alice@hotmail.com

4|Luther Green (123)-123-1234 luther@gmail.

Inputs
One.

Options

e Choose the rules you wish to verify, for the dataset and for each column.
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o Check each verification rule you wish to apply.

o Set Value for rules that require a value.

o Set Severity according to the severity of a rule fail.

o Hover over the rules to see tooltips with more information on each rule.
e Type text into the columns Filter field to temporarily hide columns whose

old or new names do not contain this text.

The rules available for each column depends on the Column type selected.

Columns [10]

Column 1: name ( Aachen, Aarhus, £ ;‘imim e]
| Column 2:id (1,2, 6, ...) [ruleacti "
[ Calumn type: meric (integer) ]
| Date k
! Match column name:
Descriptio Notes Available Case Applies
n (in for sensitive
alphabetic option
order) applies
Allempty  Verify that every Column No Per value in
values value in the column type=Text column
is empty. A value Column
containing type=Num
whitespace is not eric (real)
considered empty.  Column
type=Num
eric
(integer)
Column
type=Date
Atleast 1 Verify that at least 1 Column No Per column
non- value in the column type=Text
empty is not empty. A Column
value containing type=Num

whitespace is not eric (real)

considered empty.  Column
type=Num
eric
(integer)
Column
type=Date
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Descriptio
n (in
alphabetic
order)

Contains

Don't
allow
listed
values

Ends with

Integer
except
listed

Notes

Verify that every
value in the column
contains the text
supplied. Matching
is sensitive to
whitespace.

Verify that no
values in the
column belong to
this list. Separate
multiple values by
Commas. Matching
is sensitive to
whitespace.

Verify that every
value in the column
ends with the text
supplied. Matching
is sensitive to
whitespace.

Verify that every
value in the column
is an integer
(whole) number or
belongs to the list
of special values
supplied. Separate
multiple values by
Commas. List
matching is

Available
for

Case

option
applies

Column Yes
type=Text
Column
type=Num

eric (real)
Column
type=Num

eric

(integer)

Column Yes

type=Text

Column Yes
type=Text
Column
type=Num

eric (real)
Column
type=Num

eric

(integer)

Yes (for
listed

special
values)

Column
type=Num
eric
(integer)

sensitive

Applies

Per value in
column

Per value in
column

Per value in
column

Per value in
column
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Descriptio
n (in
alphabetic
order)

Is local file

Is local
folder

Is lower
case

Is
sentence
case

Is title case

Is upper
case

Is valid
ASIN

Notes

sensitive to
whitespace.

Verify that every
value in the column
is the location
(path) of an existing
file on this
computer.

Verify that every
value in the column
is the location
(path) of an existing
folder on this
computer.

Verify that any
letters are lower
case.

Verify that any
values are sentence

case. E.g.:
Sentence case.

Verify that any
values are title case.
E.g.Title Case.

Verify that any
letters are upper
case.

Verify that every
value in the column
is a valid Amazon
Standard
Identification
Number (10
characters A-Z ,0-
9). Expects upper

Available
for

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Case
sensitive
option
applies

No

No

No

No

No

No

Yes

Applies

Per value in
column

Per value in
column

Per value in
column

Per value in
column

Per value in
column

Per value in
column

Per value in
column
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Descriptio Notes Available Case Applies
n (in for sensitive
alphabetic option

order) applies

case letters if case
sensitive checked.
Does not check
ISBN checksums.
Does not check if
the product actually
exists. Whitespace

is ignored.
Is valid Verify that every Column No Per value in
EAN13 value in the column type=Text column

is a valid EAN13 Column

barcode number type=Num

(13 digits, including eric

a valid checksum (integer)

digit). Does not
check if the product
actually exists.
Whitespace is
ignored.

Is valid Verify that every Column No Per value in
email value in the column type=Text column

is a valid email

address. E.g.:

e cmail@email.
com

e EMATILQEMAIL.
COM

Does not check if
the email actually

exists.
Is valid Verify that every Column No Per value in
GTIN value in the column type=Text column

is a valid GTIN Column

barcode number (8, type=Num
12,13 or 14 digits, eric
including a valid (integer)
checksum digit).

Does not check if
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Descriptio Notes Available Case Applies
n (in for sensitive
alphabetic option

order) applies

the product actually
exists. Whitespace
is ignored.

Is valid Verify that every Column Yes Per value in
IBAN value in the column type=Text column
is a valid IBAN code.
E.g.
e GB82WEST1234
5698765432

e TE64 IRCE
9205 0112
3456 78

Some small
countries (such as
pacific islands) may
not be included.
Expects upper case
letters if case
sensitive checked.
Does not verify the
BBAN checksum.
Does not check if
the bank account
actually exists.
Whitespace is

ignored.
Is valid Verify that every Column No Per value in
ISBN value in the column type=Text column

is a valid ISBN-10 or Column
ISBN-13 number type=Num
(10 or 13 eric
characters, (integer)
including a valid

checksum digit).

E.g.:

e 152935112X

e 978-1-60309-
502-0
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Descriptio Notes Available Case Applies
n (in for sensitive
alphabetic option
order) applies
e 979-8-886-
45174-0

ISBN-13 numbers
should start with
978 or 979.

Does not check if
the ISBN number
actually exists.
Whitespace and
dashes are ignored.

Is valid Verify that every Column No Per value in
telephone value in the column type=Text column
num. is a valid telephone  Column
number. E.g.: type=Num
e (123)-123- eric
1234 (integer)
e 1-123-123-
1234
e 123.123.1234
e +12 (123)
123-1234

e 11231231234

e +1 123 123-
1234

Does not check if
the phone number
actually exists.

Is valid Verify that every Column No Per value in
UPC-A value in the column type=Text column

is a valid UPC-A Column

barcode number type=Num

(12 digits, including eric

a valid checksum (integer)

digit). Does not
check if the product
actually exists.
Whitespace is
ignored.
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Descriptio
n (in
alphabetic
order)

Match
column
name

Matches
regex

Maximum
characters

Maximum
number of

Notes

Verify that column
has the supplied
name. Matching is
sensitive to
whitespace.

Verify that every

value in the column
matches the regular

expression
supplied. E.g.
$x.*$ to match
values that start

with x. Matching is

sensitive to
whitespace.

Verify the maximum

number of
characters in each
value in the
column.
Whitespace
characters are
counted.

Verify the maximum
number of columns

Available
for

Case
sensitive
option
applies

Applies

Column Yes Per column
type=Text
Column
type=Selec
tion
Column
type=Num
eric (real)
Column
type=Num
eric
(integer)
Column
type=Date

Per value in
column

Column Yes

type=Text

No Per value in

column

Column
type=Text
Column
type=Num
eric (real)
Column
type=Num
eric
(integer)
Column
type=Date

Dataset No Per dataset
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Descriptio Notes Available Case Applies

n (in for sensitive

alphabetic option

order) applies

cols in the dataset.

Maximum  Verify the minimum Dataset No Per dataset
number of number of rows in

rows the dataset.

Maximum  Verify the maximum Column No Per value in
value value in the type=Num column

column. Numbers eric (real)
equal to this value

are ok. Non-

numeric values are

ignored.

Verify the maximum Column No Per value in
value in the type=Num column

column. Numbers eric
equal to this value  (integer)

are ok. Non-

numeric values are

ignored.

Verify the last Column No Per value in
allowed date in the type=Date column

column. Dates
equal to this value
are ok. Non-date
values are ignored.

Minimum  Verify the minimum Column No Per value in
characters number of type=Text column
characters in each ~ Column
value in the type=Num
column. eric (real)
Whitespace Column
characters are type=Num
counted. eric
(integer)
Column
type=Date
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Descriptio
n (in
alphabetic
order)

Minimum
number of
cols

Minimum
number of
rows

Minimum
value

No blank
values

No
Carriage
Returns

No
currency

Notes

Verify the minimum
number of columns
in the dataset.

Verify the minimum
number of rows in
the dataset.

Verify the minimum
value in the
column. Numbers
equal to this value
are ok. Non-
numeric values are
ignored.

Verify the minimum
value in the
column. Numbers
equal to this value
are ok. Non-
numeric values are
ignored.

Verify the first
allowed date in the
column. Dates
equal to this value
are ok. Non-date
values are ignored.

Verify that no value
is all whitespace
characters.

Verify that values
do not contain
Carriage Return
characters.

Verify that values
do not contain

Available
for

Dataset

Dataset

Column
type=Num
eric (real)

Column
type=Num
eric
(integer)

Column
type=Date

Column
type=Text

Column
type=Text

Column
type=Text

Case
sensitive
option
applies

No

No

No

No

No

No

No

No

Applies

Per dataset

Per dataset

Per value in
column

Per value in
column

Per value in
column

Per value in
column

Per value in
column

Per value in
column
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Descriptio
n (in
alphabetic
order)

No digits

No double
spaces

No
duplicate
col names

No
duplicate
values

Notes

currency characters.
E.g. $, £ ore.

Verify that values
do not contain digit
characters E.g. 0 or
9.

Verify that values
do not contain
consecutive Space
characters.

Verify that no 2
column names in
the dataset are the
same. Matching is
sensitive to
whitespace.

Verify that no value
in the column
appears more than
once. Matches as
text. Matching is
sensitive to
whitespace.

Verify that no value
in the column
appears more than
once. Matches as
integers. E.g. 1, +1,
and 01 are
duplicates.

Verify that no value
in the column
appears more than
once. Matches as
dates. E.g.
01/01/2000 and

Available Case

for sensitive
option
applies

Column No

type=Text

Column No

type=Text

Dataset Yes

Column Yes

type=Text

Column No

type=Num

eric

(integer)

Column No

type=Date

Applies

Per value in
column

Per value in
column

Per column

Per value in
column

Per value in
column

Per value in
column
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Descriptio Notes Available Case Applies
n (in for sensitive
alphabetic option

order) applies

1/1/2000 are

duplicates.
No empty Verify that no rows dataset No Per row
rows in the dataset have

an empty value for
every column. A
value containing
whitespace is not
considered empty.

No empty Verify that no Column No Per value in
values values in the type=Text column
column are empty.  Column
A value containing  type=Num
whitespace is not eric (real)
considered empty.  Column

type=Num
eric
(integer)
Column
type=Date
No gaps in Verify every Column No Per column
values possible value type=Num
between the eric
minimum and (integer)
maximum values in
the column occurs
at least once. E.g.
4,1, 2,4 has agap
at 3.
Verify every Column No Per column
possible date type=Date

between the
minimum and
maximum values in
the column occurs
at least once. E.g.
for dd/MM/yyyy
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Descriptio
n (in
alphabetic
order)

No
leading/tra
iling
whitespac
e

No Line
Feeds

No non-
ASCI|

No non-
printable

No
punctuatio
n

No
symbols

No Tab
characters

Notes

format
01/01/2000,
02/01/2000 and
04/01/2000 has a
gap at
03/01/2000.

Verify that values
do not contain
leading or trailing
whitespace
characters.

Verify that values
do not contain Line
Feed characters.

Verify that values
do not contain non-
ASCII characters.

Verify that values
do not contain non-
printable
characters, such as
Null.

Verify that values
do not contain
punctuation
characters. E.g. !, ;
or ..

Verify that values
do not contain
symbol characters.
Eg. S, +, =or>.

Verify that values
do not contain Tab
characters.

Available
for

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Column
type=Text

Case Applies

sensitive

option

applies

No Per value in
column

No Per value in
column

No Per value in
column

No Per value in
column

No Per value in
column

No Per value in
column

No Per value in
column
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Descriptio
n (in
alphabetic
order)

No
whitespac
e

Numeric
except
listed

Only allow
listed
values

Require
listed
values

Notes

Verify that values
do not contain
whitespace
characters. E.g.
Space, Tab,
Carriage Return or
Line Feed.

Verify that every
value in the column
is a real number or
belongs to the list
of special values
supplied. Separate
multiple values by
Commas. List
matching is
sensitive to
whitespace.

Verify that all values
in the column
belong to this list.
Separate multiple
values by Commas.
Matching is
sensitive to
whitespace.

Verify that every
listed value appears
at least once in the
column, matching
as text. Separate
multiple values by
Commas. Matching

Available
for

Column
type=Text
Column
type=Num
eric (real)
Column
type=Num
eric
(integer)
Column
type=Date

Column
type=Num
eric (real)

Column

type=Selec

tion

Column
type=Text
Column
type=Num
eric
(integer)

Case Applies

sensitive

option

applies

No Per value in
column

Yes (for Per value in

special column

listed

values)

Yes Per value in
column

Yes Per column
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Descriptio Notes Available Case Applies
n (in for sensitive
alphabetic option

order) applies

is sensitive to

whitespace.
Starts with  Verify that every Column Yes Per value in
value in the column type=Text column

starts with the text  Column
supplied. Matching type=Num

is sensitive to eric (real)
whitespace. Column
type=Num
eric
(integer)
Valid date  Verify that every Column No Per value in
in format  value in the column type=Date column

is a valid date in the

supplied date

format. The rule will
fail if either:

e The date is in the
wrong format.
E.g.31/01/2000
does not match
format
yyyy/MM/dd.

e The date is in the
right format, but
does not exist.
E.g.2000/02/30
is a non existent
date in format
yyyy/MM/dd.

e Check case sensitive to use case sensitive matching. Case sensitivity is only
relevant to some rules (see the table above).

e Set Filter according to which rows you wish to keep. E.g. you might want to
remove rows with warnings.

Notes
e Column filtering is sensitive to whitespace, but not case.
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¢ Any verification fails are color-coded in the Right pane data table. Hover
over a header or value for information on the rule(s) failed. Click on the
color buttons to change the colors used.

Data Characters ! Warnings @Infc- Comment Details
4 cols x 4 rows 5 fails (5 warning), 54 row(s) removed
BB 2 olHEY << =21 T 1L L
First Last Teleplikone Email i
Bob White =

Column rule fail: Is valid telephone num. (3)

Alfred Grey
Alice Brown N/A alice@hotmail.com

Luther Green (123)-123-1234 luther@gmail.

Error:-Warning: = | Info:

Lo [ w v | #

e A summary of all the verification rules and whether they passed or failed is
output to the Info tab.

e A summary of failed verification rules with Severity set to Warning or Error
is output to the Warning tab.

e Checking a rule may hide other, mutually exclusive, rules. E.g. checking No
empty values for a column will hide the Minimum characters rule.

o All date verification rules use the date format in Valid date in format rule,
if set. Otherwise Easy Data Transform will attempt to infer the date format
from Preferences>Dates and the values in each column.

e The |ocale is used to decide the validity of numbers and dates. E.g. '1,234.5'
is a valid real number in some locales.

e Some rules have associated lists of values. The list is Comma separated,
consequently, values cannot contain Commas.

e If you want to verify the relationship between 2 columns (e.g. the value is
column A is always greater than the value in column B for the same row)
use a transform, such as Compare Cols or If and then use Verify on the new
column.

See also

¢ Video: How to verify data

e Video: How to check ISBN numbers

e Video: How to check IBAN account numbers

¢ Video: How to clean, merge and scrub email lists
e Schemas

e Filter
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2.3.72 Whitespace

Description
Tidy whitespace (Spaces, Tabs, Carriage Returns etc) in the selected

column(s).

Example
Tidy Tabs, Carriage Returns and repeated Spaces:
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ClB@)<« -

MName

1 ‘Mr--John<Smith
2 Dr-Jane—Smith

3 Mr-Albert<-Smith--

y

Whitespace d} L E:
® Tidy whitespace (spaces, tabs, carriage returns e...

E| Q Filter columns

Mame

v

4 b

1 of 1 columns selected

Vv trim leading and trailing whitespace
replace line feeds with spaces
replace tabs with spaces
replace non-standard spaces with spaces
remove carriage returns

convert consecutive spaces to one space

<SS << <<

remove non-printable characters

\

BB /)

MName

1 Mr-John-Smith
2 Dr-Jane-Smith

3 Mr-Albert-Smith
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Inputs
One.

Options

e Check the column(s) you wish to transform.

e Check trim leading and trailing whitespace to remove whitespace
characters, such as Space and Tab.

e Check replace Line Feeds with Spaces to replace LF (\n) characters with
Spaces.

e Check replace Tabs with Spaces to replace Tab (\t) characters with Spaces.

e Check replace non-standard spaces with Spaces to replace non-standard
Spaces (such as non-breaking Space, thin Space etc) with Spaces.

e Check remove Carriage Returns to remove CR (\r) characters.

¢ Check convert consecutive Spaces to one Space to replace 2 or more
consecutive Spaces with a single Space.

e Check remove non-printable characters to remove characters of Unicode
type Other_*. This include ASCII codes 0 to 31, such as Tab, Line Feed,
Carriage Return, Bell and Backspace. It does not remove Spaces.

Notes

e The operations are carried out in top to bottom order, e.g. Replace Line
Feeds with Spaces is carried out before Convert consecutive Spaces to
one Space.

e Click the eye icon in the Right pane to show whitespace in the data.

m Characters Warnings @ Info (
1 col x 4 rows
1 3 mm
P& Z Ole &Y
v Sa— .
Show invisible characters in the dataset as symbols:
1 ~1 | Muli: @
Space:
2 —l | Tab: -
Carriage return: “
3 .-3--  Line feed: -
MNon-breaking space: _
4 @4 Other whitespace: O
Other non-printable: 3
See also

e Case
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2.4 Output
I

2.4.1 Output data

Once you have finished transforming your data you can output it in the
following formats:
o LSV

e Excel

* JSON

e HTML

e Markdown

e Plain text

o TSV

e vCard

o XML

e YAML

To create an output, select 1 input and/or transform item in the Center pane
and then click the To File button at the bottom of the Left pane. You can
choose the file type in the file type drop-down list of the Output window.

You can select the output item in the Center pane and change any options
related to the output in the Right pane.

RA
]

output.csv & H

(7 Output to file.
Output to:  Single file

File: /Usersfandyb/Desktopfoutput.csy

Type: Delimited text
Delimiter:  Comma (,)

Quoting: As needed

Line endings: Automatic

Encoding: UTF-8
Byte Order Mark

®

Write mode: OQOverwrite

write header
Alias: output?
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Set Output to depending on whether you want to output the dataset to a
single file or multiple files.

Set File to the location of the file you want to output (only available when
Output to set to Single file). The location can use file name variables to
dynamically change output file names based on input file names.

Set Files column to the column containing the location of the files you want
to output to (only available when Output to set to Multiple files).

e This column is not output.

e The location can be an absolute location

(e.g. /Users/andy/output.csv) or a location relative to the .transform
file location (e.g. results/output.csv).

The location can use file name variables to dynamically change output file
names based on input file names.

Folders output to, must already exist.

Empty or invalid locations (e.g. file names with illegal characters) are
ignored.

Check Confirm files if you want to manually confirm before writing to
output files (ignored for command line processing).

If you are writing to an Excel file the output will be written to a sheet called
‘Easy Data Transform' by default. You can change this by adding the sheet
name inside [], e.g. myfile.xlsx [mysheet].

Set Type to the file type. The type will be set by default according to the file
extension and the settings in the Output Extensions tab of the Preferences
window.

Set Value types depending on how you want to set JSON types (only
available for JSON files).
e Automatic to let Easy Data Transform decide the JSON type depending on
the contents of each column.
e String to set the JSON type for all columns to String
e Manual to choose the JSON type of each column as:
o Automatic (based on column contents).
o Boolean.
o Number.
o String.
If you output a column as Boolean or Number, any values not of that type will
be output as null.

Set Delimiter to the delimiter you wish to use (only available for delimited
text files, such as CSV and TSV).
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Set Quoting depending how you want to use quoting in the output (only

available for delimited text files, such as CSV and TSV).

¢ As needed to add quotes (") around values that contain the delimiter
character, quote characters or Carriage Returns.

¢ Always to add " quotes around every value.

e Never to never add " quotes around values (delimiters and Carriage Returns
with values are replaced with Spaces).

Set Line endings to the control characters you wish to use to denote line

endings (only available for text files).

¢ Automatic to choose the standard line ending for the current operating
system.

¢ Windows (CRLF) to choose the standard Windows line ending, Carriage
Return+Line Feed (\r\n).

e Mac\Unix (LF) to choose the standard macOS/Unix line ending, Line Feed
(\n).

¢ Old Mac (CR) to choose the standard classic (pre mac OS X) Mac line
ending, Carriage Return (\n).

¢ Record separator (0x1E) to choose the ASCII record separator character.

Set Encoding to the text encoding you wish to use (only available for text
files).

Set Formatting depending on how you want to set the Excel cell formatting
(only available for Excel files).
¢ Automatic to let Easy Data Transform decide cell formatting depending on
the contents of each column.
¢ General to set the cell format for all columns to ‘General'.
¢ Manual to choose the cell format of each column as:
o Automatic (based on column contents).
o Boolean (expects true or false, not case sensitive)
o Date (expects a date format in Preferences).
o General.
o Number (expects a real or integer number, e.g. 123 or 123.456)
o Text.
o Formula (expects starting with =).
o Time (expects hh:mm:ss orhh:mm, e.g. 13:59:01 or 13:59).
o Hyperlink (expects a hyperlink, e.g.
https://www.easydatatransform.com).

Set Byte Order Mark checked to write a Unicode Byte Order Mark to the file

(only available for UTF encodings and ignored when appending to an existing
file).
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Set Escape special characters checked to escape HTML special characters (for
example < and >) so they are rendered correctly in the HTML (only available
for HTML files). Uncheck it to write 'raw' HTML. Note that you can also set
Change to To escaped HTML to escape selected columns in the Decode
transform.

Check remove empty to recursively remove any nodes that have an empty
value and no children (only available for JSON and XML files). For example:

A AB ABC
1
2 1
3 1

Is output to XML with remove empty checked as:

<root>
<record>
<A>
<B>1</B>
</A>
</record>
<record>
<A>
<B>
<C>1</C>
</B>
</A>
</record>
</root>

Is output to XML with remove empty unchecked as:

<root>
<record>
<A>
<B>
<C></C>
</B>
</A>
</record>
<record>
<A>
<B value="1">
<C></C>
</B>
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</B>
</record>
<record>

<A>

<B>

<C>1</C>

</B>
</DA>
</record>

</root>

For XML output you can set Root name, Below root and Row name
depending on the name you want to use for the root and row records and
any extra information you want to add below the root.

<?xml version="1.0" encoding="UTF-8"2>
<l-— File created 2023 09 27

. <Above=Abovel</Above> = 17 23 38 226 >
Above root <Above>Abovel</Above> \h <Above>Abovelk/Above>
Root name:  root ""'-1” zi:ziiﬁ\bovel /Bbove>
Below root: <Below>Below1</Below> A .<Below>Bel 1</Below>
<Below>Below2</Below> v <Below>Belgw2</Below>

Row name:  record : » <ri$§if?v>
Write mode:  Overwrite v \</record>

<re
File comment: File created {date} {time} —— Sve2< /v

</record>

</root>

Use Write mode to determine how existing files are treated:

Write mode for
Excel files

Overwrite / File

Overwrite /

File exists with
named sheet

Overwrite named
sheet, delete all
other sheets

Overwrite named

Sheet sheet*
Append Append to
named sheet
New Do nothing
Disabled Do nothing

Easy Data Transform

File exists
without named
sheet

Add named
sheet, delete all
other sheets

Add named

sheet

Add named
sheet

Do nothing

Do nothing

File does not
exist

Create file with
only named
sheet

Create file with
only named
sheet

Create file with
only named
sheet

Create file with
only named
sheet

Do nothing
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*Overwriting a named sheet is slower than creating a new file and can cause
the file size to increase each time (due to indexing by Excel). If this becomes a
problem, you can delete the file and re-output it. Because of this you should
use Overwrite / File if the file will only have 1 sheet.

Write mode for non- File exists File does not exist
Excel files

Overwrite Overwrite file Create file
Append Append to file Create file

New Do nothing Create file
Disabled Do nothing Do nothing

Check write header to write the header (only available for Excel, Delimited
text, HTML and Markdown files). If Write mode is Append you can check if
empty to only write the header if the file (sheet for Excel files) is currently
empty or does not exist (and not for subsequent appends).

Set File comment to any comment you wish to output to the file (only
available for HTML, Markdown, XML and YAML files). This can include file
name variables such as {date}. Leave it empty to output no comment.

Use Alias to identify the file for batch processing or command line processing.
2.5 File formats
|

2.5.1 File formats

Easy Data Transform supports the following data file formats:

Format Input Output

Delimited text Yes Yes
(including CSV and TSV)

Excel XLSX/XLS Yes Yes
Fixed width Yes No
JSON Yes Yes
HTML No Yes
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Format Input Output
Markdown No Yes
Plain text Yes Yes
vCard Yes Yes
XML Yes Yes
YAML No Yes

You can manage the default file type for different file extensions in the Input
Extensions and Output Extensions tabs of the Preferences window.

2.5.2 CSV format

Easy Data Transform can input from and output to CSV format files. Default
file extension ".csv".

CSV (Comma Separated Value) format is commonly used for exchanging
tabular data between programs.

CSV is a type of delimited text file format. The column delimiter is usually a
Comma, but not always. The row delimiter is Line Feed, Carriage Return or
Carriage Return+Line Feed.

Easy Data Transform supports the following column delimiters:
e Comma (,)

e Semi-colon ()

e Colon ()

e Pipe (|)

e Caret ()

e Tab (\t) (used for TSV format)

e ASCII Unit separator (Ox1F)

e Space ()

e Custom (choose your own)

For files padded to fixed column widths with Spaces see Fixed width format.
For file with no column delimiters see Plain text format.

To output to a CSV file you should typically set Delimiter to Comma (,) and
Quoting to As needed in the Right pane.

For example:
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| CategorylD CategoryName Description In stock
1|1 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i3 3 Confections Candies and sweet breads true

Is output with Delimiter set to Comma (,) and Quoting set to As needed as:

CategoryID,CategoryName, Description, In stock
1,Beverages, "Soft drinks, coffees & teas",true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true

Note that " quotes have been used to enclose values that contain delimiter
characters.

Check ignore repeated delimiters if you want to treat 2 or more consecutive
delimiters as a single delimiter. For example, this might be useful if values are
separated by a variable number of spaces:

Area Q1 Q2 Q3 Q4
North 34.4 928.3 83.1 98.3
East 42.1 234.9 88.4 4.1
South  784.4 39.8 55.3 9
1

9.1
West 437.4 83.1 078.4 1.3

Type: Delimited text Type: Delimited text
Delimiter: Space () Delimiter: | Space ()
v ignore repeated delimiters ignore repeated delimiters

Area Q1 Q2 Q3 Q4 Area Q1 Q2 Q3 Q4 6 7 8 9
1 North 344 9283 831 983 1 North 344 9283 831 983
2 East 421 2349 884 41 2 East 421 2349 884 4.1
3South 7844 390 553 99.1 3 South 7844 390 553 991
4 West 4374 831 0784 113 4 West 4374 831 0784 1.3

Set Quoting to Always if you want to quote every value. Set Quoting to
Never if you don't want to quote values (delimiters, Line Feeds and Carriage
Returns within values will be changed to spaces, unless the delimiter is Space
in which case they will be changed to underscore).

You will be warned when inputting a CSV format file that has a different

number of values per row. This may be a sign that there are problems with
the data (e.g. incorrect quoting).
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Data C 'Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1

You can also input a file as plain text and split it using delimiters yourself:

1. Input it with a delimiter unlikely to be in the text, e.g. caret (*), to input it
as a single column

2. Use the Split Col transform to transform it into multiple columns using the
appropriate delimiter.

Many CSV file are not well formed. For example, they have unescaped quotes.
As the CSV format is not well-defined, badly formed CSV files can be
interpreted in more than one way. Easy Data Transform will do the best it can
in these circumstances.

See also:

¢ Video: How to convert CSV to JSON

¢ Video: How to convert CSV to Markdown

¢ Video: How to convert CSV to Tab delimited

¢ Video: How to convert CSV to vCard

e Video: How to convert CSV to XML

¢ Video: How to convert Excel to pipe delimited
¢ Video: How to convert fixed column width to CSV or Excel
e Video: How to convert JSON to CSV

¢ Video: How to convert Tab delimited to CSV
e Video: How to convert XML to CSV

e Video: How to split CSV into multiple files

e Video: How to change CSV file text encoding
e TSV format

2.5.3 Excel format

Easy Data Transform can input from and output to Excel ".xIsx" and " .xIs"
format files, even if you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet
application. It is commonly used for exchanging tabular data.

You can specify the sheet name when inputting or outputting Excel files using
square brackets, for example:
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e MySpreadsheet.xlsx[Sheetl] means the sheet named Sheet1 of
file MySpreadsheet.x1sx (the sheet name is not case sensitive).

e MySpreadsheet.x1lsx[1] means sheet named 1 of file
MySpreadsheet.x1sx (if it exists) or else the first sheet.

e MySpreadsheet.x1lsx means the first sheet of file
MySpreadsheet.xlsx.

Hyperlinks are read in from Excel in the form anchor | hyperlink.

Easy Data Transform will try to infer the Excel column format from the data in
the column. But you can set the Excel format explicitly:

output.xlsx[Easy Data Transform] ‘S 0‘3 D ;

@ Output to file.
Output to:  Single file >
File: 1dy\Desktop\output.xlsx[Easy Data Transform]
Type: Excel XLSX =
Formatting: Manual v

€ Excel Column Formats ] X
W Column Excel Format
8 1 name Automatic

2 id Boolean

3 nametype Date
1 4 recclass General
[ 5 mass (g) Number

6 fall
| | year Formula
' 8 reclat T
1 9 reclong PyoeTk X

Set All * to Automatic *

1 oK Cancel

You can specify how to format columns when outputting to Excel using the
Formatting option.
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Check use style template to copy the styling from another Excel sheet,
including:

column widths

row heights

column/row hidden status

cell merging

text orientation

e fonts
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set wide columns hidden
24
u AutoSave Cm . ") v - styling.xIsjf « Sqved to this PC v pe
File Home Page Layout  Formulas ata eview View Help Power
D 5’ {A}:tos Narrow J[H “l A = ’0‘7 v ?E) Wrap Te
Paste u v O = = = 3= Merge ¢
Clipboard Font ] Alignment
A34 S
B D E G K
set bold
underline 2
3
4
set bold =i
styled.xlsx[Easy Data Transform] i Qﬁ B E:
@ Output to file.
Output to:  Single file v
File: C:\Users\andy\Desktop\styled.xlsx[Easy Data Transform]
Type: Excel XLSX v
Formatting: Automatic v
v use style template C:\Users\andy\Desktop\styling.xIsx[style]
v write header
\Write mode: Overwrite ¥ Sheet v
Alias: styled
Data Characters =~ Warnings @ Info  Comment  Details
10 cols x 20 rows @ written|
D&/ 0o lEY P iE SEN
name id nametype recclass =
1 Allan Hills 85126 991 Valid H5
2 Asuka 881379 4088 Valid Le
@ Autosave ©)« - 5 styledxlsx - Saved to this PC v 2 s
File Home Insert Pagelayout Formulas Data Review View Help Power Piv
flj ﬁ); [Ana\ v][ﬂ v} A = = @ v 25 Wrap Text
e o I v EEE EZE EMegeac
Clipboard 5] Font N Alignment
Al v i Jx~ name
A B D E G K
1 |pame |ﬂ recclass mass (q) year
2 Allan Hills 85126 991 H5 46.5 01/01/1985 12:00:00 AM
3 Asuka 881379 4088 L6 33.68 01/01/1988 12:00:00 AM
4 Dar al Gani 767 6314 L6 35.8 01/01/1999 12:00:00 AM
5 Dominion Range 08262 54041 LL6 15 01/01/2008 12:00:00 AM
6 [Elephant Moraine 90876 9285 L6 19 01/01/1990 12:00:00 AM
7 |Grosvenor Mountains 03027 34582 L5 585 01/01/2003 12:00:00 AM
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You can use a relative location for the template file (relative to the .transform
file):

V' use style template .\inputs\excel-style.xIsx[Easy Data Transform]

Please note the following limitations of Excel:
e Excel .xlsx files are limited to 1,048,576 rows and 16,384 columns.
e Excel xls files are limited to 65,536 rows and 256 columns.
e Date values are input using ISO date format yyyy-MM-dd, regardless of
your locale.
e Datetime values are input using ISO date format yyyy-MM-ddThh:mm:ss,
regardless of your locale.
e The sheet name:
o cannot be more than 31 characters long
o cannot be empty
o cannot contain the following characters: \ / * [ 1 : ?
o cannot start or end with an apostrophe
o cannot be ‘history' (reserved name)

Note that reading and writing Excel files is at least an order of magnitude
slower than reading and writing delimited text files, such as CSV or TSV.

See also:

¢ Video: How to combine columns in Excel

e Video: How to compare Excel sheets

¢ Video: How to convert Excel to JSON

¢ Video: How to convert Excel to Markdown

e Video: How to convert Excel to pipe delimited
¢ Video: How to convert Excel to XML

e Video: How to convert Excel to YAML

e Video: How to convert fixed column width to CSV or Excel
¢ Video: How to join Excel files

¢ Video: How to convert JSON to Excel

¢ Video: How to convert XML to Excel

e Video: How to remove Excel duplicates

¢ Video: How to split a column in Excel

2.5.4 Fixed width format

Easy Data Transform can input from fixed width format files, also known as
fixed column width format. Default file extension ".txt". It is also possible to
output to fixed width format (see below).
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Fixed width format is used for exchanging tabular data between programs. It
is often associated with legacy systems, but is also used for large files where
performance is an issue (e.g. bioinformatics).

In fixed width format each column has a fixed width in characters. There is no
column delimiter. Spaces are typically used as padding to make up the
column width. The row delimiter is Line Feed, Carriage Return or

Carriage Return+Line Feed. For example:

D Name Payment Country Date
8904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 US 08/20/2020
7489 Zadie Green 34567.89 DE 08/20/2020
Is input as:
ID  Name Payment Country Date
18904 John Black 1234567 GB 08/20/2020

2 3999 Jane Brown 23456.78 US 08/20/2020

'3 7489 Zadie Green 34567.89 DE 08/20/2020

Easy Data Transform will analyze the data and guess the column layout if you
set Columns in the Right pane to Automatic. Or you can choose the column
widths by setting Columns to Manual. Click the "..." button to edit the manual
column widths.
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fixed-example.txt ©) s
File: fUsersfandyb/Dropbox/fixed-example.txt
H b
{Columns: _ anual B
@ w Fixed Column Widths
Width Starts at Ends at
Column1 |6 | | 5]
Column2 13 o7 19
Column3 10 - 20 29
Columnd4 9 - 30 38
Column5 10 < 39 48
Merge Split Insert Left Insert Right Delete Columns: &
Preview
000000000111111111122222222223333333333444444444
123456/789012345678901234567890123456789012345678
1D Name Payment Country Date
B804 John Black 12345.67 GB 0a/20/2020
39499 \Jane Brown 23456.78 US 08/20/2020 g
7489 Zadie Green 34567.89 DE 0a/20/2020

Help Cancel “

The current column boundaries are shown on the first few rows in the
Preview. The horizontal offset of each character is shown in gray at the top.
The currently selected columns are highlighted. Click on a column in the
Preview to select it in the table, or vice versa.

You can change the column widths using the Width column of the table.
Select 2 or more adjacent columns and click Merge to merge them into 1

column. Click then Shift+click in either the table or the preview to select
multiple adjacent columns.
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Select 1 column with a Width > 1 and click Split to split into 2 columns.

Select 1 or more adjacent columns and click Insert Left or Insert Right to add
a new column with width 1 to the left or right of the selected columns.

Select 1 or more adjacent columns and click Delete delete the selected
columns.

Click OK to save your changes and Cancel to discard them.

Unwanted columns and rows in the dataset can be removed after input using
the Remove Cols and Filter transforms.

There is no specific fixed width file output type. But you can output fixed

width files:

e Use the Extract transform to shorten any columns that are more than the
desired length.

e Use the Pad transform to pad with spaces any columns that are less than
the desired length.

¢ Use the Rename Cols transform to make columns headers the correct
length.

e Output to plain text format.

See also:
e Video: How to convert fixed column width to CSV or Excel

2.5.5 JSON format

Easy Data Transform can input from and output to JSON format files. Default
file extension "json".

JSON (Javascript Object Notation) format is commonly used for exchanging
data between programs. JSON data is generally expected to be in UTF8
encoding without a Byte Order Mark (BOM).

For example:

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i3 3 Confections Candies and sweet breads true
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Is equivalent to:

{
"CategoryID": 1,
"CategoryName": "Beverages",
"Description": "Soft drinks, coffees & teas",
"In stock": true

bo

{
"CategoryID": 2,
"CategoryName": "Condiments",
"Description": "Sweet and savory sauces",
"In stock": false

y

{
"CategoryID": 3,
"CategoryName": "Confections",
"Description": "Candies and sweet breads",
"In stock": true

}

The Dot ('.") character is used in the column header to show nesting. For

example:
name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c
1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

"name": "Avocado Dip",
"carb": 2,
"cholesterol": 5,
"fiber": O,
"minerals": {
"ca": O,
"fe": 0
by
"protein": 1,
"sodium": 210,
"vitamins": {
"a": 0,
"c": 0

Any Dots in JSON names are converted to Hyphens ('-') on input.
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JSON arrays can be input in either long or wide Format. For example:

[

"name": "1",

"values": [ "a", "b" ]
}I
{

"name": "2",

"values": [ "c", "d" ]

Input as Long (more rows):

name values
11 a
21 b
32 C
|42 d

Input as Wide (more columns):

name values.0 values.1

11 a b

2|2 c d
If children of the top level object are named, then they are flattened slightly
different to avoid creating thousands or millions of columns. For example:

{

"record 1":{

"value": 1
by
"record 2":{
"value": 2
by
"record 3" :{
"value": 3

}
}

Is flattened into:
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_ObjectName_  value
1 record 1 1
2 record 2 2
3 record 3 3

An input JSON format file is expected to have either:
¢ asingle top-level array or object; or
¢ a single JSON object on each line (see jsonlines.org).

e a record separator character followed by a single JSON object on each line
(see REC7464).

You can specify the JSON type for each columns when outputting to JSON
using the Value types option.
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outputljson S d} E E g
@ QOutput to file.
Output to:  Single file b
File: CAUsers\andy\Desktop\output1.json
Type: JSON v
Value types: Manual >
€ JSON Column Types O X
Column JSON Type °
1 name Automatic s
2 id Automatic
3 nametype Boolean
4 recclass Number
5 mass(g)
6 fall Raw data
7 year Automatic v
8 reclat Automatic N
Set All *  to Automatic *
oK Cancel

Note:

e The Raw data type is output without quotes or escaping and can be useful
for data that is already valid JSON.

e The JSON number type does not support numbers with a additional leading
0, such as 0123 or 00.0, or numbers containing a comma (regardless of
locale). These should be output as JSON String type.

¢ Any values that do not match the type selected are output as a JSON null
value.

See also:

¢ Video: How to convert CSV to JSON

e Video: How to convert Excel to JSON
¢ Video: How to convert JSON to CSV

e Video: How to convert JSON to Excel
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2.5.6 HTML format

Easy Data Transform can output to tables in HTML format files. Default file
extension ".html".

HTML (HyperText Markup Language) format is commonly used for creating
web pages. If you don't need the data to take up a whole page, you can just
copy the <table>to </table> part of the output.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
|
|3 3 Confections Candies and sweet breads true

Is output as:

<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table, td, th{border:1px solid black;text-
align:left;vertical-align:top;border-
spacing:0px;border-color:gray; font-family:Verdana, sans-—
serif; }th{background-color:#EQOEOEO; }td, th{padding:5px; }
</style>
</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees &amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
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<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
</html>

Usually you will want to 'escape’ special HTML characters in dataset values
when output to HTML format. For example to convert < to &1t ;, so it can be
correctly displayed in the HTML. However, if you wish to write ‘raw' HTML,
then you can uncheck Escape special characters in the Right pane. Note that
you can also set Change to To escaped HTML to escape selected columns in
the Decode transform.

2.5.7 Markdown format

Easy Data Transform can output to tables in Markdown format files. Default
file extension ".md".

Markdown format is commonly used as a human-friendly markup language,
which can be automatically translated to HTML.

For example:
| CategorylD CategoryName Description In stock
1|1 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
|3 3 Confections Candies and sweet breads true

Is output as:

| CategoryID | CategoryName | Description
| In stock |

| 1 | Beverages | Soft drinks, coffees &

teas | true |

| 2 | Condiments | Sweet and savory sauces
| false |

| 3 | Confections | Candies and sweet breads
| true |
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You can also use Markdown when you need a plain text version of your data,
for example in a code comment.

Note that not all Markdown implementations support tables. If your
implementation does not support tables, you may need to output to HTML
instead.

See also:
e Video: How to convert CSV to Markdown
¢ Video: How to convert Excel to Markdown

2.5.8 Plain text format

Easy Data Transform can input from and output to plain text format files.
Default file extension is ".log" for input and ".log" or ".txt" for output.

Plain text format is used for semi-structured data, such as computer
generated log files.

When inputting plain text the dataset is read into a single column. The row
delimiter is Line Feed, Carriage Return or Carriage Return+Line Feed.

For example:

03/22 08:51:01 INFO :..settcpimage: Associate with TCP/IP image name = TCPCS
03/22 08:51:02 INFO :..reg_process: registering process with the system
03/22 08:51:02 INFO :..reg process: attempt 0S/390 registration

03/22 08:51:02 INFO :..reg process: return from registration rc=0

Is input in plain text format as:

1
103/22 08:51:01 INFO :..settcpimage: Associate with TCP/IP image name = TCPCS

2/03/22 08:51:02 INFO :.reg_process: registering process with the system

3 03/22 08:51:02 INFO :.reg_process: attempt 0S/390 registration

4 03/22 08:51:02 INFO :..reg_process: return from registration rc=0

When outputting plain text:

e Each row ends with a Line Feed, Carriage Return or Carriage Return+Line
Feed, as selected by the user.

e Typically plain text datasets only have 1 column. But if there is more than
one column, the column values will be concatenated without a delimiter. If
you want a delimiter use Concat Cols and Remove Cols to create a single
column that contains the appropriate delimiters, or output as delimited text.

¢ Values are not escaped.
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2.5.9 TSV format

Easy Data Transform can input from and output to TSV format files. Default
file extension ".tsv".

TSV (Tab Separated Value) format is commonly used for exchanging tabular
data between programs.

TSV is a type of delimited text file format where values are separated by Tab
characters and rows by Line Feed, Carriage Return or Carriage Return+Line
Feed. Tabs and Carriage Return are not allowed within data values, so there is
no need for quoting or escaping delimiters, as with CSV files. This means that
TSV files are generally a bit more compact and faster to read and write than
CSV files.

To input a TSV file you should set Type to Delimited text and Delimiter to
Tab (\t) in the Right pane. You will usually also want to uncheck ignore
repeated delimiters and set Quoting to Automatic (which is the same as
Unquoted for Tab delimiters).

You will be warned when inputting a TSV format file that has a different
number of values per row. This may be a sign that there are problems with
the data.

Data ! 'Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1

To output a TSV file you should set Delimiter to Tab (\t). You will usually also
want to set Quoting to Never in the Right pane. If you have a Tab character
or Carriage Return within a value, then Easy Data Transform will then convert
it to a Space on output.

For example:
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| CategorylD CategoryName Description In stock
1|1 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i3 3 Confections Candies and sweet breads true

Is output with Delimiter set to Tab (\t) and Quoting set to Never as:

CategoryID CategoryName Description In stock
1 Beverages Soft drinks, coffees & teas true
2 Condiments Sweet and savory sauces false

3 Confections Candies and sweet breads true

See also:
¢ Video: How to convert Tab delimited to CSV
e Video: How to convert CSV to Tab delimited

2.5.10vCard format

Easy Data Transform can input from and output to vCard format files. Default
file extension ".vcf".

VCard format is commonly used as way of exchanging contact details
between programs.

Note that you need to change the column header names to the values
expected by vCard (using the Rename Cols transform). For example vCard
expects the full name column to be named FN.

Choose an appropriate text encoding. You should probably uncheck Byte
Order Mark if you are encoding in a UTF format, such as UTF-8.

For example:
N FMN ORG TELTYPE=WORKVOICE ADR;TYPE=WORK,PREF
1 Gump;Forrest;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;

Is equivalent to:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest; ;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK,VOICE: (111) 555-1212
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ADR; TYPE=WORK, PREF:100 Waters
Edge;Baytown;LA;30314;United States of America
END:VCARD

See also:
e Video: How to convert CSV to vCard

2.5.11 XML format

Easy Data Transform can input from and output to XML format files. Default
file extension ".xml".

XML (Extensible Markup Language) format is commonly used for exchanging
data between programs.

For example:

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i3 3 Confections Candies and sweet breads true

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp;
teas</Description>
<In-stock>true</In-stock>
</record>
<record>
<CategoryID>2</CategoryID>
<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>
</record>
<record>
<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>
</record>
</root>
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The Dot ('.") character is used in the column header to show nesting. For

example:
name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c
1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Note that the columns may be input in a different order to the nodes in the
XML. You can use Reorder Cols or Stack transforms to change the ordering.

Any Dots in XML element names are converted to Hyphens ('-') on input.

The Underscore ('_') character is used at the start of a column header name to
identify it as an XML attribute. For example:

_name _carb _cholesterol _fiber minerals.ca minerals.fe _protein _sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0
Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record carb="2" cholesterol="5" fiber="0"
name="Avocado Dip" protein="1" sodium="210">
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
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<c>0</c>
</vitamins>
</record>
</root>

Repeated XML values can be input in either long or wide Format. For
example:

<?xml version="1.0" encoding="UTF-8"?>
<ITEMS>
<ITEM>
<PARAM name="a" value="1"/>
<PARAM name="b" value="2"/>
</ITEM>
</ITEMS>

Input as Long (more rows):

PARAM._name PARAM. value
1b 2

2a 1

Input as Wide (more columns):

PARAM._value PARAM._name PARAM._value.l PARAM._name.1
11 a 2 b

You can set the names for the root and record tags and add extra XML below

the root:
<?2xml version="1.0" encoding="UTF-8"2>
<!-— File created 2023 09 27

Above root: <Above>Abovel</Above> 17 23 38 226 >

<Above>Abovelk/Above>
<Above>Abovelk/Above>
P <root>
<Below>Bel
<Below>Bel
< TECOTd>

<v>l</v>

\.</record>
<re

<v>2</v>
</record>
</root>

<Above>Abovel </Above>
Root name:  root

1</Below>
2</Below>

<Below>Below1</Below>
<Below>Below2 </Below>

Below root:

Row name:  record

Write mode:  Overwrite

| A4S

File comment: File created {date} {time}

Use " if you need nested tags:
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<?xml version="1.0" encoding="UTF-8"7?>
<l-- File created 2023 09 27
17_31 09 740 -—>

<hAbove>Abovel</Above>

Above root: <Above>Above1</Above> - <Above>Abovel</Above>
<Above>Abovel</Above> v g <rootl>
Root name:  rootl.root? ] <Below>Belowl</Below>
!!th <Below>Below2</Below>
Below root: <Below>Below1</Below> — \<root2>
<Below>Below?2 </Below> v <record>
Row name:  record <v>1</v>
</record>
Write mode:  Overwrite x F <record>
File comment: File created {date} {time} r <v>2</v>
</record>
</root2>
</rootl>

Exclamation marks at the start of column names are removed from name tags
when output to XML. This can be useful when you want duplicate tag names
with the same parent.

<root>
<family>
<name>Smith</name>

<member>
~ <name>John Smith</name:>
1Smith John Smith Jane Smith Bob Smith <name>Jane Smith</name>
<name>Bob Smith</name>

</member>
</family>
</root>

name member.name member.name member.name

<root>
<family>
<name>Smith</name>
<member>
<name>John Smith</name:>
</member>

<member>
‘ : . ‘ —h >Jane Smith</
1 Smith John Smith Jane Smith Bob Smith <name>Jane Smi name>

</member>
<member>
<name>Bob Smith</name:>
</member>
</family>
</root>

name member.name [[lnember.name [ member .name

You are responsible for ensuring that the names of XML nodes and attributes
are valid (e.g. start with a letter or underscore and do not contain spaces).

If you need really fine grained control over the XML output, you can:
¢ output the XML to a file

e read the file back in as plain text

e apply transforms

e write it back out as plain text
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A
output.xml ol == [0E¢ ,
|
@ Output to file.
Output to:  Single file =
File: C:\Users\andy\Desktop\output.xml
Type: Plain text i
See also:
e Video: How to convert CSV to XML
e Video: How to convert Excel to XML
¢ Video: How to convert XML to CSV
e Video: How to convert XML to Excel
e Video: How to convert CAMT 053 XML to Excel or CSV
2.5.12 YAML format
Easy Data Transform can output to YAML format files. Default file extension
"yaml".

YAML (YAML Ain't Markup Language) format is commonly used for
exchanging data between programs and for configuration files.

For example:

| CategorylD CategoryName Description In stock

1|1 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
|
|3 3 Confections Candies and sweet breads true
Is output as:

CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas

In stock: true

CategoryID: 2

CategoryName: Condiments

Description: Sweet and savory sauces

In stock: false
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CategoryID: 3

CategoryName: Confections
Description: Candies and sweet breads
In stock: true

See also:
e Video: How to convert Excel to YAML

2.6 Processing

You can run processing of your data in one of two modes:

e Automatic mode: Processing is run automatically as soon as you have
stopped making changes, for the amount of time specified in the
Preferences window.

e
DE:E‘I:

e Manual mode: You control when processing is run, on an item-by-item
basis.

[ NN
O 68 & & é Bl B O

You can switch between modes by toggling Run>Auto Run, or the
equivalent tool bar button.

Typically automatic mode is better for small to medium datasets, but manual
mode may be a better choice for large datasets.

There are 3 options for running processing in manual mode:

¢ Run>Run Unprocessed: Run processing on any items that are not already
processed.

¢ Run>Run Selected: Run processing on one or more selected items, even if
they are already processed. Any upstream items that need updating are
also processed.

e Run>Run All: Run processing on all items, even if they are already
processed. This is provided for completeness, but you should usually use
one of the above 2 options, for efficiency.
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@ EasyDataTransform File Edit Nl View Licensing

. [ Auto Run
D B lh & > B O Run Unprocessed :H:
v Input " Run Selected '
From File @ EUES

From Clipboard @

You can also click the Run button in the Right pane, which is equivalent to
Run>Run Selected. Note that Run, for a clipboard input, applies the options
to data previously imported. If you want to re-import from the clipboard in
automatic mode, then you have to click the Import from clipboard button.

Check View>Timing Profile to see where the processing time is being spent.
The length of the colored bar is proportional to the fraction of total
processing spent processing that item.

L
10k.csv
14 cols x 10k rows
(o] ] {— ] _________] (|
Stack Filter Sort output.csv
—0 — 9 —0 P
14 cols x 110k rows 14 cols x 81,5k rows 14 cols x 81,5k rows 14 cols x 81.5k rows
[
100k.csv
9

14 cols x 100k rows

Or select View>Item Summary... and click on the Processing column header
to sort by processing time,

EEe o« 0 Aaaaaf @ (vrwwr | @

® ® Item Summary
G)&
id Type ~ Name Upstream Upstream Ids Downstream  Downstream Ids | Columns Rows Status Processing Result
1 45 Transform Replace 1 33 1 36 5 209 @ Uptodate 0.009 No changes
2 39 Transform MNum Format 1 38 1 40 6 1585 Up to date 0.006 Nochanges
3 38 Transform Filter 1 37 1 39 6 1556 @ Up to date 0.008 54 rows...
4 37 Transform Sort 1 36 1 38 6 209 @ Up to date 0.000 No changes
5 36 Transform Javascript 1 45 1 37 6 209 Up to date 0.020 209 evaluate...
(3 33 Transform Join 2 26,32 1 45 5 209 @ Uptodate 0.006 209 rows ...
7 32 Transform Dedupe 1 16 1 33 4 209 @ Uptodate 0.022 14,449 rows ...
8 30 Transform Sort 1 29 0 2 99 @ Up to date 0.001 Sorted
9 29 Transform Count 1 26 1 30 2 99 @ Uptodate 0.006 99 counted ...
10 26 Transform Sort 1 24 2 29,33 2 210 @ Up to date 0.002 Sorted
il 24 Transform Pivot 1 16 1 26 2 210 @ Uptodate 0.057 Pivot table ... 4
12 20 Transform Spread 1 16 0 104 209 @ Up to date 0.066 100 cols ...
13 16 Transform Remove Cols 1 15 3 20,24,32 4 14,658 0 Up to date 0.029 7cols ..
14 40 Output output.xlsx 1 39 0 Error 0.018 Error writing

16 44 Note

Inputs: 1, Transforms: 13, Outputs: 1, Notes: 4
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You can stop processing with Run>Stop Run, or the equivalent tool bar
button. If you stop processing in automatic mode it will switch to manual
mode.

When an item is processed, all it's upstream items will be processed first. You
can only change the options for an item in the Right pane if all it's upstream
inputs and transforms are processed.

2.7 Comments
1

You can manage the complexity of large .transform files by adding comment
text to:

¢ The Comment field of Note items. These are added to the Center pane by
right clicking and selecting Note from the menu. You can also set an Arrow
direction and a Color. If you right click on an existing item, the Note item
will be placed pointing to that item, if there is space. The comment will be
shown as a tooltip when you hover over the Note item.

Deaths by
date

Spread

v

j—
Latest vl,‘:'c"[",\'.',’[',_' e ,Remove Cols ,  Pwot , sort , Count , Sart | Death
COVID data PP 3 cxe 8 rems et o | frequencies

, Jein |  Replace b
( Filter ,Num Format Joulpul.xlsx) Deaths by
s I - ¢ o x135 s | b n 183 e

country
Scale to per
10k

e The Comment tab of Input, Transform or Output items. Check View>Show
Comments to show these comments in the Center pane. The comment will
be shown as a tooltip when you hover over the item.
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Data  Warnings Info = Comment*

Sum total COVID cases.

Stats

Sum total COVID cases.
11 cols x 14.7k rows

N
Name: Stats

Size: 11 cols x 14.7k
Transform type: Analysis

Result: Sum row a

Comment: Sum total COVID cases.

T

¢ In the Notes window that is displayed when you select File>Notes... from
the main menu.

You can also visually group related items in the Center pane to show that
they are related.

2.8 Connections
1

When you select an input or transform item and add a transform or output
item, connections to the currently selected item(s) are added automatically.

To select a connection

To select a connection either:

e Click on the connection; or

e Click and drag a box over any part of the connection. This may be easier
than clicking the connection when you are zoomed back.

transactions.csv Filter
— g

35 cols x 60.1k rows 35 cols x 17.8k rows

To delete a connection
To delete a connection:
e Select the connection.
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e Select Edit>Delete (or click the Delete tool bar button).

Easy Data Transform will try to remember columns when an item is
disconnected and reconnected. But it is generally better not to disconnect an
item, unless you have to.

e If you want to change an input file, do it by selecting the input and clicking
on '.."in the Right pane, rather than disconnecting the input and
connecting a new one.

e If you want to add a new transform between 2 already connected items,
you can do it without disconnecting (see below).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.

To add a connection

To add a new connection between two existing items:
e Hover over the start item.

e Click the '+' that appears.

e Hover over the end item

e Click the '+' that appears.

Press the 'Esc' key or click away from an item to cancel adding the
connection.

Note that the '+' will only appear if an additional connection is allowed. For
example you can't:

e Create a loop.

e Connect more than once to an output.

2.9 Headers
]

If the first row of an input is a header (i.e. one that describes the columns
below) check has header for that input in the Right pane.
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vaccination.csv @ IC? E

]

File: /Users/andyb/Desktop/vaccination.csv

Type: Delimited text b
Delimiter:  Automatic L+
Quoting: Automatic C
Encoding: Automatic t
Ignore: First O row(s) =
+ has header
espace
+ simplify whitespace
+ ignore empty rows
watch file
Meta info: Mot added 4

Alias: vaccination
Data Warnings Info Comment Results

3 cols x 5,780 rows

& E% & @ Show first 10 rows <

country time becg_vacc

When you first read in a dataset Easy Data Transform will make a guess about
whether the first row is a header (it will assume it is a header if it contains no
dates or numbers).

If you have unwanted rows that appear before the header, you can remove
them using the Ignore field.

You can move 1 or more dataset rows to the header using the Header
transform.

See also:
e Compare 2 or more dataset headers
e Schemas

2.10 Column types

Easy Data Transform does not require you to explicitly set column types. But
different transforms might interpret a column as text, numeric or date, as
appropriate. For example, intelligent sort in the Sort transform will infer
whether a column is text, date or numeric from the values in the column, and
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sort it accordingly. This approach is very flexible and can save you a lot of
time.

Note that you can explicitly set a column type when exporting to Excel or
JSON files.

2.10.1 Text

Whitespace (such as Space and Tab characters) and case are always
significant, unless stated otherwise.

You can remove leading and trailing whitespace by checking trim whitespace
in the Input or using the Whitespace transform.

You can change the case using the Case transform.

You can concatenate and split columns of text using the Concat Cols and Split
Col transforms.

Manipulate columns of text using the Chop, Extract, Insert, Pad, Replace and
Substitute transforms.

Count the number of times each text value appears in a column using the
Count transform.

Check text values are as expected in a column using the Verify transform.

Generate random text values from a selection using the Random transform.

2.10.2 Date

Set Supported Date Formats in the Preferences window according to how
you want to interpret values as dates.

Format Meaning

d The day as number without a
leading zero (1 to 31)

dd The day as number with a leading
zero (01 to 31)

ddd The abbreviated localized day name
(e.g. 'Mon' to 'Sun'). Uses the locale
to localize the name.

dddd The long localized day name (e.g.
'‘Monday' to 'Sunday'). Uses the
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Format Meaning
locale to localize the name.

M The month as number without a
leading zero (1 to 12).

MM The month as number with a leading
zero (01 to 12)

MMM The abbreviated localized month
name (e.g. 'Jan' to 'Dec’). Uses the
locale to localize the name.

MMMM The long localized month name (e.g.
‘January' to 'December’). Uses the
locale to localize the name.

vy The year as two digit number (00 to
99).
YYvyy The year as four digit number. If the

year is negative, a minus sign is
prepended in addition.

For example:

e To support a date such as 31/1/2019 add a supported date format:
d/M/yyyy

e To support a date such as 1-31-19 add a supported date format: M-d-yy

List the date formats in order of preference, with the most likely to be used
first.

Dates with only two year digits, are treated as a date between 1900 and 1999.
E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919.

Add today date to a dataset using input file meta information or using the
Stamp transform.

Values that are in a recognized date format will be treated as dates in
transforms such as: Calculate, Compare, Filter, If and Sort. Supporting large
numbers of date formats will slow down these transforms.

Change the format of dates using the DateTime Format transform.

Do date calculations, such as calculating the number of days between 2 dates,
using the Calculate or Javascript transform.
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Convert between ISO standard datetimes and milliseconds since 1st Jan 1970
using the Calculate transform.

Convert an ISO standard datetimes (e.g. 2020-10-16T01:51) into separate date
and time columns by using the Split Cols transform on the "T" delimiter.

Add missing dates in a sequence using Sequence.

Check date values are as expected in a column using the Verify transform.

Generate random dates using the Random transform.

Days of the week in ddd format in some of the more commonly used locales

are:

Day of
week

English/ English/ French/ German/ Italian/lt Spanish

United
Kingdo
m
1 Sun
Mon
Tue
Wed
Thu

Fri

N OO o AW N

Sat

United
States

Sun
Mon
Tue
Wed
Thu
Fri
Sat

France

dim.
lun.
mar.
mer.
jeu.
ven.

sam.

German
y

So.
Mo.
Di.
Mi.
Do.
Fr.
Sa.

aly

dom
lun
mar
mer
gio
ven

sab

/Spain

dom
lun
mar
mié
jue
vie

sab

Days of the week in dddd format in some of the more commonly used locales

are:

Day of
week

English/
United
Kingdo
m

1 Sunday

2 Monday
3 Tuesday

English/
United
States

Sunday

Monday
Tuesday

French/
France

dimanch
e

lundi

mardi

German/
German

y

Sonntag

Montag

Dienstag

Italian/It
aly

domenic
a

lunedi

martedi

Spanish
/Spain

domingo

lunes

martes
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Day of  English/

week United
Kingdo
m

4 \Wednes
day

5 Thursday

6 Friday
7 Saturday

English/
United
States

Wednes
day

Thursday

Friday
Saturday

French/
France

mercredi

jeudi

vendredi

samedi

German/ ltalian/It
German aly

y

Mittwoch mercoled
i

Donnerst giovedi
ag

Freitag venerdi

Samstag sabato

Spanish
/Spain

miércole
[

jueves

viernes

sabado

Months of the year in MMM format in some of the more commonly used

locales are:

Month  English/ English/ French/ German/ Italian/Ilt Spanish

of year United
Kingdo
m

—

Jan
Feb
Mar
Apr
May
Jun
Jul
Aug

© 00 N oo g DN

Sept
Oct

= -
= O

Nov

12 Dec

United
States

Jan
Feb
Mar
Apr
May
Jun
Jul
Aug
Sep
Oct
Nov

Dec

France

janv.
févr.
mars
avr.
mai
juin
juil.
aoat
sept.
oct.
nov.

déc.

German aly
y

Jan. gen
Feb. feb
Marz mar
Apr. apr
Mai mag
Juni giu
Juli lug
Aug. ago
Sept. set
Okt. ott
Nov. nov
Dez. dic

/Spain

ene
feb
mar
abr
may
jun
jul
ago
sept
oct
nov

dic

Months of the year in MMMM format in some of the more commonly used

locales are:

Easy Data Transform © 2025 Oryx Digital Ltd



Reference

Month
of year

English/
United
Kingdo
m

—

January
February
March
April
May
June
July
August

© 00 N o a ~ DN

Septemb
er

-
o

October

11 Novemb
er

12 Decemb

er

2.10.3 Numeric

English/
United
States

January
February
March
April
May
June
July
August

Septemb
er

October

Novemb
er

Decemb
er

French/
France

janvier
février
mars
avril
mai
juin
juillet
aodt

septemb
re

octobre

novembr
e

décembr
e

German/
German

y

Januar
Februar
Marz
April
Mai

Juni

Juli
August

Septemb
er

Oktober

Novemb
er

Dezemb
er

Italian/It
aly

gennaio
febbraio
marzo
aprile
maggio
giugno
luglio
agosto

settembr
e

ottobre

novembr
e

dicembr
e

Spanish
/Spain

enero
febrero
marzo
abril
mayo
junio
julio
agosto

septiemb
re

octubre

noviembr
e

diciembr
e

Set the locale according to how you want to interpret values as numbers. For

example:

e |f locale is set to English/United Kingdom or English/United
States then 123, 456.7 isanumberand 123.456, 7 isn't

e If locale is set to German/Germany or French/France then
123.456,7isanumberand 123, 456.7 isn't

An integer is a whole number. E.g. 1.0 or 1, 0 (depending on your locale), -1

and 1e3 are considered integers.

Numeric values are recognized in the approximate range -1 x 103% to +1 x

10308,

Numeric calculations are accurate to approximately 16 digits of precision. This
means that Easy Data Transform may consider 12345678901234567 and
12345678901234568 to be equal, for example using the = operatorin a

Filter transform.
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NaN means ‘not a number'. It can be returned by some calculations, for
example using Calculate to raise 1000 to the power 1000 will overflow
numerically and return NaN.

Rounding artifacts can sometimes occur during calculations with real (floating
point) numbers. This is because fractional values whose denominator is not a
power of 2 (e.g. 0.1), cannot be exactly represented as floating point numbers

of finite precision. It is not a bug.

Change the format of numbers (e.g. the number of decimal places or the
decimal symbol) using the Num Format transform.

Change the base of integers (e.g. base 10 to base 16) using the Num Base
transform.

Do numeric calculations, such as multiplying 2 columns, using the Calculate or
Javascript transforms.

Add missing integers in a sequence using Sequence.
Check numeric values are as expected in a column using the Verify transform.

Generate random real or integer numbers using the Random transform.

2.10.4 Boolean

A boolean value can be true or false.

Canonical value Allowed values Examples
true true (case insensitive) true
. TRUE
or a non-zero numeric
True
value 1
1.0
-1
0.1
999
false false (case false
. e FALSE
insensitive) or a zero
) False
numeric value 0
0.0
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2.11 Locale

You can set the Locale in the Preferences window.

Locale:  English United Kingdc ) Default

The locale language and country setting affect how numbers and dates are
interpreted and displayed.

Example outputs using the DateTime Format transform with ISO date value
2001-05-21 and Format to set to ddd MMMM d yyyy:

Locale to Result
English/United States Mon May 21 2001
English/United Kingdom Mon May 21 2001
German/Germany Mo. Mai 21 2001
French/France lun. mai 21 2001
Spanish/Spain lun. mayo 21 2001
ITtalian/Italy lun maggio 21 2001
Portuguese/Portugal segunda maio 21 2001
Arabic/Egypt OsOSIdl gl a YY Yoo
Chinese/China BA— EA 21 2001
Japanese/Japan A 5A 21 2001

Example outputs using the Num Format transform with US/UK number value
1234.567:
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2.12

Locale to Result

English/United States 1,234.567
English/United Kingdom 1,234.567
German/Germany 1.234,567
German/Switzerland 17234.567
French/France 1 234,567
Spanish/Spain 1.234,567
ITtalian/Italy 1.234,567
Portuguese/Portugal 1 234,567
Arabic/Egypt Y,YYe,0Y
Chinese/China 1,234.567
Japanese/Japan 1,234.567

You will be warned if you File>Open a .transform file with a different locale to

the one you have set.

Meta Information

You can add meta information to input data using the Meta info field in the
Right pane when you select an input item.
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10k.csv ‘= Qﬁ == E
@ Input from file.
File: DAEDT data\CSW10k.csv

Ignore: . v row(s)
€ Meta Information X
| $(FilePath) ${CurrentDateTime]‘l Clear
Insert: <select> o
OK Cancel = Help

Meta info: At start \'\

Alias: 10k

Data Characters Warnings @ Info Comment Details

14 cols x 10,001 rows @) Read

MER SO HHE Y K< 22T
I = CA
L\\.'L_’J. L

1l D:\EDT data\CSV\1lOk.csv 2022-12-05T09:30:29 ]

Set it to At start, At end or Every row, depending on where you want the
meta information to appear. Then click on the ... button to edit which
information you wish to show. The following placeholders are substituted by
their actual values at the time of input.

Meta Information Description Example

$ (ComputerName) The name of the MyComputer
computer.

$ (CurrentDate) The current date, in ISO 2020-08-18
format.

$ (CUrrentDateTime The current datetlme’ |n 2020-08-
) ISO format. 18T18:00:00

$ (DataColumns) The number of columns 10
in the dataset (not
including meta data).
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Meta Information

$ (DataRows)

S (DataValues)

S(FileCreatedDate
)

S (FileCreatedDate
Time)

S (FileName)

S (FilePath)

S (FileSheetName)

$(FileSizeBytes)

$ (FileUpdatedDate
)

S (FileUpdatedDate
Time)

Description

The number of row in
the dataset (not
including meta data).

The number of columns
X rows in the dataset
(not including meta
data).

The date the file was
created, in ISO format.
Only available for file
input.

The datetime the file
was created, in ISO
format. Only available
for file input.

The name of the input
file, including it's
extension. Only
available for file input.

The full location (path)
of the input file. Only
available for file input.

The name of the sheet.
Only available for Excel
file input.

The size of the file in
bytes. Only available for
file input.

The date the file was
last updated, in ISO
format. Only available
for file input.

The datetime the file
was last updated, in ISO
format. Only available
for file input.

Example

10,000

100,000

2020-08-18

2020=08=
18T18:00:00

myfile.csv

/Users/andy/Docum

ents/myfile.csv

Sheetl

1,234,567

2020-08-18

2020-08-
18T18:00:00
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Meta Information Description Example
$ (UserName) The name of the user ~ Andy
(from the USER or
USERNAME

environment variable).

If Meta info is set to Every row you can set the new column name in New
column name.

See also:
e Stam

2.13 Schemas
1

The columns of an input can change over time:
e new columns added

e existing columns deleted

e column order changes

This is known as 'schema drift'. You can define a schema for each input, to
manage this. Set Use schema to Yes and add the expected column names in
the expected order (first column at the top, last column at the bottom). Click
the Import button to import the columns from the current input.
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[metenrites.csv | %= tﬁ} E:

(%) Input from file.
File: s/andyb/Dropbox/EDT_data/meteorites.csv

v .5 he.
@chema: Yes <
e e Schema
61| ® IE1E ® B & X
Expected columns Missing column value
1  name
2 id
3  nametype
4 recclass
5 mass (g)
& fall

Missing columns in input:  Add as in schema

Out of order columns ininput:  Re-order as in schema

Extra columns in input:  Add to end
®
B T T R T P S B

You can then choose what to do for:
e columns that are missing (in the schema, but not in the input):
o add a column at the expected position in schema schema with all values
set to Missing column value; or
o stop with an error
e columns that are out of order (in a different column position in the schema):
o move column to the expected position in schema; or
o stop with an error
e columns that are extra (in the input, but not in the schema):
o add the extra column to the end; or
o ignore the extra column; or
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o stop with an error

Matching between input column names and the schema is case sensitive and
takes account of whitespace.

Any changes caused by the schema are output to the Warnings tab of the
input and a summary of the changes are output to the Info tab.

For Excel inputs the ignore hidden columns option is applied before the
schema.

The ignore empty columns option is applied after the schema.
Schemas work best when all columns have unique names.

See also:
¢ Video: How to handle schema drift

2.14 Verifying data
-

Real world datasets are often 'dirty’, with invalid and missing values. You can
check whether a dataset conforms to expected values (and remove rows or
stop processing if it doesn't) using the Verify transform.

See also
¢ Video: How to verify data

2.15 Column variables
]

Transforms such as Filter, If, Insert, Javascript, Lookup, Replace, Slice and
Substitute allow you to use the values in the same row using column
variables. Column values can be referenced either:

e By column header name, e.g. $ (item cost) for the 'item cost' column;
or
e By column index, e.g. $ (1) for the first column.

Notes:

e The column name is case sensitive. E.g. column 'A' is referenced by variable
$ (A) and column 'a' is referenced by variable $ (a) .
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e Whitespace at the start or end of the column name is ignored. E.g. column '
A 'is referenced by variable $ (n) .

e Whitespace within the column variable is important. E.g. column 'AB' is not
referenced by variables $ (A B), $ (AB) $( AB) or $ (AB ).

e If multiple columns have the same name, the first column from the left with
that name will be used.

e Reference by name takes priority over reference by index. For example, if
there is a column named "1" then $ (1) will refer to that rather than the
first column.

e Column variables are replaced as text. For example if column 'A' has value
‘2" and column 'B' has value '3', then $ (A) *$ (B) evaluates as '2*3' (not '6").

e Column names can contain $, ( and ) characters. For example:

If ol = [0E

@ Create a new column with values conditional on other columns.

New column name: Value

@EesElE @Aano ™ L ®

Logic Column Op. Value
11F currency ¥ = ¥ |USD
2 THEN= $$(value($))
3 ELSE= £$(value(£))
Vv case sensitive
Data Characters ~ Warnings Info Comment Details

2.16

5 cols x 2 rows

@) 1 match(es) IF/ELSE IF, 1 match(es) ELSE

B /@ H=EY

File name variables

<<=/ T

W
transaction currency vwvalue($) value(f) Value

1 2634543 USD 34232.33 $34232.33

2 9233663 GBP 62022.94 £62022.

94

You can dynamically change the name of an output file based on input file
names using file name variables. For example, if the input file with alias
orders has file name orders dec 2022.csv, then setting the output
filename to output {orders.fname}.csv will write to

output orders dec 2022.csv.
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Alias: orders !

orders-dec-2..

14 cols x 830 rows

Join output_{orde...
(/] —- 0 -
18 cols x 2.2k rows 18 cols x 2.2k rows
order-details....
5 cols x 2.2K rows
File: C:\Users\andy\Desktop\output_{orders.fname}.csv

You can also include dates and times in your output file names.

File name variable Meaning Example
{<input The name of the input  If the input with alias
alias>.fname] file being processed orders is using
with the corresponding file /Users/andy/Do
alias. cuments/orders_ 20

20.csv then
{orders.fname} is
replaced with

orders 2020.

{<input The extension of the If the input with alias

alias>.ext} input file being orders is using
processed with the file /Users/andy/Do
corresponding alias. cuments/orders_20
Does not include the .. 20.csv then

{orders.ext} is
replaced with csv.

{<input The sheet of the input  If the input with alias
alias>.sheet} file being processed orders is using
with the corresponding file /Users/andy/Do
alias (Excel only). cuments/orders 20

20 .x1sx with sheet
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{<input
alias>.folder}

{<input alias>}

{date}

{time}

{datetime}

The folder (directory) of
the input file being
processed with the
corresponding alias.
Does not include the
final /.

The name of the input
file (plus an underscore
and the sheet name, if
an Excel file) being
processed with the
corresponding alias.

Date processing was
carried out in
year_month_day
format.

Time processing was
carried out in
hours_minutes_seconds
_milliseconds format.

Date/Time processing
was carried out in
year_month_day_hours_

Sheetl then
{orders.sheet} is
replaced with Sheet1.

If the input with alias
orders Is using

file /Users/andy/Do
cuments/orders 20

20.csv then
{orders.folder} is
replaced

with /Users/andy/D

ocuments.

If the input with alias
orders is using

file /Users/andy/Do
cuments/orders 20

20.csv then
{orders} is replaced
with value

orders 2020.

If the input with alias
orders is using

file /Users/andy/Do
cuments/orders 20

20 .x1sx with sheet
Sheetl then
{orders} is replaced
with
orders 2020 Sheet
1.

2025 04 18

15 01_56_599

2025 04 18 15 01
56 599
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{day}

{month}

{year}

{hour}

{minute}

{second}

{computername}

{username}

{transformfname}

{version}

minutes_seconds_millis
econds format

Current day of the
month (2 digits).

Current month of the
year (2 digits).

Current year (4 digits).

Current hour of the day
(2 digits).

Current minute of the
hour (2 digits).

Current second of the
minute (2 digits).

The name of the
computer.

The name of the user

(from the USER or
USERNAME

environment variable).

The file stem of the
.transform file. Empty if
not set.

The Easy Data
Transform version
number

01

56

MyComputer

Andy

If the .transform file
path

is /Users/andy/Doc
uments/myfile.tra

nsform then
{transformfname}

is replaced with
myfile.

v2 8 0

File name variables can be used for output file names set in the Right pane, in
batch processing or through command line arguments.
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2.17 Regular expressions
-

Regular expressions are a powerful way to match patterns in text (including
text representation of dates and numbers). For example, you can use a
regular expression in the Replace transform to swap first and last names:

Match Type Replace With
1 Regex ¥ (w+hs*w+) A2\

Turns:

Full name

1 John Smith
2 Mary Brown

3 Jill Jones

Into:

Full name

1 Smith, John
2 Brown, Mary

3 Jones, Jill

Easy Data Transform allows the use of regular expressions in the Compare,
Extract, Filter, If, Lookup, Replace, Slice, Split Col and Split Rows transforms. It
is also available as part of the Javascript language in the Javascript transform.

Regular expressions are far too big a topic to cover here. However there are
many detailed resources online, such as regex101.com, www.regular-
expressions.info and regexr.com.

2.18 Fuzzy matching
|

Fuzzy matching allows you to match 2 values that are similar, but not
identical. For example if you set fuzzy match closeness to 80%, then 2 values
that are 80% the same or better are considered a match.
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For example, doing a fuzzy match to this value:

100 avenue street, townsville, ohio

Gives:
Value Fuzzy closeness
100 avenue street, 100%

townsville, ohio

100 avnue street, 98%
townsville, ohio

¢}

100 avenue street 95%
townsville ohio

100 avenue st., 89%
townsville, ohio

100 avenue st, townsville 72%

100 av. st., citysville, 52%
texas

townsville, ohio 416%
742 evergreen terrace, 36%

springfield, oregon

Fuzzy matching treats everything as text and takes account of whitespace. It
can optionally take account of case.

Easy Data Transform supports the use of fuzzy matching in various transforms,
including the Cluster, Dedupe, If, Filter and Lookup transforms.

Fuzzy matching is significantly slower than exact matching. The closeness
score is based on Levenshtein distance.

See also:
e Match dirty data

2.19 Drilldown
1

If you check allow drilldown for a transform, double clicking a cell in the
Right pane data table shows the rows in the upstream dataset that this
cell/row was derived from. For example you can double click a cell in a pivot
table to drilldown into the rows it was calculated from:
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Set non-calculated: Zero

6 cols x 5 rows

BB ZeHEY

Pivot odll=:! EC
@ Create a pivot table to summarize the selected columns.
Columns: Match type v |
Rows: Added/Excluded v
Values: Clicks v
Summarize by: Sum v

V' add totals
Total by: Rows and columns v
v allow drilldown '
Data Characters Warnings Info  Comment Details

@) pivot table created
o [ | e | e O O B %

Added/Excluded (Empty) Broad match Exact match Phrase match Grand Sum !
1 (Empty) 24913 0 0 0 24913
2“ 0 223 1903 103 2229
3 Excluded 0 / 26 632 0 658

€ Drilldown ¥ double-click O %

Ho)

Search term Match type  Added/Excluded  Clicks Impr. CTR =

43  |print at home place cards  Broad match Added 5 5100 |
232 place card Broad match 3 89 3.37¢
485 size of place cards Broad match 1 7 14.2¢
544 |printable dinner place cards Broad match 3 2 150.(

A4

»

You can also select Drilldown... from the right click menu.

Easy Data Transform allows drilldown in the following transforms: Count,
Dedupe, Ngram, Pivot and Unigue.

Note that enabling drilldown slows down processing and requires more
memory.

It is also possible to drilldown when profiling a dataset.

See also:
e Video: How to drilldown into data
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2.20 Batch processing

To apply the current .transform file to multiple input files/sheets select
File>Batch Process... . The Batch Process window will appear with a column
for each input item and a column for each output item. The Alias for each
item is displayed in the column header.

orders.xlsx
V) [orders]
14 cols x 830 rows ‘A\ias‘ output
Alias: orders .
Join output.csv
(] —9
‘Alias' customers. 24 cols x 830 rows 24 cols x 830 rows
customers.csv
11 cols x 91 rows

€ Batch Process X
Input locations caginclude wildcards and Excel
E.g. 'C:\Users\and®\Documents\*.csv' or 'C:\Users\@dy\Documents\*xIsx[*]".
Output locationgitan include variables:
E.g. 'C:\Users\agly\Documents\output\{customers.fndne}.csv'.
Where:

{customers.flame} is replaced with the file stem of the Wput with alias ‘customers’

{customers Bt} is replaced with the file extension of the faput with alias ‘customers’

{orders.fnalie} is replaced with the file stem of the input Wih alias ‘orders'

{orders.exf} is replaced with the file extension of the input alias "orders’

{orders.sBeet} is replaced with the Excel sheet of the input with alias 'orders'.

{date}, e} and {datetime} are replaced by the processing d. time and datetime.
Click 'Hgp' for more details.

Ad Remove | Clear

Input alias=customers Input alias=orders Output alias=output (Overwrite)
1/C:\Users\andy\batch\customers.csv ... |C:\Users\andy\batch\order* xlsx[*] ... ch\out\{orders.fpame)_{orders.sheet}.csv ...
logging Process| Stop v make a sodhd on completion
- orders orders
l wildeards file name sheet name
V' log results to y\Desktop\batch_log.txt| ... ' Append ¥ Close | Help

Note:

All input and output items must have an alias.

An output item can't have the same alias as another output or input item.
Disconnected input and output items are not shown.

Output items with Write mode=Disabled are not shown.

Click Add to add a new processing row.
Click Remove to remove the selected processing row(s).
Click Clear to remove all processing rows.

Check clear 'Append’ outputs before first append if you want to clear
output files you are appending to before the first append.
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Check log results to if you want to log the results to a text file. Set the file
location and set the write mode to Overwrite or Append. You can use
{datetime}, {date} and {time} in the file location.

In the input column(s) you can use * and ? wildcards for file name stems, file

extensions and Excel sheet names. E.g.:

Input

/Users/andy/Documents/*.cs
%

/Users/andy/Documents/d?
.CsV
/Users/andy/Documents/data

X1sx[*]

/Users/andy/Documents/*.x1
sx[data*]

Note:

Description

All files with extension .csv in the
Documents folder

All the files with name 'd' plus a
single character in the Documents
folder

All the sheets in data.xlsx in the
Documents folder

All the sheets beginning with 'data’
in all the xslx files in the Documents
folder

e If there is more than 1 input column on a row that specifies multiple files or
sheets, then an output will be created for each possible permutation of
input files/sheets in the row. E.g. 3 input files from column 1 x 4 sheets from

column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

e Batch processing will ignore files in sub-folders. Add them as extra rows.

e All the files input to an input item or output from an output item should be

the same file type as the original.

In the output column(s) you can use the file name variables to dynamically
change output file names based on input file names.

You can write to multiple sheets of an Excel file.

This example shows using a wildcard for the input file name and sheet and file
name variables to set the output file name based on the input file with alias

sales:

Input alias=sales
1/C:\Users\andy\batch\* xIsx[*]

Output alias=output (Overwrite)

. |C:\Users\andy\batch\output\{sales.fname} xlsx[{sales.sheet}]
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But make sure to set the corresponding output Write
mode=0Overwrite/Sheet.

Click Process to start processing the rows.
Click Stop to stop processing the rows.

Check make a sound on completion if you want to play a sound when all
processing is finished.

Click Close to close the window.

Note:

e Whether an output file is created, overwritten or appended to depends on
the Write mode of the output item.

e We recommend you output to a different folder than the one the input files
are in.

See also:

¢ Video: Batch processing

e Batch processing examples
e Command line arguments

2.21 Command line arguments
-

Easy Data Transform accepts the following command line arguments:

Argument Description

<file name> The .transform file to open at start-up.

-build Output the Easy Data Transform build time and
date.

-cli Close the application once any processing on the

opened file is complete.

-log <location>  Appends the command line output to the file at
<location>. -cli must also be set.

—file . Sets the input or output file with the given alias

iallas>:<locatlon to the location (path) specified. Input Excel files
should include the sheet name, e.g.
file.xlsx[sheet]. Output Excel files may
optionally include a sheet name. The file type
should be the same as the original.
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Argument Description

-new_window Don't load the last opened .transform file, even if
open previous file at start-up is checked in
Preferences.

-verbose Output additional information to the terminal.

Useful for debugging problems.

-version Output the Easy Data Transform version number.

This allows you to run Easy Data Transform from the Mac Terminal or a script.
For example:

Torun /Users/andy/Documents/myfile 1.transform with the
output with alias output1 output instead
to /Users/andy/Documents/datal.csv:

/Applications/EasyDataTransform.app/Contents/MacOS/Easy
DataTransform '/Users/andy/Documents/myfile
l.transform' -file
'outputl=/Users/andy/Documents/datal.csv' -cli -verbose

Torun /Users/andy/Documents/myfile2.transform with the input
with alias inputl input instead from sheet sheet1l
of /Users/andy/Documents/data 2.xlsx:

/Applications/EasyDataTransform.app/Contents/MacOS/Easy
DataTransform /Users/andy/Documents/myfile2.transform -
file 'inputl=/Users/andy/Documents/data 2.xlsx[sheetl]'
-cli -verbose

Use wildcards to transform multiple files in a folder:

for £ in in*.csv;

do /Applications/EasyDataTransform.app/Contents/MacOS/E
asyDataTransform
'/Users/andyb/Dropbox/cli/cli.transform' -file cli-
in=$f -file cli-out=out-$f -cli -verbose; done

Use file name variables to dynamically change output file names based on
input file names.

You can also use the Mac 'open’ command:
open /Applications/EasyDataTransform.app —--

args /Users/andy/Documents/myfile\ 1.transform -file
outputl=/Users/andy/Documents/datal.csv -cli
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open /Applications/EasyDataTransform.app --
args /Users/andy/Documents/myfile2.transform -file
'"inputl=/Users/andy/Documents/data 2.xlsx[sheetl]' -cli

But note that no command line output is shown if you use 'open’.

Put single quotes (') around any arguments with spaces or a backslash (\) in
front of each Space (as shown in the examples above).

Input and Output items are referenced by their Alias field value.

|nutput.csu | = d;‘ | E:

(%) Output to file.

write header

(Alias: output )

If you are using relative (rather than absolute) locations (paths) for input or
output files, these will be relative to the folder the current working folder.

If you are using wildcards, then it is usually a good idea to output to a
different folder to the one that you are inputting from.

Select File>Command Line... to show sample command line text which you
can copy and modify. It will also warn you of potential issues.

To run on a schedule, call the command line interface (or a script file that calls
the command line interface) from a scheduling program, such as launchd.

See also:
e Batch processing
e Run jobs on a schedule

2.22 .transform files
1

.transforms file are stored in a simple XML format. So you can edit them with a
standard text editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are
recalculated whenever you File>Open... the file.
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The contents of Input and Output files are not stored in the .transform file,
only their locations (paths). These locations are stored as 'absolute’ locations,
so you can move the .transform file without changing the locations of the
Input and Output files.

If you open a .transform file in a different location from that in which it was
saved and it can't find Input and Output files at the expected absolute
locations, it will look for them in the same location relative to the old
.transform file. This allows you to easily move .transform files to different
locations and computers if you keep the Input and Output files in the same
relative location (e.g. in the same folder as the .transform file). This even
works between Windows and Mac.

Example:

e mytransform.transformisin C:\Users\andy\Documents\ on
Windows processes Input file MyData . csv in sub-folder MyData (C:
\Users\andy\Documents\Data\MyData.csv).

e mytransform.transformis moved to /Users/Bob/Documents/EDT
on a Mac.

e When mytransform. transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

e If it can't find that it will look for MyData . csv in sub-folder MyData
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We
don't recommend you do this for large datasets as XML is not very efficient
for storing large amounts of data.

2.23 Limits
1

Easy Data Transform has the following hard limits:
Maximum number of characters in a value (cell): 2230 (1,073,741,824)

Maximum number of columns in a dataset: 2428 (268,435,456)
Maximum number of rows in a dataset: 2/28 (268,435,456)

You will probably run out of memory before you get anywhere near the
column or row limits.

2.24 Memory usage
|

Easy Data Transform keeps all the data in memory for maximum performance.
You can track the current memory usage in the Status bar.
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@emnry usage: 2% of 1'1“3@ =l £ 3 4] Email us questions/feedback

Set Maximum memory usage in Preferences to the maximum amount of
memory you want the Easy Data Transform process to use. If this is exceeded,
you will be asked if you want to allocate more memory. It is generally not
recommended to set this to more than the system RAM, otherwise Easy Data
Transform will start using virtual memory (paging between RAM and disk),
which is slow. The operating system can also crash or freeze if all the available
virtual memory is used.

If Optimize processing for is set to Minimum memory use in Preferences
then memory compression techniques are used to try to reduce the amount
of memory required. This is generally recommended, as not using memory
compression may use up all the RAM available and start using virtual memory
to page between RAM and disk, which is likely to be a lot slower than the
compression overhead.

2.25 Data security
|

As Easy Data Transform can potentially read or write any file on your

computer, to which you have read/write permission, you need to be careful

not to run .transform files of unknown provenance until you have checked

them. Otherwise they could accidentally or maliciously read or write files that

you don't wish to be accessed. To this end we recommend:

¢ Not setting Opening a .transform with auto run to Leave auto run
enabled in Preferences>General, so that you can check any .transform files
you aren't sure about, before running them.

¢ Setting Block input from files with extensions in Preferences>Input
Extensions to any file extensions of any file types that Easy Data Transform
shouldn't be reading from.

¢ Setting Block output to files with extensions in Preferences>Output
Extensions to any file extensions of any file types that Easy Data Transform
shouldn't be writing to.

2.26 Portability
|

By default Easy Data Transform stores your preferences in macOS
Library/Preferences. However you can store your preferences in an
easydatatransform.ini file in the same folder as the Easy Data Transform .app
file. This means you can install Easy Data Transform on a device without
admin access. It also allows you to store everything on a portable device, such
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as a USB memory stick. You can even move your portable device between
Windows and Mac computers.

To use Easy Data Transform portably:

e Install Easy Data Transform into an appropriate folder on the portable
device. Make sure you have write permission to the folder.

e Start Easy Data Transform.

e Open the Preferences window.

¢ In the General tab set the Store these preferences in field to portable .ini
file.

e Click OK.

e You may also wish to copy your .transform files to the portable device.

If you change the folder your portable version is installed in (e.g. you install a
new version to a different folder) you should copy across your
easydatatransform.ini file to the new folder.

If you move your portable device from one computer to another (e.g.

Windows to Mac) the location (path) of files may change (e.g. from D:
\my usb key\my transform.transform

to /Volumes/my usb key/my transform.transform). Easy Data

Transform will try to be intelligent about handling these changes of location

by:

e storing recent .transform file locations as relative rather than absolute
locations

¢ by treating relative .transform locations as relative to the Easy Data
Transform .app file.

It is possible to have Windows and Mac versions of Easy Data Transform on
the same device sharing a single easydatatransform.ini file and common input,
output and .transform files. Just make sure you install the Windows .exe and
Mac .app into the same folder. We also recommend that they are the same
version of Easy Data Transform.

If you have problems installing Easy Data Transform to a USB key see Mac
Install Troubleshooting.

For the purposes of licensing, installing to a USB key, or other portable device,
counts as one of your 3 allowed installs.

Note If you install Easy Data Transform Windows .exes or Mac .apps into 2

different folders and set them to use .ini files, they will each store their
preferences in their own .ini file.
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2.27 Dark mode

Select View>Toggle Ul Theme (or the corresponding status bar button) to
swap between light and dark user interface themes. You can also change the
Center color scheme in the Colors tab of the Preferences window.

Ceenpara Cols
Cancat Cols

Concat Rows
Copy Cols

Count

Date For

2.28 Keyboard shortcuts

1983 10

1984 N

1889 38

Email us questions/feedback

Using keyboard shortcuts can improve your productivity. If you are using Easy
Data Transform a lot we suggest you find the time to learn at least some of
them. The following keyboard shortcuts are available for the Mac version of

Easy Data Transform:

Key
A

Shortcut

Cmd+A

Cmd+B

Cmd+C

Cmd+Shift+C

Cmd+D

Action

Select all in Center
pane.

Show the Batch
Process window.

Copy selected data with
header from the Right
pane.

Copy selected data
without header from
the Right pane.

Duplicate the selected
branch in the Center
pane.
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Key

Shortcut

Option+D

Ctrl+F

Ctrl+Cmd+F

Option+H

Option+I
Option+Shift+I

Cmd+K

Cmd+L

Option+M

Cmd+N

Cmd+0O

Cmd+Shift+0

Option+O

Cmd+R

Cmd+Shift+R
Cmd+S

Cmd+T

Action

Compare the data of
items selected in the
Center pane.

Find items that match a
search term in the
Center pane.

Toggle setting Right
pane item to fullscreen.
Only works if 1 item in
Right pane.

Compare the headers
of items selected in the
Center pane.

Input From File.
Input From Clipboard.

Search transforms by
keyword.

Toggle the Log pane
visibility on/off.

Toggle cursor
magnification for
Center pane on/off.

New .transform file.
Open .transform file.

Show the Open Recent
window.

Output To File.

Run unprocessed items
[4].

Run selected items [4].
Save .transform file.

Toggle two screen
mode on/off
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Key

Space

Backspace

Easy Data Transform © 2025 Oryx Digital Ltd

Shortcut

Cmd+U

Cmd+27

Cmd+Shift+Z

Space

Backspace

Cmd+.

Cmd+;

Cmd+,

Cmd+=

Cmd++
Cmd+-

Option+|

Option+]

Cmd+\

Cmd+/

Action

Toggle user interface
between light and dark
themes (if available).

Undo
Redo

Show the Value
window for the current
value in the Right pane.

Delete selected item(s)
in Center pane.

Toggle the Timing
Profile on/off.

View the Item
Summary window.

Show Preferences
window.

Zoom Center pane so
all items fit.

Open or close the Data
Preview window when
hovering over an item
in the Center pane.

Zoom Center pane in.
Zoom Center pane out.

Move keyboard focus
to Center pane.

Move keyboard focus
to Right pane.

Stop processing.

Zoom to selected items
in the Center Pane.

Open or close the Data
Preview window when
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Key

Left arrow

Right arrow

Up arrow

Down arrow

1.9

F1
F5
F8

F9

F10

[1] Highest=nearest the top of the Center pane.
[2] Lowest=nearest the bottom of the Center pane.

Shortcut

Cmd+Left arrow

Cmd+Right arrow

Cmd+Up arrow

Cmd+Down arrow

Cmd+1 ... Cmd+9

Cmd+Shift+1
Cmd+Shift+9

Fl
F5

F8

F9

F10

Action

hovering over an item
in the Center pane.

Move Center pane
selection from item to
highest[1] item that
inputs to it.

Move Center pane
selection from item to
highest[1] item that it
outputs to.

Move Center pane
selection from item to
highest[1] sibling[3].

Move Center pane
selection from item to
lowest[2] sibling[3].

Select input item 1to 9
(based on height in
Center pane).

Select output item 1 to
9 (based on height in
Center pane).

Show help.
(Re)process all [4].

Show options and data
in the Right pane.

Show only options in
the Right pane.

Show only data in the
Right pane.

[3] Two items are considered siblings if they have inputs from the same
item(s) or they both have no inputs.
[4] If Run>Auto Run is unchecked.
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You can also use the keyboard to add transforms in the Center pane. Just
select the item(s) you want to add the transform to and start typing the name.
Only eligible transform that contain the typed letters will be displayed (spaces
are ignored).

For example, to add the Rename Cols transform an existing Input item:

e select the input items

e type ren

e press the Return key

If you want to see a list of all the transform names, press the Space key
before you start typing. You can use the Del or Backspace key to undo
letters typed.

You can quickly change selection in the Center pane using arrow keys with
the Cmd key.

[ Left Arrow ] [ Up Arrow ]
Y

JRemove Cols

Dedupe l ———

4 aols x 209 rows I ng ht Arrow

4

4 ools x 14.7k rows

Pivot

2 als x 210 rows

L/ Sort

2 als x 210 rows

v Spread

104 cols x 209 rows

[ Down Arrow J

If you are zoomed in you can scroll the Center pane by pressing the shift
key and dragging the canvas.
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3 How do I?

3.1 Add atransform between existing items

To add a new transform between existing items (e.g. between 2 already
connected transforms) see connections.

3.2 Add metadata to a dataset

You can add meta data to an input dataset by setting the Meta info field. See
meta information for more information.

10k.csv 5 Qﬁ

@ Input from file.
File: DAEDT data\CSV\10k.csv

Ignore: . v row(s)

€ Meta Information X

| $(FilePath) ${CurrentDateTime]‘l Clear

b

Insert: <select>

OK Cancel = Help

™

Meta info: At start
Alias: 10k

Data Characters Warnings ® Info Comment Details

14 cols x 10,001 rows @) Read
MER SO HHE Y Y E RN

Regiofn ca
1 D:\EDT data\CsSv\1lOk.csv 2022-12-05T09:30:29 ]

3.3 Add missing data values
-

You can add missing values (based on the average (mean), median or mode of
non-empty values) using the Impute transform.
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For example you can add missing ages for Titanic passengers based on the
average age supplied for the other passengers:

Pclass Sex Age SibsSp Parch |+ E
21 2male 35 0 0 !
224 2 male 34 0 0
23 3 female 15 0 0
24 1 male 28 0 0
25 3 female 8 3 1
26 3 female 38 1 5]
2 3male 0 0
28 1 male 19 i 2
29 3 female 0 ol
30 3 male 0 0
31 1l male 40 0 0 ;
Impute OC' = ESI

@ Infer values of missing data.
E] Q Filter columns
Pclass

Sex

Age

v 9

1 of 9 columns selected

Using: Average v
Of:  All rows v
Pclass Sex Age SibSp Parch ‘!
21 2male 35 0 0
22 2male 34 0 0
23 3 female 15 0 0
24 lmale 28 0 (4]
25 3 female 8 3 1
26 3 female 38 1 4
27 3male 29.6991176471 0 0
28 1 male L) I 2
29 3 female 29.0991176471 0 0
30 3male 29.6991176471 0 0
sht lmale 40 0 oy

See the Impute transform documentation for more details.
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See also:

¢ Video: How to impute missing data
e Replace empty values

e Profile a dataset

3.4 Addorremove a header
1

To add or remove a header just check or uncheck the has header checkbox
for the appropriate input item.

vaccination.csv @ CF v

File: /Usersfandyb/Desktop/vaccination.csv

L4

Type: Delimited text

Delimiter:  Automatic L+
Quoting: Automatic C
Encoding: Automatic e
Ignore: First O row(s) 2
+ has header
espace
+ simplify whitespace
+ ignore empty rows
watch file

Meta info: Mot added &

Alias: vaccination
Data Warnings Info Comment Results

3 cols x 5,780 rows

ClB|£||® Show first 10 rows £
country time becg_vacc

You can also make the first row of your dataset into a header using the
Header transform.

3.5 Change a connection
|

To change a connection see connections.

3.6 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a
guess at the encoding. You can explicitly set the encoding by selecting an
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input item and changing Encoding from Automatic to one of the other
encodings in the Right pane.

. . KA
vaccination.csv @ tf'} ]

File: /Usersfandyb/Desktop/vaccination.csv

Type: Delimited text
Delimiter: Automatic
Quoting:  Automatic

Encuding‘.

Ignore: First O row(s)

<> << <)

Similarly you can also set the encoding of a text file output by selecting the
output item and changing Encoding in the Right pane.

output.csv @ {‘? E:

File: fUsers/andyb/Desktop/output.csy

Type: Delimited text
Delimiter: Comma (,)
Quoting:  As needed

Line endings: Automatic

Encmiin

Byte Order Mark

OO 6

See also:
e Video: How to change CSV file text encoding

3.7 Clean a dataset

Data is often 'dirty' and needs to be cleaned up before further processing.
You can quickly find unwanted characters by looking in the Characters tab of
the Right pane to see what types of characters occur in which columns.
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Data Warnings @Info Comment  Details
Sample: All 29 rows © W show bars

SupplierlD CompanyName ContactName ContactTitle Address City Region PostalCode

Uppercase 80 60 61 64 33 95 18
Lowercase 408 293 428 347 185 24

Digit 49 81 124
Dot 9 2 12

Colon

Apostrophe 6 2

Dash 2 1 5 2 2

Forward Slash

Other 3 1

Non-ASCI| 2

Space 51 32 32 74 2 7
Leading Space 1

Trailing Space 1

Double Space 1

Note that some of these categories are non-exclusive. For example: a Space
might be counted as a Space, whitespace and a leading Space, and a symbol
might also be a non-ASClI character.

Hover over a cell for more details.

h‘ 2

2 Non-ASCI| character(s) out of 559 character(s)

sampled from all row(s) in column 'CompanyName' (0.36% of all).
Examples:

Row 19: New England Seafood Cannery ¥

You can turn the colored bars off.
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Data Characters Warnings @Info i

Sample: All 29 rows * show bars |

SupplierlD CompanyName

Uppercase 80
Lowercase 408
Digit 49

And you can restrict it to sampling only a subset of rows for improved speed
in large datasets.

Data Characters =~ Warnings (D Info  C

LI 1,000 rows V' show bars
10,000 rows
100,000 rows

All 500,000 row
Lowercase y 71,267 7,033

ountry Item Type

Upperc 1,252 1,250

You can use the Characters tab in conjunction with the Replace and
Whitespace transforms to quickly clean your data. Replace can easily remove
non-ASCIl, symbols etc by replacing them with nothing:
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Replace o d e
@ Replace multiple text in the selected column(s).
E Q Filter columns

N, N;me

Customer Id
Product Id

1 of 5 columns selected

® 1TV ®E & X

(—Matchlyh Replace With
Text

Exact text
\ Regex

Empty

73]

Warnings Info L »
@) No changes
Il < 22T D

- Punctuation :

Letters

g . .
L Digits

Symbols Customer|d  Product Id *

[l Whitespace C018930 1357

v
4 Currency »

Non-ASCI| k|

See also:

e Video: How to clean data
e Add missing data values
e Profile a dataset

e Match dirty data
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3.8 Compare datasets
I

Comparing headers

To compare headers between 2 or more datasets:

e Select 2 or more items in the Center pane

¢ Select View>Compare Headers..., use the right click menu or Option+H.

- ] . Compare Headers

Compare headers by:  Column name Show: All

Column differences: 4

Column Name Index(es) in ‘meteorites-new.csv’ Index(es) in ‘Meteorite-Landings.csv'
GeoLocation 8 10
YEAR 10

fall 6 6
id 2 2
mass (g) 5 5
name 1 1
nametype 3 3
recclass 4 a
reclat 7 8
reclong 9 9
year 7

Differences:

Notes:

e Set Compare headers by to compare by Column name or Column index
(position).

e Comparing by Column name is sensitive to case and whitespace.

¢ Set Show to show All, Only matches or Only differences, depending on
the rows you want displayed.

e Differences are shown colored. Missing headers are shown hatched.

e Click the color button to change the difference color.

Comparing data

To compare the data in 2 datasets:

e Select 2 items in the Center pane

¢ Select View>Compare Data..., use the right click menu or Option+D.
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o ® Compare Data

Compare rows by:  Row numbers Show: Al

Row differences: 195
Header differences: 0

'meteorites.csv’, [d=486, 10 cols x 45,716 rows 'meorites-modified.csv', 1d=48, 10 cols x 45,716 rows

- name id r name id 1
23 Alby sur Chéran 458 T 23 Blby sur Chéran 458
24 Aldsworth 461 % 24 Rldsworth 461
25 Aleppo 462 % 25 Rleppo 462
26 Alessandria 463 1 26 Rlessandria 463
27 Alexandrovsky 465 1 4 27 Rlexandrovsky 485 '
28 Alfianello 466 || |28 Alfianello 467 °
29 Allegan 2276 % L 29 Allegan 2276
30 Allende 2278 © < 30 Allende 2278
31 Almahata Sitta 48915 <hl Almahata Sitta 48915

synchronize vertical scroll synchronize horizontal scroll Differences: -

Notes:

Set Compare rows by to:
o Row numbers to see a row-by-row comparison of the 2 datasets.
o Key columns to see a comparison by key values in each dataset.

» Set the Key column for left and right datasets.

= Check Sort by key to sort the keys in ascending order.

» Check case sensitive to make the key comparison case sensitive.
Set Show to:
o All to show all rows.
o Only matches to show only rows that are the same in both datasets.
o Only differences to show only rows that are different in both datasets,
Differences are shown colored. Missing rows are shown hatched.
An overview of the differences by row are shown on the left when Show is
set to All. You can click or drag this overview to navigate.
Click Top to scroll to the top of both datasets.
Click Previous row difference to go the previous row with a difference.
Click Previous difference to go the previous cell with a difference.
Click Next difference to go the next cell with a difference.
Click Next row difference to go to the next row with a difference.
Click Bottom to scroll to the bottom of both datasets.
Click Swap to swap the left/right positions of the two datasets.
Check synchronize vertical scroll to make vertical scrolling in one pane
mirrored in the other pane.
Check synchronize horizontal scroll to make horizontal scrolling in one
pane mirrored in the other pane.
Click Differences to change the color used to highlight differences.

See also:
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e Video: How to compare Excel sheets
e See changes from a transform
e Match dirty data

3.9 Convert to percentages
|

You can convert to percentages using the Scale transform.

Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale d:’ B Eﬂ

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Item
v Di.s.pgted

1 of 2 columns selected

4)

Scale to : 100
Using:  Sum v

Of: All values v

‘

ltem Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions | 20.5633113897
3 Unknown 13.6227590823
4 Delivery & Installation 13.0305037981
5 Service Delivery 2.8524001673

6 Technical Issues 0.6425123193
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3.10 Dedupe a dataset
I

There are 2 transforms for removing duplicate rows from datasets:

e Dedupe removes duplicate rows, keeping only the first row in each group
that it considers to be duplicates of each other.

¢ Unique creates a single aggregate row from each group that it considers to
be duplicates of each other.

Dedupe is simpler. Unique has more flexibility.
Using Dedupe

To keep only the first row with each Customer Id from this dataset:

Name CustomerId Productld Cost Date
1 Alice Anderson C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones |C[I1??83 96352 19.95 02/10/2020
4 Robert Brown C018917 98526 10.00 02/10/2020
5 Charles Jones 'C017783 28746 25.00 03/10/2020

To get this dataset:

Name Customer|ld Productld Cost Date
1 Alice Anderson |C018930 13574 29.95 01/10/2020
2 Bob Brown c018917 89456 10.55 01/10/2020
3 Charlie Jones \C[ﬂ??ES 96352 19.95 02/10/2020

Drag the dataset file onto the Center pane of Easy Data Transform. Then click
the Dedupe transform in the Left pane.
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0dea::]U|:-E—E:w:an’1... © Dedupe

5 cols x 5 rows 5 cols x 3 rows

Then check the Customer Id column in the Right pane.

KA
Dedupe rod ¢y

@ Remove duplicate rows by matching values in al...

Explore Duplicates...
E Q Filter columns :
b
Name =
. 3
' ;
Customer Id .
v
Product Id .'
Cost ,'
T Y b II
1 of 5 columns selected :
Matching: Exact M
v case sensitive
ignhore whitespace

ighore punctuation '

Mode: Remove duplicates v

Only the first row with each Customer Id is kept. Use Sort if you want to
change the order before the Dedupe transform.

If you only want to remove rows with the same Customer Id and Product Id,
check both the Customer Id and Product Id columns.
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If you want to use fuzzy matching to also remove rows that are similar, but
not identical, set Matching to Fuzzy.

To see what rows will be removed and experiment with different options, click
the Explore Duplicates... button.

€ Explore Duplicates O X
Columns to match: Matching: 'Exact v
E Q Filter columns .
vV case sensitive
Name =
ignore whitespace
v Customer Id ignore punctuation
Product Id -
4 3

1 of 5 columns selected

> 0O Found 3 non-duplicates and 2 duplicates in <0.1 seconds

Data Summary

hide unchecked columns hide rows with no duplicates + T
Name Customer |d Productld Cost Date Grou
1 Alice Anderson  C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Robert Brown C018917 98526 10.00 02/10/2020
4 Charlie Jones C017783 96352 19.95 02/10/2020
5 Charles Jones C017783 28746 25.00 03/10/2020
| 3
OK Cancel

Note that Dedupe takes account of whitespace. So you might need a
Whitespace transform before the Dedupe transform.

See also the Dedupe documentation.
Using Unique

To aggregate all rows with the same Customer Id:
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Name Customer |ld Productld Cost Date
1 Alice Anderson |C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones |CD1??’83 96352 19.95 02/10/2020
4 Robert Brown C018917 98526 10.00 02/10/2020
5 Charles Jones C017783 28746 25.00 03/10/2020

To get this dataset with:

e The first Name for that Customer Id

e A Comma separated list of Product Ids for that Customer Id
¢ The total Cost for that Customer Id

e The last Date for that Customer Id

Name Customer Ild Product Id Cost Date
1 Alice Anderson  C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456,98526 20.55 02/10/2020
3 Charlie Jones C017783 96352,28746 44.95 03/10/2020

Drag the dataset file onto the Center pane of Easy Data Transform. Then click
the Unique transform in the Left pane (if you can't see Unique, then check
show advanced is checked in the Left pane).

dedupe-exam... Unique
o ——o

Scols x5 rows 5 cols x 3 rows

Then set the Unique options as shown below:
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Unique I:f} = E;

@ Aggregate rows with unique values in selected c...

Column Option
Name Keep first v
Customer Id Keep unique ht
Product Id Concat v
Cost Sum v
Date Keep last v
Set All ¥ to Keepunique ¥

'Keep unique' for 1 of 5 columns
Concat delimiter: ,

add count column

One aggregated row is created for each Customer Id. Use Sort if you want to
change the order before the Unique transform.

If you only want to create a new aggregate row for rows with the same
Customer Id and Product Id, set both the Customer Id and Product Id
columns to Keep unique.

Note that Unique takes account of case and whitespace. So you might need a
Case or Whitespace transform before the Unique transform.

See also the Unigue documentation.

See also:

¢ Video: How to remove Excel duplicates

e Video: How to merge rows in Excel

¢ Video: How to clean, merge and scrub email lists

3.11 Duplicate a series of transforms
|

To duplicate multiple items in the Center pane (e.g. a sequence of transforms)
right click on the first item and select Duplicate Branch.
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covid-data.xksx
] [Easy Data Transf...

9 cols x 14.7k rows

I Lookup Unigue _ Remove Cols o "esu Its.csv
| Show fullscreen F11
10 cols x 14.7k rows lﬂul 3 cols x 206 rows
@ Help

F1
Input »
country-codes.csv Transform »
2 cols x 205 rows Qutput »
Note
Copy Data

Duplicate Branch

&), Zoom Selected Ctrl+/

¢

covid-data.xkx
o [Easy Data Transf..

9 cols x 14.7k rows

Lookup — e Unigue ° Remove Cols results.csv

10 cols x 14.7k rows 10 cols x 206 rows 3 cols x 206 rows 3 cols x 206 rows

country-codes.csv

2 ools x 205 rows

Unique Remove Cols results.csv
10 cols x 206 rows 3 cols x 206 rows 3 cols x 206 rows

3.12 Find the difference between dates/datetimes

You can calculate the number off days difference between two dates using
the Calculate transform. For example:

Easy Data Transform
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Start End
1 31/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

‘

Calculate % | = 3 g

@ Perform calculations on 1 or 2 columns to create a new c...
v automatic new column name
Operation: - Subtract >
Value 1 type: Column v
Value 1: ? End v
Value 2 type: Column >
Value 2: ? Start =
Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

You can convert a datetime into a date using a transform such as Extract.

Alternatively, you can calculate the difference between two dates or
datetimes using Date objects in the Javascript transform.

There are 4 ways to create a Javascript Date object:
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Date format Description

new Date (year, month, day, Specified date and time specified as
hours, minutes, seconds, numeric parameters (January is

milliseconds) month 0).
new Date (text date) Date and time specified as text.
new Date (milliseconds) Milliseconds after 1st January 1970.
new Date () Current date and time.

Notes:

e A text date should be in yyyy-MM-dd format.

o A Date object always includes a time. If no time is set, then the time is
assumed to be midnight GMT.

e One and two digit years will be interpreted from 1900.

Examples

To calculate the number of milliseconds between a date in the 'date' column
and 31st Dec 2000:

return new Date( $(date) ) - new Date( "2000-12-31" );
Or:
return new Date( $(date) ) - new Date( 2000, 11, 31 );

To calculate the difference between datetimes in the 'start' and ‘end' columns
in hours:

return ( new Date( $(end) ) - new Date( $(start) ) ) /
( 60 * 60 * 1000 );

To calculate how many days ago 'date’ occurred (rounded down):

return Math.floor( ( new Date() - new Date( $(date) ) )
/ (24 * 60 * 60 * 1000 ) );

For more information see the Javascript documentation.
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3.13 Handle column name/order changes in inputs
-

If you have a .transform file that you want to run multiple input files through
(perhaps with a different input file each month, via the command line from a
script, or as a batch process) you need to be aware of differences in column
name and column order in the input files.

To change the file being used by an input, select the input item and change
the file location in the Right pane (e,g, by clicking the "..." browse file button).

Columns in the same order, but with different names

Easy Data Transform references columns in inputs by their position (e.g. 3rd
column from the left) not their column name. So differences in column names
(e.g. first column is called "id" in input 1 and "UniquelD" in input 2) are not
generally an issue. But you need to be careful if you are using the Stack
transform with Align columns by set to Header name, as this will reorder
columns by name. If you want to always output the same column names,
regardless of the input column names, you could use a Rename Cols
transform to set the column names explicitly.

Columns with the same names, but in a different order
Use a schema for the input.

Columns with the same names, but with one or more

columns missing
Use a schema for the input.

Columns with the same names, but with one or more

extra columns
Use a schema for the input.

Columns with different names, in a different order

Easy Data Transform can't handle this automatically. But you can create a new
.transform and use Reorder Cols and/or Rename Cols transforms to output to
a new file with the correct column names/ordering. You can then input this to
the original .transform.

3.14 Handle datasets with many columns
|

Easy Data Transform can help you to easily remove or rename columns in
datasets with large numbers of columns.
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Find columns by filtering

If there are large numbers of columns, you can quickly find the column you
want by clicking the filter button and typing some characters from the column
name.

Check/uncheck multiple columns by criteria

If there are multiple columns, you can check or uncheck them by various
criteria in the Select Columns window. For example it can check or uncheck
all the empty columns.

[Case | % ||F||BB|[2T

(?) Change the case in the selected column(s).

E IEQ Filter columns

[ ] ] Select Columns
Check columns where  Celumn name contains provider| case sensitive
308 columns match

308 columns will be checked :

Provider Organization Name (Legal Business Name)
Provider Last Name (Legal Name)

Provider First Name

Provider Middle Name

Apply Close

Remove multiple empty columns
If your dataset has a large number of empty columns you can remove them
by checking ignore empty columns when you input it.

orders.xlsx[orders] F||E|| 2

(2) Input from file
File: wdyb/Dropbox/EDT_datajorders.xlsx[orders)

[ 4]

Type: Excel XLSX

<3

Ignore: First 0 row(s)
+ has header
+ trim whitespace
' simplify whitespace
v ignore empty rows

v ignore empty columns

watch file
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Remove multiple columns

To quickly remove a large number of columns using the Remove Cols

transform, you can filter by column names. For example, to remove the

columns with names that contain "id":

¢ Add a Remove Cols transform.

e Type id into the filter field. All the columns whose names contain "id"
should now be visible (not case sensitive).

e Click the Unselect all button.

e Click the Clear button.

All the columns whose names contain "id" should now be removed by the

transform. You can repeat this process as often as needed.

KA
Remove Cols o d i

@ Uncheck tE column(s) you wish to remove

('Cl id] %)

OrderlD

CustomerlD

EmployeelD

Rename multiple columns

To quickly rename a large number of columns using the Rename Cols

transform, use Replace text:

¢ Add a Rename Cols transform.

e Click the Replace text button.

e Enter the text you want to Replace and the text you want to replace it
With. You can match as Text, Exact text or Regex, with case sensitive
matching optional.

e Click Apply to make the change.

e Click Close.
L Replace Rename Cols Fedll==
(?) Rename column headers.
Match type: iti .
YP! Text B case sensitive l c
Replace: ID Old name New name
‘s
With: Id OrderlD Orderld
| Preview: Changes applied CustomeriD Customerld
F EmployeelD Employeeld
Close A
OrderDate OrderDate
14
See also:

¢ Handle large datasets
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3.15 Handle large datasets
-

Large datasets (e.g. with millions of rows) can slow down processing. If slow

processing is a problem you can:

e Add a sample transform straight after the input and set Rows to pass
through only the first 100 or so rows. Once you have completed all your
transforms you can then Disable sampling to pass through all rows.

¢ Set Maximum memory usage to a higher value in the Preferences window,
to ensure you don't run out of memory.

¢ Set Optimize processing for to Minimum memory use in the Preferences
window, to reduce memory usage.

e Uncheck Run>Auto Run to give yourself full control over processing.

[ NN
Dﬁmlﬁl >l O

or
e Check Run>Auto Run and:

o Set Right pane processing delay in the Preferences window to a longer
time (say 5 seconds) to ensure that changes aren't processed until you
have finished making the changes.

o Set Write mode to Disabled in output files, until you are ready to write
them.

You can check View>Timing Profile to see where the processing time is

being spent.
[ |
° 10k.csv
14 cols x 10k rows
B ] T ] ] ] =
Stack o Filter o Sort o output.csv
14 cols x 110k rows 14 cols x 81.5k rows 14 cols x 81.5k rows 14 cols x 81.5k rows
[
° 100k.csv

14 cols x 100k rows

Or select View>Item Summary... and click on the Processing column header
to sort by processing time,
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@@ A Q@ e @& e H ® ¥ How Do I? @

[ ] @ Item Summary
G &

Id Type v Name Upstream Upstream Ids Downstream  Downstream Ids | Columns Rows Status Processing Result
1 45 Transform Replace 1 33 1 36 5 209 @ Upto date 0.009 No changes
2 39 Transform Num Format 1 38 1 40 6 155 Up to date 0.006 No changes
3 38 Transform Filter 1 37 1 39 6 155 @ Up to date 0.008 54 rows ...
a 37 Transform Sort 1 36 1 38 6 209 @ Up to date 0.000 No changes
5 36 Transform Javascript 1 45 1 37 ] 209 Up to date 0.020 209 evaluate...
6 33 Transform Join 2 26,32 1 45 5 209 & Up to date 0.006 209 rows ...
7 32 Transform Dedupe 1 16 1 33 4 209 @ Up to date 0.022 14,449 rows ...
8 30 Transform Sort 1 29 0 2 99 @ Up to date 0.001 Sorted
] 29 Transform Count 1 26 1 30 2 99 @ Up to date 0.006 99 counted ...
10 26 Transform Sort 1 24 2 29,33 2 210 @ Up to date 0.002 Sorted
n 24 Transform Pivot 1 16 1 26 2 210 @ Up to date 0.057 Pivot table ... ¢
12 20 Transform Spread 1 16 0 104 209 @ Up to date 0.066 100 cols ..
13 16 Transform Remove Cols 1 15 3 20,24,32 4 14,658 @ Uptodate 0.029 7cols ...
14 40 Output output.xlsx 1 39 0 Error 0.018 Error writing
15 44 Note

______________ Inputs: 1, Transforms: 13, Outputs: 1, Notes: 4

See also:

e Handle datasets with many columns
e Manage a large number of Center pane items

e Processing

3.16 Input a fixed width format file

To input data from a fixed width file see fixed width format.

3.17 Manage alarge number of Center pane items
|

Large .transform files can have 100+ Input, Transform, Output and Note items

in the Center pane. There are various techniques you can use to keep this

manageable:

¢ Place items in conceptual groups with space between. Use Note items to
describe the purpose of the group.

Try to avoid connections crossing items and other connections where
possible.

Set Edit>Snap To Grid on to make it easier to keep items neatly aligned.
Select View>Show Tool Tips>Detailed, so that you can see detailed
tooltips when hovering over an item.

Add comments in item Comment tabs. You can see these in tooltips when
you hover over the items. You can also select View>Show Comments to
show them on items.
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e Hover your mouse over an item in the Center pane to highlight the
connections to and from it.

e Hover your mouse over a connection in the Center pane to highlight the
items at either end.

e Hover your mouse over a transform button in the Left pane to highlight all
buttons of that type.

¢ Select View>Magnify Cursor to magnify items while zoomed back.

O QR G

® "How Do I? @

o Spread

deaths by date

106 cols x 2Bk rows

1
Vi_ nedupe

Trin

e Select View>Find Items to select items in the Center pane that match one
or more search terms.

# ®  vHwDoR @

[ ] Find Items

Find: (O date]

),

In: names ids f comments optionvalues columnnames  data values (slow)

of: B nputs @ Transforms @ Outputs [ Notes

Options: zoom selected case sensitive

Find items matching “date" IN names OR comments

Select All Select Next Select Previous

Close

e Get an overview of all the Center pane items in the Iltem Summary window
by selecting View>Item Summary... .
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O v~ 0 @aaaaF ®  vrwoor | @

® ® Item Summary
HE
Id Type v Name Upstream Upstream Ids Downstream  Downstream Ids | Columns Rows Status Processing Result
1 45 Transform Replace 1 33 1 36 5 209 @ Up to date 0.009 No changes
2 39 Transform MNum Format 1 38 1 40 6 185 Up to date 0.006 No changes
3| 38 Transform Filter 1 37 1 39 6 155 @ Up to date 0.008 54 rows ...
4 37 Transform Sort 1 36 1 38 6 209 @ Up to date 0.000 No changes
5 36 Transform Javascript 1 45 1 37 6 209 Up to date 0.020 209 evaluate...
6 33 Transform Join 2 26,32 1 45 5 209 @ Up to date 0.006 209 rows ...
7 32 Transform Dedupe 1 16 1 33 4 209 @ Up to date 0.022 14,449 rows ...
8 30 Transform Sort 1 29 0 2 99 @ Up to date 0.001 Sorted
9 29 Transform Count 1 26 1 30 2 99 @ Upto date 0.006 99 counted ...
10 26 Transform Sort 1 24 2 29,33 2 210 @ Uptodate 0.002 Sorted
n 24 Transform Pivot 1 16 1 26 2 210 @ Up to date 0.057 Pivot table ... ¢
12 20 Transform Spread 1 16 0 104 209 @ Up to date 0.066 100 cols ...
13 16 Transform Remove Cols 1 15 3 20,24,32 4 14,658 @ Up todate 0.029 7cols...
14 40 Output  output.xlsx 1 39 € Error 0.018 Error writing

16 44 Note

Inputs: 1, Transforms: 13, Outputs: 1, Notes: 4

¢ Configure the mouse wheel zoom and pan behavior using the Zoom wheel
behavior field of the General tab in the Preferences window.

e Hold down the shift key and drag on the Center pane to scroll
left/right/up/down.

See also:
e Handle large datasets

3.18 Match dirty data

There is often a need to match real-world data that is 'dirty’. For example, you
might want to match the company name in two datasets to perform a

Lookup.
In the first dataset there are company names:

Smith Industries
Weyland-Yutani
ACME LTD

In the second dataset there are company names:

Smith Industries Ltd
Weyland-yutani, Inc.
Acme

You can try to match these using the fuzzy matching option in Lookup, but
this is slow for big datasets and can result in false positives. So it is much
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better to try to clean/normalize the data as much as possible before
matching.

You can do this by using a Replace transform to replace any of the following
with a space:

e punctuation characters
e ‘inc’, 'incorporated’, ‘Itd’, ‘limited’ etc (use \b to denote a word boundary in

a regex, so you only replace a whole word, not part of a word)

Then use a Whitespace transform to remove leading and trailing whitespace
and convert consecutive spaces into a single space.

You can then do a Lookup with exact match and case sensitive unchecked:

Replace % |23
@ Replace multiple text in the selected column(s).
IE‘ A|(aFilter columns r Lookup P 2
 company ® Create a new column in the top dataset using values |..
Explore Keys..
\b = word boundary Vv automatic new column name
1 of 2 columns selected Top key column: ? Company v

@1 L B &< space chars

Bottom key column: v Company b4

Company v Match Type Replace With Bottom value column:| Y. v -
1Smith Industries 1 1/Punctuation ¥ .

2 Regex v inc\b | Matching: Exact v

2Weyland-Yutani 2 3|Regex ¥ \bltd\b Bottom values used:  First v

3ACME LTD 3 4| Regex ¥ N\nincorporated\b If no match Use no match value v

\ / No match value;
Clipboard Replac Whltespace case sensitive
—

(] (]
. S~ . \
Lookup o
/ selsx3n
o Clipboard o Replace Wh espace e & e ©
2eole % 3rows 2 cols %3 rows 2 s x 3rows
’ 1 Smith Industries 1cC
e 2Weyland Yutani 2A
Company v Whitespace %[ B LS 3 ACME 3B
1Weyland-yutani, Inc. A (@) Tidy whitespace (Spaces, Tabs, Carriage Returns etc) in...
ol B [E A (arFilter columns
Company
3smith Industries Ltd C v

v

1 of 2 columns selected
v trim leading and trailing whitespace
v replace Line Feeds with Spaces
v replace Tabs with Spaces
v replace non-standard Spaces with Spaces
v remove Carriage Returns

v convert consecutive Spaces to one Space

v remove non-printable characters

If there are still issues (e.g. typos in company names) you could try setting
Matching to Fuzzy.

Once you are happy with the match, you can add an output to write it to file.

See also:
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e Fuzzy matching
e Clean a dataset

3.19 Merge datasets
-

Easy Data Transform has two main options for merging two datasets. Stack
and Join.

Stack datasets

If you want to merge the two datasets so they are one on top of another, use
the Stack transform. For example, to Stack these two datasets:

MName ID DOB

John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+

i Name ID DOB

Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

To get this dataset:

Name D DOB
1 Q‘I_I!‘I Black 001 1‘966—0?@

2|Paul White 002 1973-03-11

3 @ry Green 003 19??—12—_59

4 Jane Brown 004 1980-11-02\

51;1\|Taupe 005 1981-03-[2}

e Drag the two dataset files onto the Center pane of Easy Data Transform.
e Select the two datasets using Cmd+click.
e Click the Stack transform in the Left pane.
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stack-example-1a....

3 cols x 3 rows

Stack

3 cols x 5 rows

9

stack-example-1b....

3 cols x 2 rows

The datasets are now stacked in the vertical order that the datasets are shown
on the screen. The top dataset is shown first. You can swap the vertical
positions of the datasets to change the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the
second dataset, set Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in
the same order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch
processing to write to an output item with Write Mode=Append.

Join datasets

If you want to merge the two datasets side-by-side using a common (‘key’)
column, use the Join transform. For example, to Join these two datasets:
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MName ID DOB ID Department Level
{61 Engineering 1\1

v

John Black 001 1966-(]?&

[t

Paul White 002 1973-03-11 003 Engineering 2
Barry Green [B03] 1977-12-30 + 3|004 Marketing 1

Jane Brown 004 1980-11-03 41002 Sales 2

5 Sales 3
QO J/

LN

Jill Taupe |0OS 1931—[!3—_{9

By common ID value to get this dataset:

Name ID DOB Department Level

1 ﬂg’h_n Black r{ﬂﬂ1"\15"515-'[]I"—[}l Engineering 1 )

2|Paul White | 002 [1973-03-1 Sales 2
3|Barry Green{ 003 [1977-12-3( Engineering 2

4|lane Brown| 004 [1980-11-03 Marketing 1

klﬂTaupe @leSI—GSWIEE 3 )

¢ Drag the two dataset files onto the Center pane of Easy Data Transform.
e Select the two datasets using Cmd+click.
e Click the Join transform in the Left pane.

%]
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join-example-1a.csv

3 cols x5 rows

o Join

S5 cols x5 rows

join-example-2a.csv

3 cols x 5 rows

¢ Set both Top key column and Bottom key column to the common (‘key")
column.

[Jnin | = IC? B E;

(%) Merge 2 input datasets side by side using common (k...

Explore Keys...

Top key column: 1D B
include top non-matching rows
Bottom key column: 1D (%]

include bottom non-matching rows
case sensitive
detailed report

The datasets are now joined side-by-side using the common column. The top
dataset is shown on the left. You can swap the vertical positions of the
datasets to change the order in which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you
set By to Row in the Join transform.

Set include top non-matching rows and include bottom non-matching

rows depending on what you want to do with top and bottom dataset rows
for which there are no matches.
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Note that matching columns takes account of whitespace. So you might need
to do Whitespace transform before the join.

If you only want one column from the second dataset you can use the Lookup
transform.

If you want to find key values that are in one dataset but not the other (an
‘anti-join") you can use the Subtract transform:

Clone
/]

14 cols x 750 rows

Filter o Subtract Rows not joined

-0 <
11 cols x 87 rows D e— from top dataset

o Join

24 ols x 720 rows

Filter Subtract Rows not joined

-8 o
14 cols x 750 rows 14 cols x 30 rows from bottom dataset

If you are merging numerical datasets you can also use an Interpolate
transform.

See also:
¢ Video: How to join Excel files
¢ Video: How to clean, merge and scrub email lists

3.20 Move a .transform file
1

To move a .transform file to a different location on the same computer use
File>Save As... or Finder. You either leave the Input files at the original
location or move them to the same location relative to the .transform file (e.g.
if they were in the same folder as the .transform file before, move them to the
same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the
same location relative to the .transform file (e.g. if they were in the same
folder as the .transform file before, move them to the same folder as new
.transform file).

Easy Data Transform © 2025 Oryx Digital Ltd


https://www.screencast.com/t/aE7Rib6uH8l
https://app.screencast.com/CvACcWbziB7pt

How do I?

See also .transform files.

3.21 Open multiple main windows
e

To open an additional Easy Data Transform Main window, select File>New
Window.

3.22 Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.

L] L ] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)

DeRE o~ Oda ol @ ¥ How Do I?

Remove Cals  (2) Stack @ | |22
Rerama Cals (7} Align columns by:  Header name a
= Merge input datasets one on top of another.Orders by the
Fuorder Cols (3} vertical pasitions of the input datasets,
Auplace @ Warnings | Info | Comment | Results
= 3 cols x 10,258 rows
Row Num &)
@ R R Ze Show first 10 rows )
Samgle |&
e ® country | time  bcg_vacc
. LA
Sort ® Jvaocinalion.csv 1 afg 19682 10
# 1 +
Split Col @ 3 cols x 5.8k rows N %o CH) 0
Split Rows @ 3 afg 1984 T
Spread 2) 4 afg 1985 17
@ Stack 5 alg 1986 18
2) \/
Stamp @ 3 cols x 10,3k rows & afg 1987 27
Stas (@) 7 atg 1988 40
Substitute @ 2 afg 1989 38
® J\raocinationacsv 8 afg 1990 30
Sumenary @ 3 cols x 4.5k rows: 10 afg 1991 21
Total @
Transpese @ Last 10, 248 rows not shown
Unique @
ueits o)
Whitespace @
el Outy

C_ ToFle

[2] Email us questions/feedback

e Select *.xlsx or *.xls from the file type drop-down list that appears.

« CSV file (*csv)

. Excel file |['.u|sJ

LR W TR 2 D P Sy [

You can't output style information directly to Excel. But you can copy the
styling from another Excel sheet, including:

column widths

row heights

column/row hidden status

cell merging

text orientation

fonts
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set wide

columns hidden

A4

a AutoSave Cm . ") ~ ¢ - styling.xIsjf » Sqved to this PC v e
File Home Page Layout  Formulas ata eview View Help Power
D 5’ [A}:tos Narrow J[ﬂ = @ - 2, Wrap Te
Paste ™ B T U + H v = = | = 3= Merge ¢
Clipboard Font Alignment
A34
B E G K
set bold
underline 2
3
4
set bold =i
styled.xIsx[Easy Data Transform] Qﬁ = D:
@ Output to file.
Output to:  Single file v
File: C\Users\andy\Desktop\styled.xIsx[Easy Data Transform]
Type: Excel XLSX v
Formatting: Automatic v
v use style template C:\Users\andy\Desktop\styling.xIsx[style]
v write header
I
\Write mode: Overwrite ¥ Sheet v
Alias: styled
Data Characters Warnings (D Info Comment Details
10 cols x 20 rows @ written|
B/ 0OelE Y € =22 T [V
name id nametype recclass =
1 Allan Hills 85126 991 Valid H5
2 Asuka 881379 4088 Valid Lo
B Autosave ) v (v % styledxlsx - Saved to this PC v RS
File Home Insert Pagelayout Formulas Data Review View Help Power Piv
flj Ij‘); [Ana\ v“ﬂ } AA = = @ o v 25 Wrap Text
Paste v E = == = Merge & Ct
- ¥
Clipboard N Font ] Alignment
Al v Jx name
A B D E G K
1 [name |ﬂ recclass mass (g) year
2 Allan Hills 85126 991 H5 46.5 01/01/1985 12:00:00 AM
3 Asuka 881379 4088 L6 33.68 01/01/1988 12:00:00 AM
4 Dar al Gani 767 6314 L6 35.8 01/01/1999 12:00:00 AM
5 Dominion Range 08262 54041 LL6 15 01/01/2008 12:00:00 AM
6 Elephant Moraine 90876 9285 L6 19 01/01/1990 12:00:00 AM
7 'Grosvenor Mountains 03027 34582 LS 585 01/01/2003 12:00:00 AM
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You can use a relative location for the template file (relative to the .transform
file):

V' use style template .\inputs\excel-style.xIsx[Easy Data Transform]

Note that Excel .xlIsx files are typically limited to 1,048,576 rows and 16,384
columns.

See also:

e Excel format

e Write to multiple sheets of an Excel file

¢ Video: How to convert fixed column width to CSV or Excel
¢ Video: How to convert JSON to Excel

e Video: How to convert XML to Excel

3.23 Output nested JSON or XML
|

You can use the Dot (.") character in the column header to show nesting. For

example:
name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c
1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is output to JSON as:
[

{
"name": "Avocado Dip",
"Carb": "2",
"cholesterol": "5",
"fiber": "0O",
"minerals": {
"Ca": "O"’
"fe": "O"
b
"protein": "l",
"sodium": "210",
"vitamins": {
"a": "O",
"o "O"
}
}
]
And to XML as:
<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>

<name>Avocado Dip</name>
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<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

For more details see:
e JSON format

e XML format

See also:

¢ Video: How to convert CSV to XML
e Video: How to convert CSV to JSON

3.24 Perform the same transforms on many files
|

You can perform the same set of transforms on multiple inputs in one
operation using batch processing or command line arguments.

Example 1
To convert a folder full of .json files to .csv files:

1. Select File>New to create a new .transform file.

2. Drag one of the json files onto the Center pane. Ensure the options
(encoding etc) are correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the
location of a .json file to create. Ensure the options (encoding etc) are
correct in the Right pane.
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test.json output.csv

v 9

6 cols x 155 rows 6 cols x 155 rows

4. Select File>Batch Process.
5. In the Batch Process window change the . json file name to *. json, so
that all the . json files in that folder will be processed.

€ Batch Process* X

Input locations can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\output_*.csv' or ‘C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'C:\Users\andy\Documents\output_{test}_{datetime}.csv'.

Where {test} is replaced with the file stem of the input with alias "test'.

And {datetime} is replaced by the processing date and time.

Click 'Help' for more details.

Add Remove | Clear

Input alias=test Output alias=output (Overwrite)
1|C:\Users\andy\Desktop\*ljson ... \C:\Users\andy\Desktop\output_{test}.csv

Process| Stop

Close Help

6. Press the Process button. A . csv file will now be created for each . json
file in the folder. In the example above the {test} file name variable will
be replaced by the file name of the input file with alias test (if you just
output to output . csv then you would be continually overwriting the
same file).

7. Select File>Save to save your .transform for future use.

If you want to process input files from another folder then click Add to add a
new row and change the input folder.

Example 2

To merge multiple .csv files into a single .csv file:
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8. Select File>New to create a new .transform file.

9. Drag one of the .csv files onto the Center pane. Ensure the options
(encoding etc) are correct in the Right pane.

10.Click on the To File button at the bottom of the Left pane and set the
location of amerged. csv file to create, in a different folder to the input
.csv files. Ensure the options (encoding etc) are correct.

© test.csv amerged .CSV

14 cols x 10k rows 14 cols x 10k rows

4. In the Right pane set Write Mode to Append and check write header
and if empty. This ensures that only one header will be written, rather
than one for every input file.

merged.csv r:f} 3 :

@ Output to file.

File: C:\Users\andy\Desktop\merged.csv

Type: Delimited text v

Delimiter: Comma (,) v

Quoting: As needed v

Line endings: Automatic v

Encoding:  UTF-8 v
v rle

Write modg¢: Append v
V' write header vV if file empty

Alias: merged

5. Select File>Batch Process.
6. In the Batch Process window:
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e change the input .csv file name to * . csv, so that all the . csv files in that
folder will be processed.

e Check clear 'Append’ outputs before first append so that any existing
data in the output file is cleared before Easy Data Transform start
appending to it.

€ 5o

Input locations can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\output_*.csv' or ‘C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'C:\Users\andy\Documents\output_{test}_{datetime}.csv'.

Where {test} is replaced with the file stem of the input with alias "test'.

And {datetime} is replaced by the processing date and time.

Click 'Help' for more details.

Add = Remove Clear V' clear 'Append’ outputs before first append

Input alias=test Output alias=merged (Append)
1/C:\Users\andy\Desktop\*.csv ... C:\Users\andy\Desktop\merged.csv

Process  Stop

Close Help

7. Press the Process button. A single merged. csv file will now be created
that contains a concatenation of all the other . csv files.
8. Select File>Save to save your .transform for future use.

If the headers are different orders in different .csv files, then you can Stack by
header name in your .transform to get a consistent column order before
outputting.
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cols-in-order....

14 cols x 1 row

Stack merged.csv
9 — 9 g
28 cols x 10k rows 28 cols x 10k rows
test.csv
L/
14 cols x 10k rows

R A

Stack $ BT

@ Merge input datasets one on top of another. Or...

Align columns by{ Header name v

See also:

¢ Video: Batch processing

3.25 Profile a dataset

In the Right pane you can double click on a column header or click the
corresponding button to show a profile of the data in each column. For
example the different data types (text, numeric etc) and the frequencies of
different values. Potential discrepancies (such as missing values) are
highlighted in red.

You can hover over some table cells to see example values. You can double
click these cells to drilldown to see the dataset rows with these values.

You can use profiling in conjunction with Filter, Remove Cols and Replace
transforms to remove unwanted rows, columns or values; and with the Impute
transform to add missing values.
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Data  Characters  Warnings () Info Comment  Details
12 cols x 891 rows ) Read
BB 0De [ME|Y <=l F L] L
® ® Column Values
Column:  Embarked K| € Sample: All 891 rows
Show: 20 Most frequent values B @ bars 9% include dates  include statistics
Value Frequency Metric Value
— 5 644 / 72.28% Empty wvalues 2
101 C 168 / 18.86% Non-empty values 889
4 Q 77/ 8.684% Numeric values 0
(empty) 2/ 0.22% Integer values 0
Real walues 0
Boolean values 0
Text walues :3:3]
Distinct values 4
Unique wvalues 0
Duplicated values 4
Min length 1
Max length 1
Average length 1

For large datasets you might want to set Sample to less than the full dataset
for speed. You can also leave include dates and include statistics unchecked
for speed (include dates checks against every date format listed in
Preferences).

See also:

e Video: How to profile data
e Summary

¢ Add missing data values

e Clean a dataset

3.26 Replace empty values
|

You can replace empty values using the Replace transform.

Easy Data Transform © 2025 Oryx Digital Ltd



https://www.screencast.com/t/ZjARrwRT

How do I?

| nl n2 n3

1 123.8 9876.1

2981234 233
| 3 288
Replace OP Eg

@ Replace multiple text in the selected column(s). Can use powerf...
El Q Filter columns

v,m

v,nz

Jna

3 of 3 columns selected |
@1V RBAX |

Match Type Replace With
1 Empty ¥ 0.0

- I
v case sensitive

Y

n n2 n3

(1 123.86 98761 0.0
2981234 00 233

3 288 00 00

See also:
e Add missing data values
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3.27 Run jobs on a schedule
I

Easy Data Transform doesn't currently have it's own scheduler. However you
can run jobs on a schedule (e.g. at 5pm every day) by using pretty much any
scheduler to call the Easy Data Transform command line interface:

1. Create the .transform file that details the transformations you want to carry
out.

2. Call Easy Data Transform command line interface (or a script that calls the
command line interface) from your scheduler.

You can use launchd, which is part of macOS (but not very friendly). Or you
can use any number of third party scheduler applications, such as
LaunchControl.

@ LaunchControl File Edit Job View Window Help
[ ] [ ] local.job.plist

User Agents B © Label Daily data transform Unload

Q-

File ... Status [Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform |
Usersfandyb/daily.transform -cli

Program to run

com.dropbox.Dro + Ok
com.google.keyst « Ok

Set Executable... Edit File... Enable Globbing
com.google.keyst « Ok
com.oryxdigital.ai + SIGABRT Default argv[0] B
com.oryxdigital.ai + SIGABRT | 4
Start calendar interval
org.virtualbox.vbe Unloaded Month Day Weekday Hour Min...

Any * Any ¢ Any 17 00 2

Remove All Add

You can change the input and output file names through the command line
interface. Add -c11i to close Easy Data Transform after the job is finished.

Some schedulers will also allow you to call Easy Data Transform on an event,
e.g. when a file is added to or updated in a particular folder.

3.28 Scrape web data
|

You can scrape data from a web browser by selecting it and dragging into the
Center pane of Easy Data Transform (or copying and clicking From
Clipboard).
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o Select data in web a browser

LN 181,543 1.52[-0.99°
Vi Visa Inc. HIEY IXE EEER

e Drag onto Easy Data Transform
B casy Dat

OB8RBE v~ JQAR S |H ® | rHowDol?
n Input
From File (@)
From Clipboard @

symbol — Company Name
JNJ Jﬂhns% Johnson

Vv Visa Inc
MA Mastercard Incorporated
cvX Chevron Corporation

Bank of America Corporation

o Drop

€ Easy Data Transform v1.27.0 (licensed to Oryx Digital Ltd)*
_ Eile Edit View Licensing Help
DB8RE v OAAAFHE ® rHowDol?

| -

) Input

: From File @
From Clipboard (@)

1> Transform

- All transforms A

. v/ show advanced

'( @ Transform keywords

. Calculate ©)
Case @)
Chop ®
Clone @
Clipboard
e ke cols ®
9cols x 20 rows
Concat Cols ©)

See also:
e Video: How to scrape web data

3.29 See changes from a transform

The following transforms allow you to highlight changes made by the
transform:
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e Whitespace

Check the compare changes checkbox below the data table to highlight
changes made by the transform.

Il warnings | Info | Comment | Details
3 cols x 4 rows & 2 changed,10 unchanged

NEIEIESE
Gender

Andy M

2 Claire Green F detail of

white m selected change

4 Emma Black F

l:ampare changes -l | ‘T* ‘john'->John’

I

next/previous change
change color

Click on or hover over a cell to see details of each change.

Click on the up and down arrows to move between changes. Changes hidden
by dataset filtering are skipped.
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If you want to see rows that were removed by a transform such as Dedupe,
Unique or Filter, you can do that using Subtract. The dataset needs to have a
column of unique key values to use in the Subtract. If it doesn't have one,
then add one first using Row Num.

orders.csv Row Num », Subtract
9 — 0 »9
14 cols x 913 rows 15 cols x 913 rows \ 15 cols x &3 rows
Dedupe
0 p
15 coks x 830 rows
LJ
Subtract ff} = Eg'
® Remove rows from the top dataset whose key val... |
Top key column: Row Num v
Bottom key column: Row Num vl

v case sensitive

You can also compare headers or data between datasets.

3.30 Set output file name from input file
I

To set an output file name based on the name of one or more input files, see
File name variables.
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Alias: orders

orders-dec-2...

14 cols x 830 rows

Join output_{orde...
© T _{

18 cols x 2.2k rows 18 cols x 2.2k rows
order-details....
5 cols x 2.2K rows
File: C:\Users\andy\Desktop\output_{orders.fname}.csv

3.31 Show whitespace and invisible characters

Click the eye icon in the Right pane to show whitespace and other invisible
characters in the data.

m Characters Warnings @ Info C

1col x 4 rows

BB Z 0Oe &Y

k
v Show invisible characters in the dataset as symbols:

1 1 Mulk @

Space:
2 1l Tab: 2

Carriage return: “
3 .-3--  Line feed: !

Mon-breaking space: _
4 @4 Other whitespace: O

Other non-printable: 3

The number of whitespace and invisible characters is also totaled by column
in the Characters tab.
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Data Warnings @Info Comment  Details
Sample: All 29 rows © W show bars
SupplierlD CompanyName ContactName ContactTitle Address City Region PostalCode

Uppercase 80 60 61 64 33 95 18
Lowercase 408 293 428 347 185 24

Digit 49 81 124
Dot 9 2 12

Colon

Apostrophe 6 2

Dash 2 1 5 2 2

Forward Slash

Other 3 1

Non-ASCI| 2

Space 51 32 32 74 2 7
Leading Space 1

Trailing Space 1

Double Space 1

To add or replace Null, Tab, Carriage Return or Line Feed characters you can
use the right click menu:

Match Type Replace

1 Text B

. Paste
case sensitive

m s Info Commr

14 cols x 10,000 rows

[% l:%jl .:.49 S E[H -u_._.'|l|'l'.";:'-'il-.'_'L'-i-.'"r'..-:i=j'._ ] _'_'.ik_l’f-_".,';Z.'::';:-f.ji’;i_'||'|:|

Line Feed
Region Tab
Mull
1 El.l]‘_'CIEJF_‘ LiTLiall

3.32 Split a dataset into multiple files
N

Easy Data Transform supports splitting datasets into multiple files in 2
different ways.
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Example 1: Simple splitting

To split a dataset according to whether the Gender column contains M or F,
use a pair of Filter transforms.

= KA
Filter r::)*:l o]
@ Filter rows by text, date or numeric values in sel...

@ ® Eé ég{l X| |Keep ™ | Matching any

Column Op. Value
1 Gender vYi|i= ¥|M
Filter male_employ...
V) — 0
19 cols x 10 rows 19 cols x 10 rows
employees.csv
19 cols x 18 rows
Filter female empl...
/] — 0
19 cols x 8 rows 19 cols x 8 rows
Filter e

@ Filter rows by text, date or numeric values in sel...
@ @ Eé égﬂ X | [Keep ¥ | Matching any

Column Op. Value
1/ Gender Y= ~JF

Example 2: Split according to row values

To split a dataset according to Region column values:

e Use transforms (such as Substitute) to create a column with the file location
you want to output to, based on the Region column. The location can be
an absolute location (e.g. /Users/andy/output.csv) or a location
relative to the .transform file location (e.g. results/output.csv).
Folders output to must already exist. Empty or invalid values are ignored.
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This column is not output (use the Copy Cols transform if you want it to
be).

e Create an output with Output to set to Multiple files and the Files column
selected.

¢ Set Confirm files checked to be prompted before writing (recommended).

Multiple files & El
@ Output to file
Qutput to: | Multiple files v
Files columr): Region file v
Confirm files: V'
Type: Delimited text v

i Sl S S PP s

do (SR
Data = Warnings (Dinfo  Comment < »
3 cols x 5 rows @ written
BB OF VK« 2 AT N L
Name Region Name Region Region file

1 John Smith  North 1John Smith  North  North_staff.csv

2 Jane Green West 2 Jane Green West West_staff.csv

3 Brad White South 3 Brad White South  South_staff.csv

4 Faisal Al East 4 Faisal Ali East East_staff.csv

5 Jill Black North 5 Jill Black North  North_staff.csv

l l E East_staff.csv

© sales_staff.csv © Substitute © Multiple files | 3] North_staff.csv

2 cols x 5 rows 3 cols x 5 rows 3 cols x 5 rows @ South staff.csv

1 E West_staff.csv

Substitute JCFr = E;

@ Substitute column values into text

New column name: Region file
Substitution script:

¢(Region)_staff.csvy|

Insert variable:  <select> ¥ Evaluate
Data | Warnings Info  Comment 4

3 cols x 5 rows 05 evaluated

V< ST Sl RN
Name Region Region file

1John Smith North  North_staff.csv
2 Jane Green West West_staff.csv
3 Brad White South  South_staff.csv
4 Faisal Ali East East_staff.csv

5 Jill Black North  North_staff.csv
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Example 3: Split by size

To split a dataset into files of 1000 rows each:

Multiple files o dll== [PE¢
@ Qutput to file.
Outputto:  Multiple files >
) ' -
. Files column: File name v
Row Num i
@ d: = Confirm files: V'
Add | ith th ber.
a new column wi e row number R Type: Excel XLSX -
Start at: 1 v . z
Formatting:  Automatic >
Increment: 1 - E‘E split-1.xlsx
hd Write mode: Overwrite ¥ Sheet ~ P §
) .
Every: 1000 = V' write header E split-2.xlsx

\ ‘ \ E split-3.xlsx
E split-4.xlsx

. . . N )
° 10k.csv o Row Num ° Substitute o Multiple files B split-5.xisx
14 cols x 10k rows 15 cols x 10k rows 16 cols x 10k rows 16 cols x 10k rows Et splith.xst
g split-7.xlsx
g split-8.xlsx
y N .
Substitute FE B split-9.xlsx
(@ substitute column values into text. E‘E split-10.xlsx
New column name: File name
Substitution script:
output\split-$(Row Num).x1lsx
See also:

¢ Video: How to split CSV into multiple files

3.33 Trigger an update when an input changes

Check watch file in the Right pane for an input file if you want to set it to
‘Needs update’ whenever the input file changes (which will trigger processing
if Run>Auto Run is checked).

100k.csv o= Q{} B :»;
@ Input from file.
File: DAEDT data\CSW\100k.csv

- W axt / / J

ignore empty ____.anns

[ v watch file ]

Note:
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e If you are also outputting to this file in the same .transform you are
inputting it, it may cause the .transform to run forever.

e The update may not be triggered if the file is deleted and replaced with a
new file with the same name.

3.34 Use Easy Data Transform from a USB key
-

See Portability.

3.35 Use multiple keys for Join/Lookup/Intersect/Subtract
.|

You can Join, Lookup, Intersect or Subtract on more than one key column by
creating a composite or compound[1] key column, using Concat Cols.

For example, if you want to Join this table using both Catalog and Part as key
columns:

OrderId Catalog Part

1 83478 ACME 89383

To this table to this table using both SupplierCatalog and Partld as key
columns:

SupplierCatalog PartId Cost Description

1 ACME 89383 13.00 Spanner

So that rows are joined only when catalog and part ids both match, then you
need to create a new composite/compound key column for each dataset
using Concat Cols:
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Concat Cols d)g OO E Ec

@ Concatenate selected columns into a single ne...

v automatic new column name

= Q Filter ¢ MAS
E }; Filter columns o = Qﬁ —
Orderld _ €
| @ Merge 2 input datasets side by side using com...
| Catalog Explore Keys...
' By: Ke v
v Part v 4
1 Top key column: v Catalog + Part )
2 of 3 columns selected include top non-matching row
Delimiter: + Bottom key column: Y/ SupplierCatalog + Partld ¥
orders.csv Concat Cols
9 — 9
3 cols x 5k rows 4 cols x Sk rows
Join
/]
8 cols x 5k rows
arts.csv Concat Cols
o P — o
4 cols x 15k rows 5 cols x 15k rows
Concat Cols % QG :g

@ Concatenate selected columns into a single ne...

V' automatic new column name

|E| /{71 Q Filter columns
v Supp.:ll.erCataI.og

v Partld

Cost

Description

2 of 4 columns selected

Delimiter: +

Use a delimiter in Concat Cols, otherwise concatenating AB with CD will
produce the same key as concatenating A with BCD. Use a delimiter that is
unlikely to occur in either key.

You may need to use Copy Cols or Rename Cols to get the key columns in the
same order in each dataset, before Concat Cols.

[1] A compound key is a composite key where each element is a unique key
in it's own right.
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3.36 Verify data values

You can check that a dataset has the expected values using the Verify
transform.

3.37 Visualize data

Currently Easy Data Transform does not support charting beyond data
profiling. However it can easily integrate with other tools that do. For
example. by outputting a CSV for import into the visualization tool, or copying
and pasting via system clipboard.

For example, you can copy and paste data direct from Easy Data Transform to

rawgraphs.io:
o Copy

Data = Chara Warnings  Info  Comment  Details
2 cols x \
P B

countriesAndTerritories deaths per 10k

1 Ecuador 0.18
2 United Kingdom 0.09
3 Italy 0.08
4 Spain 0.06
5 Netherlands 0.05
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| €

C @

O & https//app rawgraphs.io

1 r

! =

2. Choose a chart

RAWCGraphs 2.0 beta

e Paste

1. Load your data

71 Paste your data

Upload your data

e Choose chart type

|1 Alluvial Diagram Arc Diagram

I : | Correlations, proportions Tttt Networks

1 Multi-set bar chart

I I | Corelations, poportions

Stacked bar chart

Correlations, proportions

Show Allcharts  ~

Bar chart

Correlations

Beeswarm plot

Distributions, time series,

Bar chart =inl proportions
3. Mapping o Choose columns
DIMENSIONS CHART VARIABLES

Aa  countriesAndTerritories X # deathspe.. Sum ~ X Aa C.. CSV(unique) ~ X

#  deaths per 10k

Aa countriesAndTerritories Bars % Size Color

4. Customize

e Customize

ARTBOARD +
Belgium
CHART - Brazil
Canada
Padding 1 <
Denmark
Bars orientation Horizontally + Dominican_Republic
Ecuador -
Sort bars by Name *
France
SERIES + Italy -
Netherlands -
COLORS =
Panama -
Color scale Ordinal v Peru
Portugal o
Color scheme Lol . -
Romania
Belgium W #9E0142 spain
Brazil W #8E2440 Sweden
Swizertand
Canada B #D8454B
United_Kingdom
Denmark W #EB6349 United_States_of America
deaths per 10k [sum]
Dominican_Repub... [l #F68550 0o obo obe oio ol ois ole ole
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See also:
e Video: How to visualize data with rawagraphs.io

Werite to multiple sheets of an Excel file
e

To write to multiple sheets (tabs) of the same Excel file you need to set the
Write mode of each output item to Overwrite/Sheet (to clear the sheet first)
or Append (to add to existing sheet data).

3.38

|® [#P||52

File: /Users/andyb/customers.xlsx[records]

Icustnme rs.xIsx[records]

Number/Bool/Date/Text 5
B> B

\

customers.xlsx
[records]

Format as:

[Write mode:  Overwrite
[ —

customers.csv

v

11 cols x 91 rows

11 cols x 91 rows

customers.xlsx

Easy Data Transform © 2025 Oryx Digital Ltd

summary

v w/

12 cols x 9 rows

[summary]

12 cols x 9 rows

I customers.xlsx[summary]

el 1bse

Format as:

File: /Usersfandyb/customers.xlsx[summary]

Number/Bool/Date/Text

‘Write mode: Overwrite
[

= SheeD

If you set the Write mode to Overwrite/File for an item then the write will

remove existing sheets.

See also:
e Excel format
e Qutput to Excel
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Expert tips
4.1 Expert tips

Here are some tips to help you be more productive with Easy Data Transform.

1. Check the show advanced checkbox in the Left pane to see all available
transforms.

o Transform

All transforms 8
show advanced

[
.\\

y

A

Caleulate @

2. Type a keyword in the transform keywords field to quickly find the right
transform.

st Transform

KC"\ group } Q)
Gather @
Unigue @

3. Add a transform by clicking an existing Center pane item and typing the
first few letters of the transform name.

4. Uncheck Run>Auto Run to take full control of when items are processed.

. @
DB &Ga(se> e o

5. Hold down the shift key and drag on the Center pane to scroll
left/right/up/down.

6. Use Note items to remind yourself how a complex .transform works.

7. Look in the Warnings and Info tabs in the Right pane to troubleshoot
potential issues.
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Data (D info | Comment

Number of values per row vary:
2730 input rows have 1 value: E.g.input row 2

8. Select multiple items in the Center pane by left clicking with the mouse
and dragging a box over the items you want to select.

9. Add a transform to an existing connection, rather than disconnecting and
reconnecting existing transforms.

10. Improve performance for large datasets by adding a Sample transform
straight after the input of a large dataset and set Rows to pass through only
the first 100 or so rows. Once you have completed all your transforms you can

then Disable sampling to pass through all rows.

11. Double click on an item in the Center pane to show it fullscreen. Escape
to close the window.

12. Use a schema to handle column changes in an input.
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[metenrites.csv | %= tﬁ} E:

(%) Input from file.
File: s/andyb/Dropbox/EDT_data/meteorites.csv

v s hee
Use schema: Yes e
e Schema
&l |® LILE|E® | B & | x
Expected columns Missing column value
1 name
2 id
3 nametype
4 recclass
5  mass (g)
6 fall

Missing columns in input:  Add as in schema )
Out of order columns ininput:  Re-order as in schema

Extra columns in input:  Add to end

®

I II".I AL TR b [ | Rt rll'

13. Check View>Timing Profile to see where the processing time is being

spent.
L
10k.csv
9
14 cols x 10k rows
(] ] (- ] i ] =
Stack o Filter o Sort o output.csv
14 cols x 110k rows 14 cols x 81,5k rows 14 cols x 81,5k rows 14 cols x 81.5k rows
[
100k.csv
9

14 cols x 100k rows
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14. Click the eye icon in the Right pane to show whitespace and invisible
characters in the data.

m Characters Warnings @ Info (

1col x 4 rows

P& s De lE Y

k
v Show invisible characters in the dataset as symbols:

1 o1 Mulk: @

Space:
2 —ul | Tab: -+

Carriage return: “
3 -3 +. Line feed: L

Mon-breaking space: _
4 @4 Other whitespace: O

Other non-printable; 3

15. Check compare changes in the Right pane to see changes from a
transform (selected transforms only).

EEEW warnings | Info | Comment | Details

3 cols x 4 rows @ 2 changed,10 unchanged
(6B <)@ V|| T[4
Gender
Andy M
2 Claire Green F detail of

white m selected change

4 Emma Black F

l:ampare changes - | ‘T* ‘john'->John’

next/previous change
change color

16. Select a column and click the column values icon in the Right pane to
show the frequency of values in that column. Potential issues are shown in
red.
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Data  Characters  Warnings () Info Comment  Details
12 cols x 891 rows ) Read
BB 0De [ME|Y <=l F L] L
® ® Column Values
Column:  Embarked K| € Sample: All 891 rows
Show: 20 Most frequent values B @ bars 9% include dates  include statistics
Value Frequency Metric Value
— 5 644 / 72.28% Empty wvalues 2
101 C 168 / 18.86% Non-empty values 889
4 Q 77/ 8.684% Numeric values 0
(empty) 2/ 0.22% Integer values 0
Real walues 0
Boolean values 0
Text walues :3:3]
Distinct values 4
Unique wvalues 0
Duplicated values 4
Min length 1
Max length 1
Average length 1

17. Check that the values in a dataset conform to your expectations using a
Verify transform.

Data Characters ' Warnings @ Info Comment Details
4 cols x 4 rows 5 fails (5 warning), 54 row(s) removed
BEWZE = || =T[4 L
First Last Teleplikone Email i
1|Bob White =

Column rule fail: Is valid telephone num. (3)

2|Alfred Grey
3Alice Brown MN/A alicef@hotmail.com

4 Luther Green (123)-123-1234 luther@gmail.

Error: - Warning: | | Info: = .

18. Enable drilldown to double click on a cell and see how the information was
derived (selected transforms only).
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Pivot odll=:! EC
@ Create a pivot table to summarize the selected columns.
Columns: Match type v |
Rows: Added/Excluded v
Values: Clicks v
Summarize by: Sum v
Set non-calculated: Zero v

V' add totals

Total by: Rows and columns v

v allow drilldown !

Data Characters Warnings Info  Comment Details

6 cols x 5 rows @) pivot table created
L& eHEY | <= T[] L

Added/Excluded (Empty) Broad match Exact match Phrase match Grand Sum !
1 (Empty) 24913 0 0 0 24913

2“ 0 223 1903 103 2229
3 Excluded 0 / 26 632 0 658

€ Drilldown ¥ double-click O %
5o
Search term Match type  Added/Excluded  Clicks Impr. CTR =

43  |print at home place cards  Broad match Added 5 5100 |
232 place card Broad match 3 89 3.37¢
485 size of place cards Broad match 1 7 14.2¢
544 |printable dinner place cards Broad match 3 2 150.(v ;
] »

19. Filter data in the Right pane. This does not change the underlying data.

20. Display the value currently selected in the data table in a separate window
by pressing the Space key or selecting Show Value... from the right click
menu. This is useful for inspecting values that are too wide to be displayed in
the data table.
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Sentence

1 Call me Ishmael.

2 Some years ago—never mind how long preci..

[ ] @ Value Row 2, Column 'Sentence’, 207 chara...

Eikes T 4] L

Some years ago—never mind how long precisely—
having little or no money in my purse, and nothing
particular to interest me on shore, | thought | would
sail about a little and see the watery part of the
world.,

Close

21. If you need several similar branches of transforms you can create one
branch and duplicate it.

covid-data.xlsx
9 [Easy Data Transf

9 cols x 14.7k rows

Lookup Uniaue _ Remove Cols results.csv
o | Show fullscreen F11

10 cols x 14.7k rows 10cc
@ Help F1

Input »

3 cols x 206 rows

country-codes.csv Transform g
Qutput »
Note

Copy Data

2 cols x 205 rows

Duplicate Branch » Ctrl+D
Q Zoom Selected Ctrl+/

}

covid-data.xksx
Q[Easv Data Transf...

9 cols x 14.7k rows

Lookup Unique o Remove Cols results.csv

L o /]

10 cols x 14.7k rows 10 cols x 206 rows 3 cols x 206 rows 3 cols x 206 rows

9

country-codes.csv

2 cols x 205 rows

Unique Remove Cols results.csv
10 cols x 206 rows 3 cols x 206 rows 3 cols x 206 rows
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22. If you have 2 or more monitors connected to your computer select
View>Two Screen Mode to show the Right pane on your second monitor.

23. Use batch processing with wildcards (e.g. *.csv) to process a folder full of
input files in one operation.

24. Use command line arguments to run .transform files from a batch or script
file.

25. Use file name variables to set the name of an output file based on the
name of an input file, date created etc.

‘Aliasz ‘

/

guest-list.xIsx

@ [wedding_sa... 0{Q'-les’tlist}_c:,_

9 cols x 68 rows 9 cols x 68 rows

/

{guestlist}_output.csv Q{} E ﬂ
@ Output to file.
Output to:  Single file ¥
File: C:\Users\andy\Desktooutput_csv

26. Use column variables when you want to use values from columns in
transforms such as If and Filter.

| Filter | 1% [P it
(%) Filter rows by text, date or numeric values in selected...
@| @ |B||& || X| kees e

Column Op. Value

1 Transaction B = B 3$(Threshold)

27. Compare the headers of 2+ datasets by selecting the items in the Center
pane and selecting View>Compare Headers... .
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[ ] . Compare Headers

Compare headers by:  Column name Show: Al

Column differences: 4

Column Name Index(es) in ‘meteorites-new.csv’ Index(es) in ‘Meteorite-Landings.csv"
GeoLocation 8 10
YEAR 10
fall 6 6
id 2 2
mass (g) 5 5
name 1 1
nametype 3
recclass 4 4
reclat 7 8
reclong 9 9
year 7
Differences:

28. Compare the data values of 2 datasets by selecting the items in the
Center pane and selecting View>Compare Data... .

® ® Compare Data

Compare rows by:  Row numbers Show: Al

Row differences: 195

Header differences: 0

'meteorites.csv', [d=486, 10 cols x 45,716 rows 'meorites-modified.csv', I[d=48, 10 cols x 45,716 rows

- name id r name id 1
23 Alby sur Chéran 458 % F 23 Blby sur Chéran 458
24 Aldsworth 461 1 24 Aldsworth 41 "
25 Aleppo 462 % 25 Rleppo 482 "
26 Alessandria 463 % 26 Rlessandria 463
27 Alexandrovsky 465 % - 27 Rlexandrovsky 45 "
28 Alfianello 466 | || [28 Blfianello 467 °
29 Allegan 2276 4 29 Allegan 2276
30 Allende 2278 ¥ < 30 Allende 2278
31 Almahata Sitta 48915 3 31 Almahata Sitta 48915

synchronize vertical scroll synchronize horizontal scroll Differences: -

29. Click on a status icon in the status bar to select and zoom in on all items
with that status.
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&3 Memory usage: 11.1% of 10GB =] ' Email us questions/feedback

30. Use keyboard shortcuts. For example, you can quickly change selection in
the Center pane using arrow keys with the Cmd key.

Left Arrow [ Up Arrow ]

JRemove Cols

v Dedupe I EE———
[

4 s x 209 rows I ng ht AI’I’OW

4 ols x 14.7k rows

Pivot

2 mls x 210 rows

/ Sort

2 als x 210 rows

Spread

v

104 cols x 209 rows

[ Down Arrow J

31. Check watch file in the Right pane for an input file if you want to trigger
processing (Run>Auto Run checked) or set it to 'Needs update’' (Run>Auto
Run unchecked) whenever it changes.

100k.csv ‘& i}ﬂ E= E:
@ Input from file.
File: DAEDT data\CSW\100k.csv

Lo W— axt / / _v,d

ignore empty . __.nns
[ v watch file l I
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32. Check View>Show Row/Col Changes to show changes in the number of
rows and columns in the Center pane.

no change to
row(s) column(s) column(s) rows or

added added removed columns

i New Rows M o Calculate ° ° Count < ® Case

v
12 cols x 1.8k rows 13 ools x 1.8k rows 2 cols x 89 rows 2 cols x 89 rows

row(s)
removed

33. Use the Subtract transform to perform an ‘anti-join".

Clone
/]
14 ols x 750 rows
Filter >, Subtract Rows not joined
K o from top dataset
11 cols x 87 rows 11 cols x 9 rows
Join
o
24 wols x 720 rows
Filter Subtract ioi
NP © ?owsbn;tjmr;et:l .
14 cols x 750 rows 14 cols % 30 rows rom bottom datase

34. Deploy Easy Data Transform as a portable application so you can run it
from a USB key or install it on computers where you have limited access
rights.

35. Find items matching one or more search terms in the Center pane using
View>Find Items.
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# ®  vHwDoR @

Find Items

Find: (CQ date]

Q)
In: names ids comments option values  column names

data values (slow)
of: @ inputs @ Transforms 3 Outputs ) Notes

Options: zoom selected case sensitive

Find items matching “date" IN names OR comments

Select All Select Mext Select Previous

Close

36. Magnify under the cursor in the Center pane using View>Magnify
Cursor.

O QR G

@ "How Do I? @

o Spread

deaths by date

106 cols x 2Bk rows

NP Count

\
nedupe Trin

37. Use the right click menu to add Carriage Return, Line Feed, Tab or Null
characters into a text option for a transform.
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Match Type Replace

1 Text 3]

. Paste
case sensitive

[ Data | s Info Comm

14 cols x 10,000 rows

I:'E) % i D El:ﬁ -I—Lu.|l|'l'.":-'il-.'_'L'-i-.'"r'..-:i::'._ i _'_'.lk_lff-_".,';Z.'::';I-?.ji’;i_'l|'|.'|

Line Feed
Region Tab
Mull
1 Europe LI oLl

38. Use fuzzy matching to match text values that aren't identical.

39. Experiment with changing Optimize processing for from Minimum
memory use to Maximum speed in Preferences to see if that improves
performance. It may be slower or it may use up all your memory.

40. Hover over an item in the Center pane and press the # key to show the
Data Preview window.

You can press the # key again to close the window. If the# key is not
convenient, you can use = instead.

41. Change the Center pane color scheme in the Colors tab of the
Preferences window.
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» ] Preferences
General Dates Input Extensions Qutput Extensions

Color scheme: Custom (%)

Selection: [ from operating system |

Connections: e |

Fill Border Text

Inputs:

Transforms:

Outputs:

Notes:

Shadows:

Hotblack << Set Custom To

Preview

®

42. Select View>Toggle Ul Theme to swap between light and dark user
interface themes.

¥ How Do I?

Input
From File Header name
Fram Clipboard
Transform Comment Results
il transtorms

Show first 10 rows

Compars Coly
Caoneat Cols
Concat Rows

Copy Cols

Email us questions/feedback

43. Select File>New Window to open a new Main window.
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44. Set the Center pane mouse wheel behavior in the Preferences window.

@ Preferences

General Dates Input Extensions Qutput Extensions Colors

Forward=Zoom out (+Option=Scroll up)
Does nothing

Store these preferences in:

User interface font: . Default
Data table font: Courier New, 13 pt Choose... Default
Locale:  English United Kingdo [ Default
® Cancel

45. Hold down the cmd key when adding a new transform or output item to
add it to the bottom left or the current canvas. Otherwise, it will be added to
the right of the currently selected item(s). This works when inserting by
clicking a button in the Left pane, typing a transform name or adding from
the right click menu.

46. When outputting Excel, check use style template to copy the styling
across from another Excel spreadsheet.
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set wide

columns hidden

ey

u AutoSave Cm . ") v - styling.xIsjf « Sqved to this PC v pe
File Home Page Layout  Formulas ata eview View Help Power
D 5’ {A}:tos Narrow J[H “l A = ’0‘7 v ?E) Wrap Te
Paste u R g % E E Merge ¢
Clipboard Font ] Alignment
A34 S
B D E G K
set bold
underline 2
3
4
set bold =i
styled.xIsx[Easy Data Transform] % Qﬁ = E;
@ Output to file.
Output to:  Single file v
File: C:\Users\andy\Desktop\styled.xlsx[Easy Data Transform]
Type: Excel XLSX v
Formatting: Automatic v
v use style template C:\Users\andy\Desktop\styling.xIsx[style]
v write header
\Write mode: Overwrite ¥ Sheet v
Alias: styled
Data Characters =~ Warnings @ Info  Comment  Details
10 cols x 20 rows @ written|
PRy OelHE Y < < T [ L)
name id nametype recclass =
1 Allan Hills 85126 991 Valid H5
2 Asuka 881379 4088 Valid Le
@ Autosave ©)« - 5 styledxlsx - Saved to this PC v 2 s
File Home Insert Pagelayout Formulas Data Review View Help Power Piv
flj ﬁ); [Ana\ v][ﬂ v} A = = @ v 25 Wrap Text
e o I v EEE EZE EMegeac
Clipboard 5] Font N Alignment
Al v fx name
A B D E G K
1 [name Ig recclass mass (g) year
2 Allan Hills 85126 991 H5 46.5 01/01/1985 12:00:00 AM
3 Asuka 881379 4088 L6 33.68 01/01/1988 12:00:00 AM
4 Dar al Gani 767 6314 L6 35.8 01/01/1999 12:00:00 AM
5 Dominion Range 08262 54041 LL6 15 01/01/2008 12:00:00 AM
6 [Elephant Moraine 90876 9285 L6 19 01/01/1990 12:00:00 AM
7 |Grosvenor Mountains 03027 34582 L5 585 01/01/2003 12:00:00 AM
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47. Quickly select a column by pressing the filter button and typing a few
characters of the name.

48. Quickly check/uncheck multiple columns using the Select Columns
window.

I Case | d?lﬂ I:P E:
@ Change the case in the selected column(s).

[EI [:Cl Filter columns

[ ] [ ] Select Columns

Check columns where  Column name contains B provided case sensitive

309 columns match

3089 columns will be checked :

Provider Organization Name (Legal Business Name)
Provider Last Name (Legal Name)

Provider First Name

Provider Middle Name

I1 A I AQllimne ealpntan

49. Select View>Item Summary... to see summary data on all the Center
pane items. Click a header to sort. However over a row to highlight the
corresponding item in the Center pane. Double click a row to select the
corresponding item in the Center pane.

IZ0 v 0 ARQARQFH @ [ Howoor (@

€ item Summary [=] X

BB
Id Name Type Upstream Upstream Ids ~ Downstream  Downstream Ids. Columns Rows Status Processing ¥ Result

1 0 log.csv Input 1 1 29 2816 @ Up to date 0.089 Read
2 1 Filter Transform 1 0 3 2,418 29 2,720 @ Up to date 0.074 96 rows removed
3 2 Filter Transform 1 1 3 9,10,17 29 2,108 @ Up to date 0.039 612 rows ...
4 4 Filter Transform 1 1 3 910,23 29 612 @ Up to date 0.030 2,108 rows ...
5 9 Intersect Transform 2 24 1 1 29 467 @ Up to date 0.025 467 rows with ...
6 18 Filter Transform 1 1 1 " 29 39 @ Up to date 0.024 2,681 rows ...
7 22 Unique Transform 1 21 1 26 19 1,393 @ Up to date 0.024 51 row(s)
8 34 Filter Transform 1 29 1 39 19 984 @ Up to date 0.023 394 rows ...
9 10 Intersect Transform 2 24 1 n 29 429 @ Up to date 0.021 429 rows with ...
10 26 Subtract Transform 2 22,25 2 27,29 19 1,392 @ Up to date 0.021 1 row(s) removed
1 13 Dedupe Transform 1 12 1 17 1 562 @ Up to date 0.020 851 rows ...
12 29 Filter Transform 1 26 2 34,35 19 1,378 @ Up to date 0.020 14 rows removed ¥
< >

Inputs: 2, Transforms: 22, Outputs: 2, Notes: 17

Note that you can click the Export or Copy buttons to export the summary to
a file or the clipboard. You can then add the summary as an Input item in Easy
Data Transform, for transformation or analysis!

50. Change focus between the Center and Right panes using Option+ [ and
Option+].
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51. Check gray Left pane buttons when not available in the General tab of
the Preferences window for Left pane buttons to be disabled until the
appropriate items in the Center pane are selected.

52. Check move Note items with associated items in the General tab of the

Preferences window if you want Note items to be automatically moved when
you drag other items that the notes are adjacent to and pointing at.
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5.2

5.3

5.4

Support

Forum

There is a discussion forum online at forum.easydatatransform.com. You can
use this to ask questions, share what you are doing and keep up to date with
news.

Contact support

If you have any questions or suggestions, please post a question on
forum.easydatatransform.com or email us at
support@easydatatransform.com.

Report a bug

Please report any bugs you find to support@easydatatransform.com Please
include:

e your operating system (e.g. macOS 14)

e the version of Easy Data Transform (from Easy Data Transform>About
Easy Data Transform)

e a step-by-step description of how we can reproduce the problem

e your .transform file and input data files (where appropriate)

e a screen capture or video can often be helpful

The step-by-step description is particularly important - if we can't reproduce
your problem, then we probably won't be able to fix it.

We treat all data sent to us as confidential, unless you tell us otherwise. If
your data is particularly sensitive, it might be enough to send us just the first
few rows with sensitive values changed. Please keep the same column
structure though.

Request an enhancement

We are always very interested to hear your suggestions on how the software
can be improved. Please post a feature suggestion on our
forum.easydatatransform.com or email us at
support@easydatatransform.com.
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.transform file 336

-A-

abs 28

add 28
aggregate 247
and 28,102

ASIN verification 254
Automatic and manual processing. 306

-B-

base (numeric) 139
base64 decode/encode 77
batch processing 332
binary 139

boolean 317

-C-

calculate 28

case 41

case verification 254
celing 28

Center pane 20
chop 44

classify 46

cleaning data 349
clone 46

cluster 46

column variables 324
command line arguments 334
comments 308
comparecols 49
compare datasets 353
concatcols 52
concatrows 54
connections 309
contact support 421
copy 360

copycols 59
correlate 61

count 63

cross 66

crosstab 220

CSV format 282

-D-

dark mode 340

data security 338

date calculations 28
date verification 254
dates 312

datetime format 67
day of week/month/year

days in month/year 28
decimal separator conversion

decode

77

decrement 28

dedupe 79
divide 28
drilldown 330
duplicate 360
-E-

EAN13 verification
Excel format 284
expert tips 402
extensions 23
extract 82

-F-

file extensions 23
file formats 281
filename variables

fill 87

filter 91

fixed width format
floor 28

forum 421

fuzzy matching 329

-G -

gather 95

group by

95

GTIN verification
GUID 252

-H-

hashing
header

97
100, 310

254

325

288

254

28

142
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hexadecimal 139 minimum 28

HTML escape/unescape 77 modulus 28

HTML format 296 month of year 28
moving 127

- I - moving average 127
multiply 28

IBAN verification 254

if 102 -N-

impute 106
increment 28 name splitter 215
indexOf 28 new col 131
input 24 new rows 133
insert 110 ngram 136
interpolate 112 num base 139
intersect 114 num format 142
Introduction 8 numbers 316
invisible characters 391
ISBN verification 254 - 0 -
-J - occurences 28
octal 139
Javascript 115 offset 150
join 119 or 28,102
JSON 291 outliers 152
Julian date 28 output 276
-K - -P-
keyboard shortcuts 340 pad 156
paste 360
- L - percent 355
percentile 228
pivot 158

lastindexOf 28

Left pane 20 pivot longer 95

pivot wider 220

length 28

Levenshtein distance 28 Plain text format 298

limits 337 portability 338

locale 318 portable use 396

Log pane 21 power 28

logarithm 28 preferences 21

long pivot 95 Preferences window 21

lookup 123 processing 306
profiling data 384
profiling time 306

= M = Pseudonym 162
pseudonymisation 162

Main window 20 pseudo-random 165

Markdown format 297
maximum 28
memory usage 337
meta information 319

Easy Data Transform © 2025 Oryx Digital Ltd



Index

-Q- -T-

Quick start guide 8 telephone number verification 254
text 312
R total 239

transpose 242

RAM usage 337 TSV format 299

random 165

rank 205 - U -

regular expressions 329

remove cols 171 unfill 243

renamecols 173 unique 247

reorder cols 174 units 250

replace 176 Unix timestamp 28

Reshape 183 unpivot 95

Right pane 21 UPC-A verification 254

rolling average 127 URL encode/decode 77

round 28 USB key use 338

row num 185 UuID 252

run processing 306

running average 127 - V o

- S - vCard format 300
verify data 254

sample 186 visualization 398

scale 188

scheduling 334, 387

schemas 322 - W -

scrape web data 387
scripting 115
security 338
sequence 193

web scraping 387
week of year 28
whitespace 273,391
wide pivot 220

sign 28 word count 28
slice 198

slide 201

sort 205 - X -

splitcol 211

split file 392 XML escape/unescape 77
splitname 215 XML format 301
splitrows 217 xor 28

spread 220

stack 222 - Y -

stamp 224

standard deviation 228 YAML format 305
stats 228 year of date 28

substitute 231
subtract 28, 232
summary 234

support 421

system requirements 8
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